HITACHI

Inspire the Next

Hitachi Dynamic Replicator - Scout
Protecting Microsoft Exchange
Server

®Hitachi Data Systems

MK-98DF8224-00




Copyright © 2009 Hitachi, Ltd., Hitachi Data Systems
Corporation, ALL RIGHTS RESERVED

Notice: No part of this publication may be reproduced or
transmitted in any form or by any means, electronic or
mechanical, including photocopying and recording, or stored
in a database or retrieval system for any purpose without
the express written permission of Hitachi, Ltd. and Hitachi
Data Systems Corporation (hereinafter referred to as
“Hitachi Data Systems”).

Hitachi, Ltd. and Hitachi Data Systems reserve the right to
make changes to this document at any time without notice
and assume no responsibility for its use. Hitachi, Ltd. and
Hitachi Data Systems products and services can only be
ordered under the terms and conditions of Hitachi Data
Systems’ applicable agreements. All of the features
described in this document may not be currently available.
Refer to the most recent product announcement or contact
your local Hitachi Data Systems sales office for information
on feature and product availability.

This document contains the most current information
available at the time of publication. When new and/or
revised information becomes available, this entire document
will be updated and distributed to all registered users.

Hitachi is a registered trademark of Hitachi, Ltd. in the
United States and other countries. Hitachi Data Systems is a
registered trademark and service mark of Hitachi, Ltd. in the
United States and other countries.

All other trademarks, service marks, and company names in
this document are properties of their respective owners.



Table of Contents

1  Introduction to Exchange failover SOIUtION..........cccccuiiiiiiiiiinininccccccccee 6
2 Solution Capabilities ........ccecueueuiiiiiiirrreece et 7
3 How this SOIution WOTKS .......ccccoiiiiiiiiiiii e 8
3.1 Protecting EXChange ... 8
3.2 Exchange FailoVeT..........ccciiiiiiiicccci e 9
3.3 Exchange FailDack .........cooooiiiiiiicecccccc e 11
3.4 FX templates iINVOIVEd ........oovvieieiiiiiiiiiiieeceece e 12

4 PIre-TeQUISILES. ..ottt 14
4.1 Moving Storage Groups and Mailbox Store for exchange 2003 .............cccocceeieininnnes 15
42 Procedure for Exchange 2007 ............ccccoiiiiiininniiiiiieeeeeeeec e 27
4.3 Dependent SEIVICES........cociiiiiiiiiiiici s 36
44 Adding DR Exchange server to SMTP connector..........cccccocvvviviiiiiiiiiiiiiinines 37
4.5 Creating special user for Exchange solution.............cccooooeeiiiiiiicinee, 38
Part 1: Non-Cluster Exchange Environment ...........ccceceuevcucueee 64
5  Protecting EXChaNGe.........cceuiiiiiiiiiiiiiiciccccc e 65
5.1 Protecting Exchange (DB and logs on same volume).........c.cocevueueueiccccccncnnnrneneennes 65
52 Protecting Exchange (DB and logs on different volumes) ...........cccccoviiiiniininninnnns 78

6  Exchange failover through CX Ul ..o 82
6.1 Exchange Planned Failover ... 82
6.2 Exchange Unplanned FailoVer ... 85
6.3 Exchange failover (W/O CDP retention) .........cccccoeoeeeirnrirereneeicieeeceeeeneeeeeeenenenenene 86
6.4 AT FaIlOVET ..ot 87

7 Exchange Failback through CX Ul.........ccooiiiiiii e, 88
7.1 DISCOVETY .ottt 89
7.2 Setting a reverse replication ...........ccccccviuiiniiiiiiiiiiii 90
7.3 FXjob £or failback .........cciiiiiiiiiiiiii e 92
7.4 After failback .......couvviiiiiiiiii e 95

8  Exchange failover and failback through CLI..........c.cccooooiiiiiic 96
8.1 Exchange FailoVer ..o 96
8.2 Exchange Failback ..........oooeiiiiiicecccc e 99

9  Failover and failback using crash consistency tag ..........ccccoevvvvnnniiiiiiinnes 100
9.1 DISCOVETY ittt ettt 100
9.2 CONSISTEIICY ...t 100
9.3 Planned Failover ... 101
9.4 FallDACK w..vviviiiiiniiiic e 102
9.5 Unplanned FailoVer ..o 102
Part 2 Active/Passive Clustered Production Server and Standalone DR Server.............ccccueuuen. 103
10 Preparing for deployment...........ccocuciiiiiiiiiiicccc e 104
11 Protect Clustered Exchange server (Cluster environment).............ccccccoeeeccncnnrnerennnes 105
11T DESCOVET .ottt ettt 106
112 Volume Replication.........ccoceueioiiiiiiieieiecce e 108
11.3  CONSISTENCY ..viviuiuiiiiiiietetetett b 112
12 Exchange Failover through CX Ul (cluster environment)............cccccoeeveevnniniviiicucncncncnne. 114
12.1  Exchange planned failovVer ... s 114
122 Exchange unplanned failover ... 116



12.3  Exchange failover (W/O CDP retention) .........cccoceeerurerueuemercueenininererenerienenereseseeeseenenes
13 Exchange failover through CLI ..o
13.1  FallOVET .ot
14 Exchange Failback through CX UlL........cccocoiiiiiiiiiiiineeececccce e
14.1  Step 1: Cluster to standalone...........coocueueueiiiiinnnrecceccecc s
14.2  Step 2: Reverse 1eplication..........oociueieieiiiiicicie e
14.3  Step 3: CONSIStENCY taZS ...cvoviviviiiiieieieieieietctc e
144 Step 4: ROIDACK ..o
14.5  Step 5: Standalone tO CIUSEET ..o s
14.6  Step 6: Migration & DNS Failback...........coooiiiiiiii
14.7  Step 7: Bring all EVS Services Online..........ccccooooieioiiiiccieiciccceeee e,
Part 3: Active/ Active Clustered Production Server and Standalone DR Server............ccccccueuuen.
15 Introduction to active/ active exchange failover..........c.cccccovvvvvniiiiicncniininnnes
16 PTOLEC...eeeee s
161 DISCOVETY eoviviviiiiiiieieietetctett bbbt
16.2  Volume Replication.........ccoceuiiiiiiiiiieieieccce e
16.3  CONSISEICY ...viuiiiiiiiciiiicicc s
17 FaIlOVET ..ottt
17.1  Exchange Planned FailoVer ..o eeeeaeaes
17.2  Exchange Unplanned FailOVer..........c.ccooiiiiiiiiiii
18 FailDacK ..ot
18.1  Step 1: Cluster to standalone...........cccococeuiiiiiiiinnniicccc s
18.2  Step 2: Reverse repliCation.........ccovverurueueueucuiiiiirrreeeeieeeee e eees
18.3  Step 3: ConSiSteNCY tagS....ceveviiieiicieieie et
18.4  Step 4: ROIDACK ....oie
18.5  Step 5: Standalone to ClUSteT..........ceviviiiicccc
18.6  Step 6: Migration & DINS Failback.........ccccccciiiiiininiiiiiiiiiiinncccccccnes
18.7  Step 7: Bring all EVS Services Online........c.ccccovvrrrieiiciicccinirrreeeeeeeceeeeenes
Part 4: Clustered Production Server and Clustered DR Server
19 INErOAUCHON ..o
20 Prepare target CLUSLET ..o
21 PIOtOCE e
22 Planned Failover ...
23 Failback......oooiiiiiiii e
Part 5: Exchange Log ROtation .........ninininiineeeniiisinisinceesnsisssissssssesessssssssssssssssesenes
24 Introduction to Exchange Log rotation ..o
25 Configuring FX JODS ....ccovviiuiuiiiiiiiiiirrrete e
251  Exchange CONSISteNCY .......cccoiiiiuiiiieieiiiecictc e
25.2  Exchange Consistency Validation ..........cocoeueieiiiiiiiiiiiiccc
253  Exchange Log RoOtation ..........ccooeimiiiiiiiiicec
Part 6: Troubleshooting...............ccuuue...
26 Recovering from Inconsistent Exchange Databases............cocovvveiiiceiicncninnnnnnennes
27 KNOWILISSUES ...ttt



Conventions

Keywords, command buttons and other such fields are enclosed in “ “ while being bold (for

example, to denote “Next” is used)

Inputs for commands and Variables are shown in Italics
File names and paths are shown in bold

Commands are shown in Courier new font

Optional keywords and arguments are enclosed within [ ].

“!l'J Notes:

Contains suggestions or tips.

L 4 Caution:

Contains critical information

How this document is designed

Although this document is designed sequentially, you may choose to skip sections that are
familiar. This document is divided into five parts.

Part 1 explains protecting and recovering a standalone Exchange server to another standalone
Exchange server. Planned failover and unplanned failover are both explained through CX Ul and
CLL Failing back a standalone Exchange server concludes part 1.

Part 2 explains about moving storage groups and mailbox in exchange 2k3 and 2k7.

Part 3 explains protecting a two node cluster with one active and one passive node to a
standalone DR Exchange server. This part is also applicable when there is only one Exchange
Virtual Server (EVS). Planned and unplanned failovers are explained in detail. Failback is
explained in the last section.

Part 4 explains Exchange log rotation. This is an optional step that is performed while backing up
a production Exchange server to a DR Exchange server

Part 5 is the trouble shooting section for this document which deals with possible errors you may

come across and their corresponding workarounds

Please note that Hitachi Dynamic Replicator - Scout does not currently support fabric-based
solutions.



1 Introduction to Exchange failover solution

This section explains the process to tackle Exchange server outages by instantly replacing it with
a backup exchange server of similar or greater hardware configuration. This process can be
referred to as the failover. Failover can be performed under a variety of conditions such as logical
corruption or a hardware error or any other situation where the production server is down.
Failing over to the backup server is a transparent process to end users and minimizes server
downtime. Given below is a picture of a failover process.

Failover to target

Primary Site Secondary Site
CX server

WAN S— Remote Backup
Server

Continuous Data Protection

Production Server

4

\ Failover

Figure 1:

A failback is initiated when the production exchange server is back online and ready to resume
its activities. Depending on the time of outage and data changes, administrators can choose to
reverse replicate -- i.e., update the production server with all the data changes (occurred during
its outage) from the backup server and then replace the backup server (acting in place of the
production server) with the production server.

Failback to the Source
Primary Site Secondary Site
CX server
&L L wan
Continuous Data Protection Remote Backup
% # Server
il |
= Production Server |
Failback
End User
Figure 2:



2 Solution Capabilities

The Solution is capable of:

e Consolidating all backup operations

¢ Minimize Recovery time objective (time taken to recover from an outage)

¢ Continuously backup production server(s) thus reducing the delay between Production and
backup servers.

e Supporting multiple backup servers (both local and remote).

e Respond to an outage by failing over to a backup server.

e Rolling back the target Exchange server in time to a consistent point.

Given below is a figure representing a single exchange server being backed up to two target
exchange servers. These target hosts can be located either locally or a remote site or multiple
remote sites.

Multiple backups

Exchange bkp 2 -

CX Server

m WAN

Production
Exchange server

Figure 3

‘!.I) Notes:

Only one of the target hosts can be used for a failover, while the others remain as a backup




3 How this Solution Works

| Protect | | Exchange Failover | | Exchange Failback
+Exchange Discovery +Exchange Planned Failover +Reversereplication
+\/X replication +Exchange unplanned Failover +Exchange Planned Failback

+Exchange Discovery
*Exchange consistency
+Exchange Log rotation (optional)

Figure 4
3.1 Protecting Exchange

This section is divided into five sections

Exchange Exchange Exchange Bichansalos
. g VX replication . g — nang — Rotation
Discovery Discovery Consistency .
(optional)
Figure 5

Exchange Discovery

The first step for protecting Exchange server is to identify the volumes Exchange server is using.
This is accomplished through the Exchange Discovery FX job. By default all Exchange servers in
the domain are discovered. You may fine tune Exchange discovery by restricting it to a specific
Exchange virtual server or a host.

VXreplication
The next step is a VX replication this is where all the discovered Exchange volumes are replicated

to a remote DR server.

Exchange discovery again

The Exchange discovery job is run once again to capture all configuration related changes such
are replication pairs set, retention path of each replication pair etc. The discovery job is to be run
whenever there are Exchange configuration changes.

Exchange consistency
Finally, a consistency job is run on a periodic basis to issue exchange specific consistency tags.

Exchange Log rotation

Although Exchange log rotation is an optional step, this is performed to maintain free space on
the production Exchange server. Once the log files are validated at the target, a request is sent to
the source Exchange server to remove the validated log files.

‘!?) Notes:

Discovery job is to be performed every time there is an Exchange configuration change.




3.2 Exchange Failover

There are two types of failovers; the first is a planned failover where the production server is
prepared for a failover and then a failover is performed. The second is an unplanned failover
where the production server is not considered (assuming that the production server is
unreachable). Both types of failovers may be performed either through FX jobs (CX UI) or
through CLI

Failover
Planned Unplanned
failover failover
N | | .
Through CX Through Through CX Through
ul CLI ul CLI

4

Figure 6

A planned failover is primarily used when the production exchange server and the CX server
both are reachable by the DR exchange server. An ideal example is a logical corruption on the
production server, DR drills or any planned outages.

An unplanned failover on the other hand is performed when:
e The production server is unreachable and CX server is up and running
o The production server and the CX server are both unreachable

Differences between planned and unplanned failover

Table 1: Differences between unplanned failover and planned failover

_ Unplanned failover Planned failover

Real-time outages or Mock drills, To test the setup.
unexpected outages Any expected outages
Recovered to To latest consistent tag Issues a consistency tag on the

common for all Exchange Exchange volumes. Target is

replication pairs recovered to the same consistent
tag.

Yes, unless the CXis down.  Yes

Yes Yes




3.2.1 Workflow of planned failover

Issue file system

Discovery on Stop Exchange consistency tags on Stop Exchange Discover retention
production — services on —> ST —=»| services ontarget —» logs on target
Exchange volumes production server host Exchange server
exchange volumes
\ |
v
Perform target
volume rollback to User migration & . Start Exchange
consistency tag > AD modification > DHS ey > services on target
issued earlier
Figure 7:
3.2.2 Workflow of unplanned failover
Stops Exchange Rolls back the target
H Exchange volumesto User migration & AD . Start Exchange
ol areel :_: the latest conssistency :_: maodification :_: i Stailoiey :_: services ontarget

Exchange server

tag

Figure 8

\:'!I) Notes:

At least one Exchange discovery is required (post VX replication ) to perform an unplanned

Exchange failover

Unplanned Exchange failover will recovery to the last issued consistency tag on the production

server.
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3.3 Exchange Failback
Exchange failback is performed when the production Exchange server is ready to resume its
operations after a failover. Failback is similar to that of a planned failover. The number of steps

involved in a failback differs depending on the type of environment.

For standalone source and target Exchange servers:

“\
*To discover all volumes (and mount points)
- *Can be performed either through CLI or CX Ul
Iscovery
o
*VX replication of discovered volumes (or mountpoints)
VX *Media retention is enabled for roll back in time capabilities
replication
*A planned failback is performed from the DR server to the
Production server.
E;:irl‘;:cg: *Can be performed through CX Ul or through CLI )

Figure 9

When a clustered target Exchange server is involved, it will be converted into a standalone
machine to enable a VX replication. It will be restored to its clustered form after a failback.

Step 1: Cluster Step 2: VX Step 3:

to Standalone replication Ed Consistency tags —>»| Step4:Rollback

W
Step 5: Step 6: Step 7: Bring the
Standaloneto | Exfailover &DNS —» EVS cluster
cluster failback resource online
Figure 10
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3.4 FXtemplates involved

Table 2:

Name of the template When is it used

Exchange 2003/2007= Exchange
Discovery

Exchange 2003= Exchange
Consistency

Exchange 2007= Exchange 2007
Consistency

Exchange 2003= Exchange Planned
Failover

Exchange 2007= Exchange 2007
planned failover

Exchange 2003= Exchange
Unplanned Failover

Exchange 2007= Exchange 2007
Unplanned Failover

Exchange 2003 = Exchange planned
Failback

Exchange 2007 = Exchange 2007
Planned Failback

Exchange 2003 =
Exchange Failover without
Retention

Exchange 2003= Exchange 2007
Failover without Retention

To discover
exchange volumes.
Discovery can be
restricted to a host
or even an EVS

To issue consistency
markers at regular
intervals on the
source volumes

To perform a
planned Failover
through CX UI

To perform an
unplanned Failover
through CX UI

To perform a
planned Exchange
failback

To perform a
failover for
replication pairs set
without CDP
retention

Discovery job is
performed before
setting the
replication pairs,
after setting up
replication pairs and
after any Exchange
configuration
changes.

After setting VX
replication pairs
with CDP retention.

When a planned
failover through CX
Ul is required

When an unplanned
failover through CX
Ul is desired

When a planned

failback is attempted

through CX UI

Exchange
Discovery is
required to
perform an
unplanned
failover at a
later time

At least one
consistency
tag is
required to
perform a
failover

12



Exchange 2003= Exchange
Consistency Validation

Exchange 2007=
Exchange 2007 Consistency
Validation

Exchange 2003=
Exchange Log rotation

Used to remove
validated exchange
logs

After setting up
replication pairs and
after consistency
validation is
completed.

13



4 Pre-requisites

1

© 0 NS YR W N e

0.

By default, Exchange is installed on the system volume; you will need to move the Exchange
DB, Storage group and mailboxes to a non-system volume. Refer to the section Moving
Storage Groups and Mailbox Store for exchange 2003 on page 15

VX and FX agent should be installed on both production and DR servers. Both these VX and
FX agents should be pointed to the same CX server to enable CX based failover/failback.

Ensure that all FX agent service should be configured to start with “domain administrator
privileges”.

Domain administrator should be member of local administrators group.

Ensure that you maintain drive mapping while setting replication pairs (i.e., replicating from
D:\ on the production server to the D:\ on the DR server).

Exchange server should be installed on the DR server with similar settings, directory
locations and service packs as on the respective production server.

After Exchange server 2007 failover, storage groups may not mount if LCR is enabled at
source Exchange server.

Failover of Exchange 2007 is not supported if CCR is configured

Disable the option “Register this connection's addresses in DNS” for all network
connections on the production Exchange server.

Login as a domain administrator to perform any CLI operation .
Automated Exchange failover with Nested mount points is not supported

Ensure that you do not name the production server with any of the following.
<Names of mail stores>,
<Storage Group Name>,
InformationStore ,
<Organization Name>,
Administrative ,
Groups,

Microsoft

Exchange,

Services,

Configuration

Else the failover will exit with an error code of 32.

14



e Ensure that a separate volume with sufficient space is available for CDP retention log files

¢  On clustered production servers you will need to set the registry value “UseConfiguredIP”
to decimal 3255. Another registry value “ConfiguredIP” should be set to the public IP
address, since the private I address will be internally used for clustering. Both registry
values are under “"HKEY_LOCAL_MACHINE\SOFTWARE\SV
Systems\FileReplicationAgent”

o Configure all the FX jobs such as discovery, consistency, failover, failback within the same job
group on the CX-UL

e Exchange server installation binaries should not be present on the source or target volumes.

4.1 Moving Storage Groups and Mailbox Store for exchange 2003

This section describes about how to move both mailbox as well as storage groups in exchange
windows 2003 from one drive to another drive. Steps are given below about how to proceed. First
storage group is moved first, mailbox, and then public storage group.

Move private : Move the
mail store private store

/

s ™

Move the
exchange logs

s 7/

Figure 11:
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4.1.1 Moving Storage Group

Step 1. Access the production Exchange server and navigate through “Start->Programs-

>Microsoft Exchange -> System Manager”.

I Prograrns L4

fﬁ Microsoft Exchange
Exchange LoadSim

g '55 Swyskem Manager

Figure 12:

Step 2. This should open the “Exchange System Manager”. Expand “Administrative Groups”
and then expand “Servers”.

IMITS035

*. Exchange System Manager

'ﬁﬂ File  Ackion  Miew Window

Help

&= | O e DB @@

‘:4 First Crganization (Exchang - |
,__j Global Settings
,__j Recipients
ElL_',‘r' Administrative Groups
i El L First Administrative
i -3 Servers

Administrative Groups
Tarne

@ First Administrative Group
@ Sample Admin Group

Figure 13:

Step 3. All the exchange servers within the domain will appear under the server. Then expand
the production exchange server, and select “First Storage Group”.

-5 GUESTZ

-5 mMITS-033

-5 mITs0as
IE Queles

: 125 Public
-3 Prokocals

-4 WILEADEVIIWI

First Storage Group
= Mailbox Store

Folder Store

Figure 14:

16



Step 4. Right click on the “First Storage Group” and click on “Properties”.

E|j IMITS03S

i welE Quedes
s |
- - Mailbox Sto L= '
[#-1£5 Public Folde Vi b
e Protocols Mews 'Window from Here
o LOMNGTGET

|5 METMAMERESEWSZ Delete

= METMAMRESEYSZ Rename
= METWORKMAMERE Refresh
o PRAVEXZ Expart Lisk, ..
o PRAVEX4
o PROEYSE

: @ R1 Help

Figure 15:

Step 5. You should now see the “First Storage Group properties” screen. To change the
Transaction log location click on the browse button corresponding to it.

First Storage Group Properties S|

General | Details |

‘_I-]] First Storage Group

Tranzaction log location;

C:"Program Files\E

Browse. .

System path location;

IC: “Program Files\ExcherryMOBDATA Browse...

Log file prefis:
IEDD

[~ Zero out deleted database pages
[~ Enable circular logging

1]4 I Cancel Lpply Help

Figure 16:



Step 6. You may create or select a new location for the transaction logs then click on “OK”.

Transaction Log 2|
Folders

4 My Camputer ]
ﬂ, 3% Floppy (A:)
“e Local Disk (2:)
i CD Drive (00)
“e® Mew Wolume (E:)
5 logkk:

[£5) loglL

Falder: I Mew Folder

Make MNew Folder Ok Cancel

Figure 17:

0HEMHE

Step 7. Repeat previous steps to change the “System Path Location” then click on “Apply”.

First Storage Group Properties ilil

General | Details I

,:Ij First Storage Group

Tranzaction log location:

IE:\FSG logs Browse... |

System path location:
IE:\FSG logs

Log file prefis:
IEDD

[~ Zem out deleted database pages
[~ Enable circular logging

Ok Cancel Apply Help

Figure 18:



Step 8. A confirmation message box appears. Click on “Yes” to proceed or “No” to cancel and go

back.

Exchange System Manager X[

You are about to perform the Following operation(s):
A - change Exchange transaction log path location
- change Exchange system path location
To perform the requested operation(s), all the stores associated with this storage group must be tempararily dismounted which wil
make them inaccessible to any user,

Do you want to continue?

Figure 19:

Step 9. A progress bar appears indicating that the transaction logs are being moved.

First Storage Group

@ Dizmounting Mailbox Stare' ...

Figure 20:

Step 10.A message box appears indicating that the logs are moved successfully. Click on “OK” to
continue.

First Storage Group x|

1] The paths have been successfully changed and all the previously mounted stores are back online.
LY

Figure 21:
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4.1.2 Moving Mailbox Store

Step 1. On the Exchange system manager, select the production server and then expand “First
Storage Group” to select the “Mailbox Store”.

e

=
[+~ [5 IMITS-033
= IMIT5035
..... 15 Queues
== First Storage Group
E|1_|ﬁ Pailboz: Skor
.__j Logons

.__j Mailboxes
i LT Full-Text Indexing
-5 Public Folder Store

,__j Protocols

Figure 22:

Step 2. Right click on the “Mailbox Store” and click on the “Properties”.

- [ GILEADEYSHY1

#- 5 GUESTZ

B[ IMITS-053

= MITS03s

..... 14 queues

El‘_LIJ First Storage Group

8

..J Logo  Dismount Store

3 Maib Create Full-Text Index

_ L@ Full-1 Statk Incremental Fopulation
..,é; Public Fo . Stark Full Populakion

,__j Protocaols Pause Population

B LONGTGT Stop Population

- [ METMAMERESEY:

-] METMAMRESEvs; Al Tasks g
B[ METWORKNAMER o, X
*—-] PRAVEXZ Mew Wwindaow From Here
- PRAVEX4

#- 5 PRCEVS1 Cut

J R1 Copy

._'] RZ Delete

[+ [ SFOEXEWS Rename

._'] 3ICEXL Refre;h

~—'] SRWZK3-32 Export List. ..

[+ [ TRGEW2K3-32

= [Froperties |

Figure 23:



Step 3. You should now see the “Mailbox Store Properties” screen. To change the “Exchange
Database” path click on “Browse Button” corresponding to it.

Mailbox Store Properties 2 x|

Details | Policies | Security
General Databaze | Lirnits I Full-Test Indexing

Exchange databaze:

IE:\F‘ngram FiIes\Exchsrw\MDBDAT.t’-‘«\:Emp.edb Browse... |

Exchange streaming databaze:

IC:\F’ngram Files\Exchsrer\MDBDAT A%priv . stm Browse... |

Maintenance interval:

IHun daily from 1:00 Ak to 5:00 Ak j Cuztamize. .. |

Time of last full backup:

IThis type of backup was never performed.

Tirne of |ast incremettal backup:

IThis type of backup was never performed.

[~ D not maunt this stare at start-ug

[ This database can be ovenaritten by a restore

0k I Cancel Apply Help

Figure 24:

Step 4. You may create or select the drive where you want to save and click on “Save” button.

Exchange Streaming Database e

Save in: | ) FSG DB B Cl=1="

Fil= name: Ipriv1 st j \ﬂl
j Cancel |

Save as type: IEHchange streaming databases

Figure 25:



Step 5. Repeat the previous steps for “Exchange Streaming Database” and then click on
llApPly”.

Mailbox Store Properties e |

Details I Policies | Security
General Database | Limitz | Full-Text Indexing

Exchange databaze:

Browse...

Exchange streaming databasze:

_ oz, |
IF:\FSG DENprivl . stm Browse... |
_Lustomizs.. |

taintenance interval:

|F|un daily from 1:00 AM to 5:00 AM j LCustomize...

Time of lazt full backup:

IThis twpe of backup was never performed.

Time of last incremental backup:

IThis tppe of backup was never performed,

[~ Do not mount this store at start-up

[~ This database can be ovenwitien by a restore

ok I Cancel | Apply I Help

Figure 26:

Step 6. A confirmation message box appears. Click on “Yes” to proceed or “No” to cancel and go
back.

Exchange System Manager ﬁ

You ate about to perform the Folowing operation(s):
- change %hange database [ocation

- change Ewghange streaming database location
To petform the requested operation(s), the store must be temporarily dismounted which wil make it inaccessible to any user,

Davou wank to continue?

Yes

Figure 27:

Step 7. A progress bar appears indicating that the “Mailbox” is being moved.

Mailbox Store

@ M ounting ‘Mailbox Store' .

6625

Figure 28:
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Step 8. A message pops up. Click on “OK”.

Details | Policies | Security
General Database | Limitz | Full-Test |ndexing

Exchange database:
IF:\FSG DE\tmp.edb Browse...

Exchange streaming database:

| [

IF:\FSG DBYpriv] stm Browse...
Hain - "

=

Run

Time ! The database files have been successfully moved.
IThis

Time

[ Do ok mount this store at start-up

[ This database can be ovenritten by a restore

Mailbox Store Properties el |

ak Cancel Apply Help

Figure 29:
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4.1.3 Moving Public Folder Store

Step 9. All the exchange servers within the domain appear under the server. Then, expand the
production exchange server, and then select “Public Folder Store”.

B3 IMITE0ss
~1H queues

=2} First Storage Group
-1 Mailbox Store

- [ Logons

- Mailbowes

i Full-Text Indexing
E,Q Public Folder Store

- Logons

--{_J Public Folder Instances
-{_J Public Folders

{1 Replication Skatus
-{_J Full-Text Indexing

Figure 30:

Step 10.Right click on the “Public Folder Store” and click on the “Properties”.

-5 IMITS035

lg Queues

L:J‘_UJ First Starage G Dismount Store
Uxﬂ Mailbose Stc cpeste Full-Tegt Index
E"‘u“:? F"t'l": Rk Start Incremental Population
'—-'i Lagu.ns Start Full Papulation
i PUE:!E P Pause Population
'-J :‘I II.':F Stop Population
j Fjlll:i;:; Resend Changes...
_ " Move Al Replicas
[#-{_4 Protocals
- LOMGTET Al Tasks .
-5 METMAMERESEWSZ
-5 METMAMRESEWSZ il=l] »
-5 METWORKMAMERE — Mew ‘Window From Here
B[ Pravexz ot
B[ PRAVEXS o
-0 PRCEVSI =R
M- R Celete
[]._‘] Rz Rename
- o SFOEXEWS Refresh
-5 SICER Expark Lisk. ..
B[ SRweks-32 .
Properties

B ] TRGwaKa-a2
[ =1 Help

Figure 31:



Step 11.You should now see the “Public Folder Store Properties” screen. Select on “Database
Tab”. To change the “Exchange Database” location click on “Browse”.

Public Folder Store Properties el

Full-Text Indexing | Details I Palicies | Security
General Database | Replication I Limnitz

Exchange database:

Browsze. ..

Exchange streaming database:
IC: “Program FileshExchzryisMDEDATANPUbT . 2tm Browse. ..

Maintenance interval:
IFlun daily from 1:00 AM ta 5:00 AM j Custamize...

FFr

Time of last full backup:

IThis tppe of backup was never performed,

Time of last incremental backup:

IThis tppe of backup was never performed,

[ Do not mount thiz stare at start-up

[" This database can be ovenriten by a restare

k. I Cancel Lipply Help

Figure 32:

Step 12.You may create or select the new location where you want to store it. Click on “Save”.

Exchange Streaming Database 2=l

Save i Ilﬂ Public Folder Store j =] % [FE-

File name: IF'ub1 _stm j &I
Save as lppe: IExchange shreaming databases j ﬂl
4

Figure 33:




Step 13.Repeat the above steps “Exchange Streaming Database”. Then, click on “Apply”.

Public Folder Store Properties ed

Full-Text IndeHir‘l& | D etails | Policies I Sectrity
General Database I Replication I Lirnits

Erchange database:

IF:\F'uinc: Folder StoretPubl.edb Browse... |

Exchange streaming database:
IF:\F'uinc: Folder StorehPubl.stm

Maintenance interval:

IHun daily from 1:00.4k to 500 Ak j Customize... |

Time of last full backup:

IThis type of backup was never performed.

Time of last incremental backup:

IThis type of backup was never performed.

[~ Do nok mount this stare at start-up

™ This database can be ovenwritten by a rastare

0Ok | Cancel | Lpply | Help |

Figure 34:

Step 14.A confirmation message box appears. Click on “Yes” to continue or click on “No” to
cancel and go back.

Exchange System Manager ﬂ

You are about to perform the following operation(s):
B - change Exchange database location

- change Exchange streaming database location

To perform the requested operation(s), the stare must be temporariy dismounted which wil make it inaccessible to any user,

Do you wank ta continue?

Figure 35:

Step 15.A message box appears indicating that the database files are successfully moved. Click
on “OK”.

Public Folder Store x|

L] E The database files have been successfully moved.
L

Figure 36:



Step 16.You should now see the “Public Folder Store Properties” screen indicating the new
paths for “Exchange Databases” and “Exchange Streaming Database”. Click on “OK.”

Public Folder Store Properties 2 x|

Full-Text Indexing | Dietails I Policies I SecLrity I
General Database | Fieplication I Limitz

Exchange databaze:

F:Public Faolde &'Publ.edb

Browse. ..

Exchange streaming database:
IF:'\F'uinc Folder StaretPubl. ztm Browse. ..

Maintenance interval:
IHun daily from 1:00 Ak to 5:00 Ak j LCustamize...

4

Time of lazt full backup:

IThis tppe of backup was never perfarmed,

Time of |azt incremental backup:

IThis type of backup was never performed.

™ Do not mount this store at start-up

[~ This database can be ovenwiitten by a restore

ak. I Cancel Al Help

Figure 37:

4.2 Procedure for Exchange 2007

This section explains about how to move both mailbox and storage groups from the system drive
(For example C:\) to any other drive. Steps given below are given below about how to proceed.
Logs are moved first followed by the mailbox and database.

e ™ e ™ . I

Move the exchange ) ) Move the private
logs Move private mail store

store

Figure 38
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4.2.1 Moving the Logs

Step 17. Access the production Exchange server and then navigate through “Start->Programs-
>Microsoft Exchange Server 2007->Exchange Management Console”.

rﬂ TS . ACCESSONES

fﬁ Microsaft Exchange Server 2007 *|B8 Exchange Management Consale

Figure 39:

Step 18.You should now see the “Exchange Management Console” screen. Expand the “server
configuration” to click on the “mailbox”.

Step 19.Select the mailbox to be moved. In this example, we move the mailbox named “Exprod”.

File  Action View Help
€= | Bam 2

£3 Microsoft Exchange
Organization Configuration
Server Configuration

T Mailbe

"I Create Filker

Clisht ariais Mame = | Fiole | \ergion |
Hub Transpart i—,d ExDR Hub Transport, Client &cce..  Version 8.0 [Build 635.24]
:::d ExFROD Hub Transport, Client &cce..  Version 8.0 [Build 685.24]

= Urified Messaging
* ._3) Recipient Configuration
=8 Toolbox

Figure 40

Step 20.All the exchange servers within the domain will appear under the server. Expand “First
Storage Group” of “Exchange Management Console”. Right click and click on “Move
Storage Group Path”.

Databaze File Path

M ame

First Storage Gig
i Maibox Databe

= o5econd Storage
“ Public Folder D Mew Public Folder Database. ..

Enable local continuous replication. ..

Move Storage Group Path. ..

kchange Serverst ailboshFirst SY
Mew Mailbox Database. ..

kchange ServerstailboxhSecon

Figure 41:
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Step 21.You should now see the “Storage Group Name” screen. To change the “Log Files Path”

location click on the “Browse” corresponding to it.

: l Move Storage Group Path

O Introduction Introduction

[ Completion Thiz wizard helps you move a storage group to a different location.

Log filez path:

IE:\F‘rogram Filez\Micrazoft\Exchange Server\MailboxhFirst Storage Grou Browsze. .. |

System files path:
| IC:\Plogram Files'Microsoft\Exchange ServerMailboxsFirst Storage Grou Browse... |

Help | < Back | Mave I Cancel I

Figure 42:

Step 22.You may create or select new location to move the folder. Click on “OK”.

Specify the log location For the storage group, To create a
new direckary, click the Make New Folder button below,

@' Deskbop 1=
.D My Documents

El j Ty Comnpuker

ﬁ 314 Floppy (400

< Local Disk (C&

s CD Drive (D)

“e [ew Yolume (B

-

“e Mew Yolume (F1)
, = ewtolume (G:) [

0 B

"mE

Make Mew Folder I ul's I Zancel |

Figure 43:
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Step 23.You should now see the “Mail Storage Group Path” screen. You can observer a progress

bar next to “First Storage Group” indicating that the logs are being moved.

——

% ﬁ Move Storage Group Path
M Introduction Completion
1 Completion Elapzed time: 00:00.57

Summary: 1 item(z]. 0 succeeded, 0 failed.
“f First Starage Group =

ol

Statuz: Copying log files

Elapsged Time: 00:00:53

Figure 44:

Step 24.A confirmation message box appears. Click on “Yes” to continue or “No” to cancel and

go back.

Microsoft Exchange x|

g Toperfarm the move operation, all the databases in storage group "EXPRODYFirst
' ! ! Storage Group" must be temporarily dismounted which will make them inaccessible
— to any uzer, Do pou want to continue?

Tes Mo |

Figure 45:

Step 25.Click on “Finish” button.

ol
|
—'ﬁ Move Storage Group Path

1 Introduc Completion

The wizard completed successfully. Click Finish to cloze this wizard.
Elapsed time: 00:01:12

Summany; 1 tem(z]. 1 succeeded, 0 failed.

_*“_* First Storage Group .&.

[ Completion

»

Exchange Management Shell command completed;
move-StarageGroupPath -l dentity 'EXPRODFirst Storage Group' -LogFolderPath
'E:AFSG Logs' -SystemFolderPath 'EAFSG Logs'

Elapzed Time: 00:01:12

Select Chil+C to copy the contents of thiz page.

Help | < Back | Firnizh I Cancel

Figure 46:
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4.2.2 Moving Private Store

Step 26.All the exchange servers within the domain will appear under the server. Expand
“Mailbox Database” of “Exchange Management Console”.

D atabase* anagement |

M ame | Databasze File Path
=] g First Storage Group

il atabase

=l o Second Storage Group
“ Public Folder D atabase

C:%Program Files'Micrasoft\E xchange Server'M albox\S econd Starage GrouphPublic Folder Database.e:

Figure 47:

Step 27.Right click on the “Mailbox Database” and click on “Move Database Path”.

Mame | [ratabase File Path |
= | g First Storage Group

.,
[l | 5 Second Storag

Dismount Database

‘| Public: Falder [ ‘Wicrosoft\Exchange ServersMailbox\Second Storage Group\Public Folder D atabas
Remove
Properties
Help
Figure 48:

Step 28.You should now see the “Move Database Path” screen. To change the “Database File
Path” ]location click on “Browse”.

I—‘\

’,” Move Database Path

O Introduction Introduction
1 Complation This wizard helps pou move database files to a different location.
Provide the updated file path for this databaze.

Storage group name:
IEXPHDD\Filst Storage Group

D atabase name:
IM ailbox Database

Database file path:

| |E:\Program Fileg'MicrozofthE xchange Servershailbox'First Storage Grou
Help | < Back Move I Cancel |

Figure 49:
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Step 29.You may create or select a new location to save. Click on “Save”.

nge Database i X
Save in: IE} FSG Database j @ _? - "

File: name: I‘-.-1.5

j Save I
j Caticel /L

Save az type: | Exchange D atabaze File[".edb)

Figure 50:

Step 30.You should now see the “Move Database Path” screen indicating that “Private Store” is
moved. Select on “Finish”.

; Move Database Path

1 Introduction Completion

The wizard completed successfully. Click Finizh to close this wizard.
Elapszed time: 00:00.29

Summary: 1 itern(z]. 1 succeeded, 0 failad.

1 Completion

= Mailbox Database @. Completed £
Exchange Management Shell command completed:
move-D atabasePath -|dentity 'EXPRODYFirst Storage Grouphtailbox Databaze'
-EdbFileFath 'F:MFSG Database\Mailbox Database edb’

Elapzed Time: 00:00:39

Select Chi+C to copy the contents of thiz page.

Help | < Back | Firizh I Caricel

Figure 51:
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4.2.3 Moving the Public Store

Step 31.Select “Public Folder Database” under “Second Storage Group” of Database
Management under “Exchange Management Console”. Right click and select move the
database file path.

[l o Second Storage Group

1 Public: Folder D atabase C:\Program Files\MicrosofthExchange ServersMailbox\Second Storage GrouphPublic Folder Database. e

Figure 52:

Step 32.You should see “Move Database Path” screen. To change “Storage Group Path” location

click on “Browse”.

=N

" Move Database Path

&) Introduc%-n Introduction
[ Complation This wizard helps vou move database files to a different location.
Pravide the updated file path for this database.

Storage group name:

|E><F'F|DD\Second Starage Group

Database narme:
IF'uinc Folder Databaze

Database file path:

IC:\F‘rog_ram Filez\MicrosoftsE schange ServersMailbossSecond Storage
Help | < Back Move | Cancel |

Figure 53:

Step 33.You may create or select to move and then create a new folder “FSG Logs”. Click on

“Save”
Save in: IL':} FSG Database j (€] 0 e

catalogdata-9d42bed5-825e-4313-a229-ed4atfcd 15eb-ccedddad-2428-4F 1 2-bbaz-79déc
Mailbox Database, edb

File name: F'uhliu:: Folder [ at: : j Save I
j Cancel |
F

Save az type: |E:<-:hange D atabasze File[* edb)

Figure 54:
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Step 34.Click on “Move”.

| =
_/ Move Database Path

O Introduction Q Introduction
1 Carmpletion This wizard helps vou move database files to a different location.

Provide the updated file path far this database.

Storage group name:
IEXPHDD\Second Storage Group

D atabase name:
IF'uinc: Folder Database

D atabase file path:

IF.\FSG D atabasePublic Folder D atabase.edb
Help | < Back Mave | Cancel |

Figure 55:

Step 35.You should now see “Move Database Path” screen. Click on “Finish”.

i
|
2 / Move Database Path

1 Introduction Completion

The wizard completed successfully. Click Finish to cloze thiz wizard,
Elapsed time: D0:00:16

Summary: 1 item(z]. 1 succeeded, O failed.

¥ Public Foldst Database @

M Completion

E xchange Management Shell command completed:
move-D atabazePath -ldentity EXPRODASecond Storage GrouphPublic Folder
Database’ -EdbFilePath 'F:4FSG Databasze'\Public Folder Database edb’

Elapsed Time: 00:00:16

|
Select Cirl+C to copy the contents of thiz page.

»

Help | < Back | Finizh I Cancel

Figure 56:
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Step 36.A message box appears indicating Databases are being moved. Click on “Yes” to

continue or “No” to cancel and go back. Click on “Finish”.

L__I\./- Move Database Path

M Introduction Completion
Elapsed time: 00:00:05

[ Completion 4 )
Summary: 1 itemfz). 0 succeeded, 0 failed.

Status: Checking the replay state
Elapzed Time: 00:00.08

Microsoft Ekchange i

g Toperform the move operation, the database "ExPRODYS econd Storage
| l ' Group\Public Folder D atabase” must be tempararily dismaunted which will make it
= naccessible to any user. Do you want to continue?

FES Mo

= public Folder Database []

x|

Select Ctrl+C to copy the contents of this page.

Help | < Back Firizh

Cancel

o

Figure 57:
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4.3 Dependent services

For Exchange Server, Scout does not start or stop all the dependent services automatically during
failover or failback operation. By default, For Exchange 2007 it starts and stops “Exchange
Information Store” and “Exchange System attendant” services and for Exchange 2003, by
default it starts and stops “Exchange Information Store”, and “Exchange System attendant”,
“Exchange MTA”, “Exchange Management” and “Exchange routing engine” services. To start
and stop other dependent services during failover and failback operation, use
Failoverservices.conf file. The “failoverservices.conf” file is located under the “consistency”
folder (under VX installation path).

To stop and start the dependent services, create a section [Exchange] in failoverServices.conf file
in not already present. In the section, add two keys START and STOP. Write services name that
should be started in START key separated by comma and write services that should be stopped
in STOP key. The service name should NOT be placed in double quotes even if there is any space
in the service name. Services name must be listed in the proper order. Scout starts services from
right to left & stops services from left to right. Scout stops all the listed dependent services before
stopping default Exchange services and starts all the listed dependent services after starting
default Exchange services. This ensures that these services are stopped and started while
performing failover.

Format of the section appears as below.
[Exchange]
START=<ServiceNamel>,<ServiceName2>,....
STOP=<ServiceNamel>,<ServiceName2>,....

Example,

[P\ FailoverServices.conf - Notepad

[ExCHANGE]
START=ElackBerry Policy Service,BlackBerry Dispatcher,ElackBerry Syncserver
SToP=EBlackBerry Policy Service,BlackBerry Dispatcher,BlackBerry SyncSerwver

Figure 58

"!'l) Notes:

If dependent services of the Exchange Server are running and those are not listed in
failoverservices.conf file, then default Exchange services cannot be stopped..
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4.4 Adding DR Exchange server to SMTP connector

Access the Exchange System manager then navigate to “Administrative Groups -> First
Administrative Group -> Routing Groups -> First Routing Group -> Connectors” and right click
on the desired connector and select “Properties”

Click on the General tab then add the DR Exchange server as a member of this connector.

Primaryconnector Properties ﬂﬂ
Content Restrictions I [reliveny Optiong | Detailz I
General I Femate Bridgehead | Delivery Restrictions

jE Primaryconnector

LConnects this routing group with:

I Exchange Routing Group [0WEBGZMFDOTAMNEIR] [Exchange .ﬁ.dminisj

Cost: |'|

A local server can send mail over this connector

(¥ These servers can send mail over this connectar;

Server | Wirtual Server

(2K E32CP116RS1 Default SMTP Virtual Server
CP116RT1 Default SMTR Virtual S erver

Add... Remove |

[ Do nat allow public folder refenals

0k | Cancel | Apply Help

Figure 59

Doing this will ensure that the emails will pass through the same SMTP connector even after
failover
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4.5 Creating special user for Exchange solution

The table below shows the required privileges in different phases of the Exchange solution

MS Exchange Server I

-‘

Discovery Service account should be added to the Local Administrators Group on
both the Master and Replica servers because,

Get root volume/mount point corresponding to each database/log file
path

Service account should be given full control of the source/target MS
Exchange server objects (Under configuration tree) at Active directory
because,

During discovery, application.exe queries the Exchange server objects at
active directory for database/log file paths

Failover
(Planned/Unplann
ed)
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AD replication/ Add service account to built-in administrators group of each domain
DNS update controller

Introduction

This chapter describes about the necessary privileges for the exchange failover and failback. It
also describes the granular permissions required to allow the InMage service to successfully
perform an exchange failover and failback. To set privileges you need to create domain user first
then full control over the DNS for each source and target.

The processes involved in this document are:

¢ Create a Domain User

e Add this user to Production Server and DR Server record in DNS Server management
console

e Add this user to Production Server and DR Server in Active Directory using ADSI Edit and
give full permission.

e Add this user to the Microsoft exchange under services of configuration tree.

-
q) Notes:

You need a domain administrator for following the steps given below.

Detailed procedure to set privileges is as follows.
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Create a Domain User

Step 37.Log on to the domain controller as an administrator where Production Server and DR
Server are part of the domain.

Step 38.Click on “Start->Programs->Administrative Tools ->Active Directory Users and
Computers”.

'E Progranms |

k 6[13 Active Directory Domains and Trusts

<y Documents r (+ @ fctive Directary Sites and Services

' {-; Ackive Directory Users and Computers |

Figure 60

Step 39.You should be able to see “Active Directory Users and Computers” screen. Under

“Active Directory Users and Computers”, select “Users”, a list of users appears on the right

hand side, right click, and select “New->User”.

5 Active Directory Users and Computers

@ Elle Action Yiew Window Help
= | AW BENE 2 sEhvga

@ Active Direckory Users and Computer | Users 45 abjects

[0 saved Queries Name 7 Type | Description
=59 bitaz arg 0 Activel User
8 Builtin € Active? User
=R COMD?JtEI’S € Administratar Delegate Contral...
{&] Domain Controllers € Cert Pubiishers Find
-] ForeignSecurityPrincipals 1 R
& Loadsim Users o EISZ Computer
ds:
-3 Users € oot Conkack All Tasks »
Grouj
€ ooz P Refresh
g InetCrgPerson
Do3 _based Distribution & Export List...
€T Dnstdmine Query-base: \Is ribution Group .
mDnsUpdatsPruxy MSMQ Queue Alias Wiew 4
Printer
Dornain Adrins User #Arrange [cons 4
€7 Domain Computers e Ling up Icons
Shared Folder =
@Domam Cantrollers Propetties
ﬁanmam GUests
access to the computerjda...
£ Dormain Lisers Help

Figure 61:

40



Step 40.You should be able to see “New Object-User” screen. Enter the “Name” and “User
Logon Name” and click on “Next”. In this example, first name and user logon name as

“InMageUser” is used.

New Object - User |

g Create ;. bit32 org/U zers

First name: IInM agellzer Initials: I

Lazt hame: I

Full name: IInM agellszer

Uszer logon name:

IInM agellzer I@bitSE.urg j

Uzer logon name [pre-wWindowes 2000]:
|B|T32\ IInMageUSEI

< Back I Mext » I Cancel

Figure 62:

Step 41.Enter the “Password” and select “Password Never Expires”. You will get a message
indicating that you will not be required to change the password at next logon, click “OK”,
and click “Next”.

Mew Object - User x|

g Create in;  bit32 org/Users

Bassword: Ioooooo.o

Confirm password: qunn

¥ User must change pazsword at nest lngon

™ Uger cannat change passward

Active Directory x|

4 tis disabled ¥ou specified that the password should never expire,
(B il [ GlRElE The user will not be required to change the password at next logon,

¥ Password never expires

< Back Mest » Cancel

Figure 63:



Step 42.You will now see the user name details,click on “Finish”.

Mew Object - User |

g Create in:  bit32 org/Users

When you click Finish, the fallowing object will be created:

Full name: Inkd agel] zer ;I
[ zer lngan name: Inkd agellsen@hit32 org

The pazzword newver expires.

[

< Back Cancel I

Figure 64:

Permission for DNS Record Change

Step 43.Click on “Start->Programs->Administrative Tools->DNS” or “Run dnsmngmt.msc”
from command line. You should be able to see DNS management screen. Expand “Domain”,
select the source host name on the right side, right click, and click on the “Properties”.

_;._ dnsmgmt - [BNSQA-BIT32-DC Forward Lookup Zones'bit32.org]

'E,' File  Action Yew Window Help

2 DNS bit32.org 339 recordis)
-3 QaBITaz-nC HName
{:I Cached Lookups FilaSarver
ED Forward Lookip Zones FileServert
-z _msdes bitz2.org i
EI hit32,org Fileoerverz
- i filzsharerw
% eites 2] imitzs0z8
D _ep Dielete
B |5 e
-1 DomainDnsZones a imitsd - properties
-1 ForestDnsZones E imitsd —————
-] TEST.COM imits0__Help
-1 Reverse Lookup Zones |E] F3-Nodez

Figure 65:
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Step 44.You should be able to see a source host properties screen. Click on the “Security” tab.

Click on “Add”.

imits035 Properties 7=

Host [&]  Security |

Group or uzer names:

ﬁ Authentic
ﬁ Dramain Adming [BIT32%Domain Adming)

ﬁ Enterprize Adming [BIT 325\E nterprize Adminz)
ﬁ EMTERPRISE DOMAIMN COMTROLLERS

ml‘ d

Add... | Remove |
Permizzions for Administrators Al Drerw
Full Contral O O
Read O
Write O
Special Permissions O

For special permizsions or for advanced settings, Advanced |
click Advanced. -

(] I Cancel | Spply

Figure 66:

Step 45.You should be able to see “Select Users, Computers, or Groups” screen. Select the

domain user name (InMageUser) created in the previous steps and check if this username is

available or not by clicking on the “Check Names”.

Select Users, Computers, or Groups

Select thiz object type:

IUsers, Groupz, or Built-in zecurity principals Object Types...

From thiz location:

Ibit32.org Locations. ..

Enter the object names to select [exnamples]:
Intdagell zer [Inkd agell ser(@hit32 ang Check Mamez

Advanced. . | ] | Cancel I

A

&

Figure 67:
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Step 46.Click on “Full Control” check box. Click on “OK”.

imits035 Propetties i |

Host [4] Securty |

Group or user hames:

€ IMITS0358 [BIT32AMITS0354) ;I
ﬁ inmage [inmage’@hit32. org)

ﬁ |nkd agellzer [Ink ageMzer@hita2 arg)

ﬁ Fre-windows 2000 E%patible Accesz [BIT32YPrewindows ED...J

€7 SvSTEM
Add... | Bemowve |
Permizzionz for [nkd agell zer Al Deny
Full Cormtral ) (M|
Fead (M|
Wirite O
Special Permizsions O O

For zpecial permizzions or for advanced settings, Advanced |
chck Advanced. =
(] I Cancel | Apply |

Figure 68:

Step 47.Repeat the same steps on the “DR-Server”

\ll) Notes:

On Cluster environment, you need to grant full privileges of DNS for the exchange virtual
server name by repeating the above steps




Permission for AD Changes

Step 48.Click “Start->Run->MMC”, select “Add/Remove Snap”-from File Menu, and Click on

llAddll‘

File Action Wiew Favortes window  Helo

- o |[E B2

“fi Console Root
3 Console Roat

Add/Remove Snap-in
Standalone | Extengions |

Use thiz page to add or remove a standalone Snap-in from the cf

Shap-ing added b Ia Cangole Roaot

i~ Description

Figure 69:

Add... | Eemove About.. |

oK |

Step 49.You should be able to see an “Add Standalone Snap-in” screen, select “ADSI Edit”, and

click on “Add”.

Add Standalone Snap-in

Awailable Standalone Snap-inz:

Shap-in

| Yendor | -

5‘% MET Framework 1.1 Configuration
éE.t‘-‘-.ctive Directory Domains and Trusts
@Active Directary Sites and Services
@.’-\ctive Directary Users and Comput...
ﬁ.&clivex Control

E%.&uthorization M anager

Microzoft Corparation

Microzoft Corporation
Microzoft Carparation
Microzoft Corparation
Microzoft Corporation
Microzoft Carparation
Microzoft Corparation

Certificate Templates Microzoft Corporation
@ Certificates Microzoft Carparation
@ Certification Authority Microzoft Corparation LI
e
r— Dezcription

& low level Active Directory Services Interface editor.

Add LCloze

Figure 70:
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‘!I) Notes:

You need to install “ADSI Edit” before you add it in “Add Standalone Snap-in” (This is
available in Windows Support Tools)

Step 50.You should be able to see “Add/Remove Snap-in” screen and click on “OK”.

Add/Remove Snap-in 21x|

Standalone | Extensions |

Usge thiz page to add or remove a standalone Snap-in from the congole,
Snaping added ta: Ia Console Root j
3 ADSI Edi
r— Drezcription
Bemove Abaut. |

QK | Cancel |

Figure 71:

Step 51.You should be able to see “console” screen. Select “ADSI Edit”, right click, and click on

“Connect To”.

i Consolel

File Action Yiew Favorites  indow

= | Bm B[

'{ii Console Root', ADSI Edit

(L1 Console Roat

-5 IR

Conneck ko, ..

View k
Mew Window from Here

Mew Taskpad Wiew. ..

Refresh
Exportt Lisk, ..

Help

Figure 72:



Step 52.You should be able to see “Connection Settings” screen. Select “Domain” from “Select a
well known Naming Context” and click on “OK”.

Connection Settings E

Mame: I Domain

Path: |LDF'.P:,l',l'imitleZ.xiu:utechxsrw.net,l'Du:umain

r— Canneckion Poink
™ Select ar type a Distinguished Mame ar MNaming Conkext:

| =

* Select a wel known Maming Context:

Camputer

" Select or bype a domain or server:

| =

' Defaulk (Domain or server that you logged in ko)

Advanced. .. | [0]'4 I

Figure 73:

Cancel |

Step 53.Select the “CN=Users” under “Domain” in the console root screen.

"Hi Consolel - [Console Rool

omain [QA-BIT32-DC.

.org]\DC=bit32,DC=org]

kﬁ] File:  Action Wiew Favarites ‘Window Help

s @ XEDE |2

(L1 Console Roat Tlarme | Class | Distinguished Name
E@ ADST Edit EN=Activel user Ch=Activel, CN=Users,DC=hit3Zz, DC=org
=3 Domain [QA-BIT32-DC bi32.org] Ocn=nctivez user Ch=ActiveZ,Chi=Users, DC=hit32,DC=org
E"D DC=bit32,DC=org (22 c=Administrator user Ch=Administrator, Ch=Users,DC=bit3z,DC=arg
£ cn=uitin (20 ch=Cert Publishers group CH=Cerk Publishers, CH=Users,DC=hit32,=org
(3 ch=Computers (D em=clst user Chi=clsl,Chi=Users, DC=tit32, DC=org
0 ou=pomin Controlers CDn=dsz user Ch=clsz, CH=Users, DC=tit32,DC=org
a CN=ForeignascurityPrincipals (D en=bD1 user CH=DD1,N=Users,DC=hit32, Di=org
[ ol=Loadsim Users )
CI N=LostandFound DCN=DDZ user CN=DD2, M=lsers,DC=hit32,DC=arg
D Ch=Microsoft Exchange System Objects [:I CMN=0D3 user CN=DD3,N=lsers,DC=hit32,DC=arg
1 cn=NTDS Quatas (2 ch=Dnsadrins group CN=Dnsadmins, C=Users, DC=hit32,DC=org
] CN=Frogram Data Ea CN=DnsUpdateProxy: aroup CN=DnslipdateProoxy, Chl=Users, DC=hit32, DC=0rg
[ CN=System (3 ¢N=Domain Admins group CM=Daomain Admins, CN=Users,DC=hit3z,DC=org
C (3 cr=Domain Computers group CN=Domain Computers,Ci=Users, DC=hit32,DC=0rg

Figure 74:
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Step 54.Right click and click on the “Properties”. You should be able to see the “Properties”

screen and click on “Security Tab”. Click “Add”

CN=InMageUser Properties EHE3

Attibute Editor - Secuity |

Group or uzer names:

m Account Dperators [BIT 32Maccount Operators]
Adrniniztrators [BIT:
ﬁ Authenticated Users
m Cert Publizhers [BITEEHEH Publizherz]

m Driomain Adminz [BIT 3240 omain Adminz) j

- SR _T SRR

Add... | Bemove |

-

Adminiztrators]

Permizzionz for Adminiztrators Al Dreny

Full Cortral

Fead

Write

Create All Child Objects
Delete All Child Objects
Allowed to Authenticate

BEO0EEEO
OO000o0

=
For zpecial permizzionz or for advanced zettings, Advanced |
click Advanced. =

(] I Cancel | Spply |

Figure 75:

Step 55.You should be able to see “Select Users, Computers, or Groups”. Select the domain user
(InMageUser) created in the previous steps and check if this username is available or not by

clicking on the “Check Names”. Click “OK”".

Select Users, Computers, or Groups 2

Select thiz object type:

IUsers, Groups, or Built-T secuity principals Object Types...

From this location;

Ibit32. org Locatiohs...

Enter the abject names to zelect [examples]:
Ini agell zer [Ini agell ser@bit32. orgl| Check Mames

i

Advanced... | (] 4 | Cancel |
¥

Figure 76:
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Step 56.You will be returned to the previous screen. Enable the “Full Control” check box and
click on “OK”. Click on “Advanced”.

CN=InMagelUser Properkties ﬂ x

Attibute Editor - Sesuiy |

Group of uger names:

ﬂ: EMTERPRISE DOMAIM COMTROLLERS ;I
!ﬁ Everyone

!ﬁ Exchange Enterprize Servers [BIT32\Exchange Enterprize Serv... J
ﬂ inmage [inmage@bit32 org)

ﬂ It agellzer [Ink agell ser@bitd2 arg)
P T T L e LI

Add... | Bemaove |

Permizzions for Ink agelzer Aillow Deny

Full Contral

Read

drite

Create Al Child Objects
Delete All Child Objects
Allowed to Authenticate

For special permissions or for advanced settings, Advanced |
click &dvanced. —
kK I Cancel | Apply |

OooOooon

Figure 77:

Step 57.You should be able to see “Advanced Security Settings” screen. Select the “Domain
User” name (InMageUser), click on “Edit”.

Advanced Security Settings for Users 2=l

Permizsions IAuditingI Dwnerl Effective Permissionsl

To view more information about epecial permissions, gelect a permiszion entry, and then click Edit.

Permizzion en_ks:
Tupe | MNarne | Permizzion | Inhented Fram | Apply To I -
Allow Authenticated L zers Special <not inherited: Thiz object only
Allow Domain Adming [BIT...  Special <not inherited: Thiz object only

Allow inmage (inmaged@bit..  Full Control <not inherited: Thiz object and all c...

|ntagell ntag...  Full Control <not inhented: ect only

Hlow  SYSTEM Full Control enctinheriteds T his ahiect oy

Allow Account Operators [ Create/Delete ... <not inheriteds Thiz object only

Allow Account Operators [, Create/Delete ... <not inherited: Thiz object only

Allow Account Operators ... Create/Delete ... <not inherited: Thiz object only j
Add... Edit... Bemove

v Allow inheritable permizzions fram the parent bo propagate to this object and all child objects. Include
these with entries explicitly defined here.

Ta replace all permission entries with the default settings, click Default. Default |

Learn more about access control,

QK I Cancel | Lpply I

Figure 78:



Step 58.You should be able to see “Permission Entry for Users” screen. Select “This Object and
all Child Objects” from “Apply Onto”.

Permission Entry for Users S

Obiject | Propertie: |

Mame: IInMageLlser[InMageLlser@bitSE.mg] LChange... |
E20al o [(NaTo\ (A E T bz object and all child objec
Pemiszions: il Derny
Full Cantral O =
Lizt Contents O
Fiead &l Properties O
Wirite All Properties O
Delete O
Delete Subtree O
Fiead Permissions O
Modify Permizsions O
b odify Qwsrer O
Al alidated 'wiites O
Create All Child Objects O
Delete All Child Objects O .
[ W EUPT T w | B [ | m
r .ﬂ.ppl_l,l_ghese pe[misginns [{a] _c:biects anddar Clear Al |
containers within thiz container only

QK I Cancel |

Figure 79:
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Step 59.You should be able to see console screen, select “CN-Computers” object, select the
“Production Server”, right click, and click on the “Properties”.

'Hi Consolel - [Console Root',ADSI Edit',Domain [QA-BIT32-DC.bit32.0rg]\DC=bit32,DC=org\C| =10l 5||
% Fil=  Action “iew Favorites ‘Window Help | = |E'|5||
& = | [ ¥ N2
I:l Console Root ame | Class | Distinguished Mame :l
E@ ADSI Edit [ CH=GILEAD-NODEL cormputer CN=GILEAD-NODE1, CH=Computers, DC=bit32, DC=org
E!B Domain [QA-BIT32-DC.bik32,0rg] | £ ch=GILEAD-NODEZ computer CN=GILEAD-NODEZ, CN=Computers, DC=hit32, DC=nrg
=8 Dc=b't32PC_=°f0 ([ eN=GILEAD-NODES computer CN=GILEAD-HODES, CH=Computers, DC=hit32, DC=org
g Chi=Eiitin [ en=aILEADL computer CN=GILEAD1,CN=Computers,DC=bit32,DC=org
.l“_"l = EETEEE . CAcN=GILEADZ computer CN=GILEADZ, CN=Cormputers, DC=hit32, DC=crg
Ou=Demain Contrallers | 7y o1 EaDEVSMW computer CN=GILEADEYSNW, Ch=Computers,DC=bit32,DC=crg
D ZM=Foreign3ecurityPrincip D "
D OU=Loadsim Users DCN=GILEADEVSNW1 cornpuker CN=GILEADEWSNWI, CH=Caomputers,DiC=hit32, DC=arg
D Ch=LostAndFound DCN=GUEST2 cornpuker CN=GUEST2,CN=Computer5,DC=b|t3?,DC=org
{2 Ch=Micrasoft Exchange & | — N=IMIT25027 computer CN=IMIT25027,Ch=Computers,DC=bit32,DC=org
[0 CH=NTDS Guatas Cdcn=1mMrT25028 computer CN=IMITZ3028, CH=Camputers, DC=bit3z, DC=arg

£ CM=Program Data MITS Computer g
. = CdcH=1MITS008 e 18, CN=Computers, DC=hit32, DC=0rg
CM=suresh397

{21 Ch=sureshacs (dcn=mmrtsoss New Connection fromHere e cpy—computers,DC=hit32,0C=0rg
D CM=suresh292 D CH=IMITS079 Hew » |79, CM=Computers,DC=hit32,DC=org
D Zh=System DCN=LONGRUN-W2K8 M-W2KE, CM=Computers, DC=hit32, DC=arg
{0 ch=testuser [ cn=LonGRUNZKS Mew Windaw From Here |NzKa, Ch=Computers, DC=hit32,DC=0rg
{0 cu=Users (0 CN=LONGRUNZKS-NL Delete 1NZKE-N1, CN=Computers, DC=hit32,DC=0rg
(A CN=LONGRLINZKS-NZ e | N2k E-M2, CN=Computers, DC=hit32,DC=org
D CHN=LOMNGSOLL Refre;h L1, CN=Computers, DC=hit32,DC=org
D Ch=LOMNGS0LZ = | 2,CN=Cormputers, DC=hit32,C=arg
D CHN=LONGTET T,CM=Computers, C=bit32,DC=arg
(A Cu=MASTERVISTA Helo WISTA, CH=Computers, DC=hit32, DC=org
CACH=MIRROR, — CN=Carnputers.DC=hit32. HC=arq

Figure 80:

Step 60.Right click and click on the “Properties”. You should be able to see the “Properties”
screen and click on “Security Tab”. Click on “Add”.

N=IMITS-033 Properties 21X

Attibute Editor - Securiy |

Group or uger names:

ﬁ Account Dperators [BIT 32\Account Operatars)

ﬂ Authenticated Uszers
m Cert Publizhers [BIT324Cert Publishers]
554 Domair{)@dmim [BIT 225D omain Adming)

=l

Add... | Bemave |

-,

PITASLE

PBermizsions for Administrators Allow Deny
Full Contral o =
Fiead O
Wirite O
Create All Child Objects O
Delete All Child Objects O O
Allowed to Authenticate O ;I

For special permiszions or for advanced settings, Advanced |
click Advanced. —
0K I Cancel | Apply |

Figure 81:



Step 61.You should be able to see “Select Users, Computers, or Groups”. Select the domain user
name (InMageUser) created in the previous steps and check if this username is available or
not by clicking on the “Check Names”. Click on “OK”.

Select Users, Computers, or Groups ed |

Select thiz object type:

IUSEIS, Groups, or Built-in zecurity principals Object Types...

Erom thiz location:
Ibit32.nrg Locations...

Enter the object names to zelect [examples]:
Intd agel) ser [Intd agel] ser@bita2 or Check Mames

ik

Advanced... | 0k | Cancel |

A

Figure 82:

Step 62.You will get previous screen. Click on “Full Control” check box under permission for
test and click on “Apply” and then “OK”".

CN=IMITS-033 Properties 2xl

Attibute Editor Securty |

Group ar user names:

€ EXUSER [EXUSER®@bitI2 org) ;I
[ £} inma&[inmage@biﬁzorg]

!3 Intdagellzer [Inkagellsen@bit32, org)

63 Pre-windows 2000 Compatible Access [BIT 324Pre wWindows 20, J
ﬁ Frint Operators [BIT 324Print O peratorg)

=gl [
Add... | Remove |
Pemnizzsions for Intagellser Allow Deny
Full Control =
Read
Wrike

Create Al Child Dbjects
Delete All Child Objscts
Allowed to Authenticate

For special permizzions or for advanced settings, Advanced |
click Advanced. —
QK. I Cancel | Apply |

HEEEE
OooOooon

Figure 83:

Step 63.Repeat the same steps for the “DR-Server “

\ll) Notes:

In Cluster case, you need to select the network name (Virtual Server Name) and give DNS
privileges by repeating steps 1 to 4.
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Permissions for AD changes For Configuration

Step 64.You should be able to see “console” screen. Select “ADSI Edit”, right click and click on
“Connect To”.

i Consolel

File Action Yiew Favorites  \indow

= | Bm B[

'{ii Console Root', ADSI Edit

I:l Zonsole Roaok
- B

Conneck ko, ..

View k
Mew Window from Here

Mew Taskpad Wiew. ..

Refresh
Exportt Lisk, ..

Help

Figure 84:

Step 65.You should be able to see “Connection Settings” screen and “Select a well known
Naming Context” as “Configuration”

Connection Settings ﬂ

Marre: | Configuration

Path: |LDP.P:,I',I'QF'.-BITSZ-DC.I:uitSZ.nrgICnnFiguratiDn

[ Conneckion Paint
" Select or bype a Distinguished Mame or Naming Conbext:

| =

¢ Select 3 well known Maming Conkext:

HConfiguration

—Computer

" Select or bype 3 domain of server:
| =

{* Default {Domain or server that vou logged in ta)

Advanced. .. | (0.4 I Cancel |

Figure 85:
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Step 66.Expand the configuration tree, expand “CN=Configuration” object, and then expand
“CN=Services” object. Select “Microsoft Exchange” object and right click on the
“Properties”.

i Consolel - [Console Root',ADSI Edit',Configuration [QA-BIT32-DC.bitd

% File  Action  Yiew Favorites  window  Help
= | EEXFERE 2

(L7 Console Root
-5 ADSI Edit
Domain [A-BIT32-DC.bik32.org]
= Zonfiguration [QA-BIT32-00C.bik32,org]
=1 CH=Configuration,DC=bit32,0=arg

l:l ChN=Displayspecifiers

-1 CN=Extended-Rights

D ChN=ForestUpdates

{:I ChN=LostAandFoundZonfig

-0 CN=NTDS Quatas

-0 CN=Partitions

D Ch=Phrsical Locations
L——_l{:l CN=S5ervices
=-3

CM=Active Directo Move
-2 Ch=First 2rganiza Mew Connection from Here
[:I CM=Msmg5ervices

23 CH=NetServices bew 4
{2 CN=Public Key Service View 5
L1 cn=Rras e \Window from Here
13 Cu=windaws MT
E-C0 CN=Sites Mew Taskpad Wiew, ..
-0 CN=Welknown Security Pr
Delete
Rename
Refresh
Expork List. ..
Help

Figure 86:



Step 67.Right click and click on the “Properties”. You should be able to see the “Properties”

screen and click on “Security Tab”. Click on “Add”.

Attribute Editor Security |

Group or user names:
ﬁE Authenticatrd Users

fﬁ Domain Adminz (BT 32%0omain Adminz) J

fﬁ Enterprize Admins [BIT 325E nterprise Adming]
ﬁ Exchange Domain Servers [BITIAE schange Domain Servers)
ﬂ inrmage [inmage@bit32 arg)

Bemove |
Permiszions for ddminiztrator Al Deny
Full Control =
Read
Wite

Create All Child Objects
Delete All Child Objects
Administer information store

For zpecial permiszions or for advanced zettings, Advanced |
click Advanced. -

EBEEEEEA
ooooad

CN=Microsoft Exchange Properties 2l

Ok Cancel | Apply

Figure 87:

Step 68.You should be able to see “Select Users, Computers, or Groups”. Select the domain user
(InMageUser) created in the previous steps and check if this username is available or not by

clicking on the “Check Names”. Click on “OK”

Select Users, Computers, or Groups

Select thiz object type:

From thiz location: N

Enter the object names to select [examples):

IUsers, Groupsz, or Built-in security principals Object Tupes..

Advanced... | Ok, |

21X
Ibit32.org Locations. .. |

Intd agell zer [Int agell ser@bit32, ar Check Mames

Caticel |

|

Figure 88:
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Step 69.You will be able to see the previous screen. Click on “Advanced”.

CN=InMagelser Properkies ﬂ b

Attibute Editor  Securiy |

Group or uzer names:
ﬁENTEHPHISE DOMAIN COMTROLLERS ;I
ﬁ Everyone
ﬁ Exchange Enterprise Servers [BIT 32\Exchange Enterprize Sery... J
ﬂ inmage [inmaged@bit32, ong)

ﬂ Inkd ageldzer [Inkd agel seni@bit32. arg)
M e e . T e 1 An Ll

Add... | Bemove I

Permizzions for Inkdagell zer Alloy Dery

Full Cantrol

Read

Wwiite

Create All Child Objects
Delete All Child Objects
Allowed o Authenticate

For special permizzionz or for advanced settings, Advanced |
click Advanced. =
0 I Cancel | Apply |

Ooooooo

=
=

Figure 89:

Step 70.You should be able to see “Advanced Security Settings” screen. Select the “Domain
User” name (InMageUser), click on “Edit”.

Advanced Security Settings for Microsoft Exchange ﬂll

Permissions |Auditing| Dwnerl E ffective F'ermissionsl

To wiew more information about special permissions, select a permizsion entry, and then click Edit.

Permiszion entries:

Type | MName I Permizzion | Inherited From | Apply Ta |
Allow Administrator fRIT32..  Full Control <not inherited: Thiz object and all chil...
Allow Authenticated ¥ sers Special <not inherited: Thiz object only

Allaw Exchange Domain Se.. Read <hiat inherited: Thiz object and all chil...

inmage (inmage@bit3 Full Control <hot inkerited: Thiz object only
trol Tt y
Special CM=Configurati Thiz object and all chil...

Full Control CN=Configuratio..: Thiz object and all chil...

Enterprise Admins (BI...

Add... Edit... Remove

~ Allow inheritable permizzions from the parent to propagate to this object and all child objects. Include
these with entries explicitly defined here.

Ta replace all permiszion entries with the default settings., click Default. Default |

Learn mare about access control.

ok I Cancel I Apply |

Figure 90:



Step 71.You should be able to see “Permission Entry for Users” screen. Select “This Object and
all Child Objects” from “Apply Onto”. Click “OK”

PermissinnEntry for Microsoft Exchang, S|

Obiject | Properties I

Hame: IInMageUser [Intdagell zer@hbit32 org] Change. .. |

nd all child

Apply onto;

Permizgzions: Allow Deny

D e

Full Contral

Lizt Contents

Read &l Properties
Wwite All Properties
Delete

Delete Subliee
Fead Permizsions
b odify Permizzions
M odify Owwrer
All'Validated ‘wiites
All Extended Rights
Create 4l Child Objects

Poolos ANCLId AL e

r Apply these permizsions to objects and/or Clear &ll |

containers within thiz container only

Ok, I Cancel |

IEREEEEREEEEE
lOoO0OoOoO0ooooon

-

Figure 91:

Step 72.This leads to the previous screen and click on “OK”.

Advanced Security Settings for Microsoft Exchange 2=l

Permissions |Auditing| Dwnerl Effective Permissionsl

To view more information about special permissions, select a permission entry, and then click Edit.

Per[:éssion entries:

Type | Mame | Permiszion | |nherited From | Apply To |
Allow Administrator (BIT32%...  Full Contral <nat inherited: Thiz object and all chil...
Allow Authenticated Users Special <not inherted: Thiz object anly

Allow Exchange Domain Se... Read <nat inherited: Thiz object and all chil...

inmage [inmagel@bit3

Full Contral <not inherited: This object only
Irikd L al d

Dromain Adming [BITS... Special Cl onfiguratio...  Thiz object and all chil...
Allow Enterprige &dming [Bl...  Full Control CH=Configuratio...  This object and all chil...
Add... Edi... Bemove

~ Allows inhentable permizzions fram the parent to propagate to thiz object and all child objects. Include
theze with entries explicitly defined here.

To replace all permission entries with the default settings, click Default Default |

Leam more about access control.

0K I Cancel | Apply |

Figure 92:
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Step 73.Click on “Full Control” check box under permission for test and click on “OK”.

CN=Microsoft Exchange Properties I |

Aftibute Editor - Security |

Group or uzer names:

[ €8 Domain Admins (BIT32\Damain Adming]
m Enterprize Adminz [BIT 32M\Enterprize Admins]

m Exchange Domain Servers [BIT 32A\Exchange Domain Servers) J

inmage [inmaged@bit32. org)
ﬂ |kl agell zer [Inkd agell seritbit 32, ang)

Add... Remove |
Permizzionz for Inkd agel) ser Al Drerw
Full Contral
Read
Write

Create All Child Objects
Delete All Child Objects
Adminizter infarmation store

O
O
O
O
O

O -

EEEEEE

For special permizzions or for advanced settings,
click Advanced.

(] Cancel | Apply |

Figure 93:



Adding User to Host Machines

Step 74.Logon to “Production Server” with the domain administrator. Open Computer
management console, click “Groups” under “Local Users and Groups”, and click on
“Administrators”.

E Computer Management
m) File Action  Wiew Window  Help

e | Am| XER[2E

E Computer Management (Local)
Elm System Tools

{3 Event Viewsr

% Shared Folders

Drescription

Backup Operakors can override secu...
Mermbers are allowed ko launch, acti...

E' Local Users and Groups muests have the same access as me...

Members in this group can have som...

Performance Log Users Mernbers of this group have remote ...
Performance Logs and Alert:

7, Device Manager

[—]@ Storage

[+-{2) Remavable Storage

Disk Defragmenter
i Disk Management

[]--& Services and Applications

Performance Monitor ... Members of this group have remote ...
Power |sers possess most administr..
Mernbers can administer domain prin. ..
IMembers in this group are granted £...
Supports File replication in a domain
Users are prevented from making ac...
Debugger Users are non administrat.. .
Group for the Help and Support Center
115 Worker Process Group

Members of this group have access k...
QVS Developers ‘Wisual Studio developers can author ...
R vmware__ WMware User Group

Figure 94:

Step 75.You should be able to see administrator’s properties screen and click on “Add”.

Administrators Properties .I.l .ﬁi

General |
Administrators
Diescription: nplete and unre: ompLterdomain
Members:

TnM agellzer [Ink agell ser@bit-j-.?. arg)

Figure 95:



Step 76.You should be able to see “Select Users, Computers, or Groups”, Select the domain user
name (InMageUser) created in the previous steps and check if this username is available or
not by clicking on the “Check Names”. Click “OK”

select Users, Computers, or Groups

Select thiz object type:

|L|m, Groups, of Buitin secuily prncipals Object Types...
FErom thes location:

|mdm:m:|wnﬂ LDCM.
Enter the object names to select [examples)

Iribd agellser (| agell ser@bit32, org] Check Hames

ddvarced.. | [ ok | Concel |

Figure 96::

Step 77.Click “Start->Control Settings->Administrative Tools”. You should be able to see
“Administrator’s Properties” screen. Now, click on “Apply” and then on “OK”.

Administrators Properties i ..ﬂ ..J'f.l
General |

Descrphon: 35 bo the computer/domain

Members:
IEEIHM agellzer [Intdagellser@bit32 org)

agd. | Bewave |

oK Cancel Sl

Figure 97:

‘!I) Notes:

On cluster environment, you need to add domain user to each node.
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Adding user to logon service

Step 78.Log on to “Production Server” with domain user. Click “Start->Program Files-
>Administrative Tools->Local Security Policy”.

'E Frograms " .@ Microsoft Exchange  » ,, Terminal Services Configuration
B Administrative Toals  » B8

B2 Local Securiby Palicy

Figure 98:

Step 79.You should be able to see “Local Security Settings” screen, select “User Rights
Assignment”, and select “Log on as a Service”.

Fil=  Action Wiew Help
e B0 xR @

@ Security Settings Policy  /
@ Account: Policies
28 Local Palicies

| Security Setting |

nccess this computer from the net... Everyone,*3-1-5-2..,
P.ct as part of the operating syskem  BIT32\adminiskrator,,.

{8 audit Policy [8%]add warkstations ta domain

{8 User Rights Assignment Adjust memory quotas for a process  LOCAL SERYICE,ME...

{3 Security Options

) allows log on locally -1-5-21-
& Pubi . (58] Allow log on local *5-1-5-21-3958233
1 Pubiic Ky Po n:|.es. - nllow lag on through Terminal Ser...  Administrators,Rem. ..
[ Saftware Restriction Policies - y . . L
lg IF Security Policies on Local Computer Back up files and directories Administrators,Back. ..

[HLog on as a service

e METY WL
@Change the syskem time

LOCAL SERVICE, Ad...

Figure 99:

Step 80.You should be able to see “Log on as a Service Properties” screen, click on “Add User or
Group”, and click on “OK”".

Local Secuity Setfing | Explain This Setting |

Log on a3 a service

&

ASPMFT
InMagellser (InMagellser@hitid.om]

Add Uiser or Group... |

I 0K I Cancel

Figure 100:
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Step 81.This should open “Select Users, Computers, or Groups” screen, select the domain user

name created in the previous steps and check if this username is available or not by clicking

on the “Check Names”.

select Users, Computers, or Groups

Select thiz object type:

|L|m, Groups, of Buitin secuily prncipals Object Types...
FErom thes location:

|:-eidncm:|w.net Locations.
Enter the object names to select [examples)

Iribd agellser (| agell ser@bit32, org] Check Hames

ddvarced.. | [ ok | Concel |

Figure 101:

Step 82.You should be able to see the previous screen. Now, click on “Apply”, and then on

IIOKII.

.0g on as a service Properties 21 x|

Local Security Setting | Explain This Setling |

E Log on as a sarvice

ASPHET
Intd agellser [Int agell ser@hit32. org)

Add Lser or Group... I Hemove

Figure 102:
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Step 83.Log on to “Production Server” with the domain user created above. Click “Start->Run-
>Services.msc”, select the “FX agent service”, right click, and click on the “Properties”.

Services (Local)

InMage DR-Scout FX Agent Mame 4 | Description | Status
Distributed Link Tracking Client  Enables cli...  Starte
Stop the servicel * g Shark Skarted
Restart the service %InMage DR-Scout Y Agent ;to Btarted
%Intersite Messaging Pajjse
Description: ) %IPSEC Services Re;urne Started
File Replication Service Shkerberos Key Distribution C —
%License Logging -
%Logical [isk Manager all Tasks F Btarted
%Loglctﬁl Disk Manager Admini Refresh
%Machme DebugManager __—— — Ftarted
%Mc.ﬂfee Framework, Service Properties Ckarked
%Messenger
%Microsoft E:xchange Event Help

Figure 103:

Step 84.You should be able to see the “FX agent Properties” screen. Enter the “Domain
Username” and password details. Then, click on “Apply” and then “OK”.

InMage DR-Scout FX Agent Properties (Local 2=l

General LegOn | Hecover_l,ll Dependenciesl

Log oh as;

' Local System account

[T Allow service to interact with deskiop

%' Thiz account: IInMageUsel@bitBZolg Browse... |

Pazzword: I-oo-oo-o

Confirm pazzword; I"‘"" LAl

You can enable or disable this service faor the hardware profiles listed below:

Hardware Prafile | Service |
Profile 1 Erabled
Encble | Disable |

QK I Cancel | Apply |

Figure 104:

Step 85.Restart the “FX Agent Service”. Repeat the same steps for the DR-Server

‘!LI’J Notes:

In Cluster case, you need to add domain user to each node. Repeat the steps from 1 to 8.
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Part 1: Non-Cluster Exchange
Environment

This part describes Exchange server protection in a non-cluster environment where production
server and DR server both are standalone.

64



5 Protecting Exchange

5.1 Protecting Exchange (DB and logs on same volume)

This section explains protecting Exchange server when Exchange log files and Exchange database
are on the same volume.

5.1.1 Discover Exchange volumes

5.1.1.1 Through CX UI

Step 86.0pen the CX user interface, click on “File Protection” then click on “New Job Group
Wizard”.

File Protection

Logged in as 'admin’ - Logout

Applications Filt

Application Per PagE:IE-

Mo Replication Applications To Display
New Job Group Wizard

Manage Templates

Figure 105

Step 87.This opens up the File protection wizard. Click on “Add Job”.

File Protection
Logged in as 'admin’ - Logout
Replication Jobs

= A
[: A Application  Source Target Target Directory

|j. Name Host Source Directory Host

Cancel

Add Job

Figure 106

!
s Caution:

To perform an unplanned Exchange failover it is critical to perform the Exchange Discovery at
least once.
Ensure that the FX agent service is running with domain administrator privileges.
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Step 88.Select the production exchange server as source and the backup exchange server as
destination. (In this example the source exchange is Exchange_Prod and the target exchange

is Exchange _DR). Select the template as “Exchange Discovery” as shown in the picture
below. Then click on “Next”.

File Protection Wizard: Replication Pair

Replication Hosts

Application Name: I

Job Description: I

Source Destination

Host Host

&) | EXCHANGE_PROD [Windows] | 1 D {0 | EXCHANGE_PROD [Windows]
{ | EXCHANGE_DR [Windows] (& | EXCHANGE_DR [Windows] 2 '
Directory Directory
3 IExchange Discovery =
Nextiodl | Cancel
Figure 107

Step 89.The FX “Job Options” opens up with the required fields filled up. Scroll down to

“Miscellaneous Options” to observe that the target post script is filled up. Click on “Finish”
without changing any settings.

SEMT E-TAM aT=TT Ill:l MIMUTES P WItNCUT TS0 PIrogre

Pre execution script pathnamel

Past execution script pathnamel

Fre executicn script pathname ::cesl:inal:icn:il

Post execution script pathname [destinati n::lxpp «ction.exe -discover -=pp Exchangs -host Exchangs Prod

Catch &l job mc:iﬁer|—5..par for power users only

<- Back Finizh= I} Zancel

Figure 108

‘!ll) Notes:

Optionally to restrict Exchange Discovery to the EVS, you may append the switch “~host

<name of the production server>" at the end of the target post script as shown in the above
picture.
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Step 90.The Job will be set to execute once a day. Click on “Set Schedule” to change the job
scheduled option.

File Protection

Group Schedule
Schedule Type Schedule Time

Run Ewvery 1 Dray

Set Schedule

Replication Jobs

[:g ﬁpﬂ:::lon Source Host Source Directory Target Host Target Directory
Fup order 1
CihPragram Ci\Program
[ Ungrouped EXCHAMSGE-PROD | Files\InMage EXCHAMGE_DR | Files\InMage
Systemsifailoveridata Systemsifailoveridata
Cetails Rermove Cancel
Add Job
Finish
Figure 109

Step 91.The FX job Scheduler opens up. Set the job to “Run on Demand” and click on “Set
Schedule” to return to previous screen and click on “Finish” to complete setting up the job.

File Protection Wizard: Scheduling

Replication Schedule

Scheduling Mode

@ © Run Once © Scheduled

O Run Mow i Run Every:
0 Run At |D Days, | Hours, | Minutes
0n|2008 Y \|3 At|2 3 |D & | Daily At

& Run Cn Demand 2. |DD + |

& Weekly on

I Sunday 'I At [HERN IEIEI

Set Scheduls - Cancel

Figure 110



Step 92.Now that the job is setup, click on “File Protection” on the command pane and then
select the job and click on “Start” as shown below.

File Protection Logged in a5 "admin@10.0.88.20" - Logout
Server Time: May-21-2009 15:02:41
Applications Filter: [Ppplzation Mame [ Sertbydd T
Application Per Page:]s Jobs Per Page:[s Go
[=] ungrouped
o § ] Scheduled b Scheduled i
Job Description Status Source Host Source Directory Target Host Target Directory Rpo | 0 GID JID | gl otk Time | Trending
CihPragram Cr\Program 2008-05-21
e} exchange discovery... Srarting... EXCHANGE-PROD Files\InMage EXCHANGE_DR Files\InMage MA | runevery | 2 2 o MiA
130200
Systemsfailovedats Systemsifailoveidsts
Results 1-10f 1 << <1 > >»
stop | start | Details | Remove
Displaying 1 to 1 (of 1 Applications) Result Pages:1
New Job Graup Wizard
Manage Templates

Figure 111

5.1.1.2 Through CLI

Alternatively, you may choose to perform Exchange discovery through command line. Access the
target command prompt and navigate to the VX agent install path to issue the below command:

For exchange 2003 and 2007 the syntax is
Application.exe —discover —app exchange —host <name of the source exchange
server>

C:~Program FilesxInMage Systems>Application —discover —-app exchange —host Exchange Prod
Attempting to determine Exchange Uirtual Server name for host - Exchange_FProd in case it's a
clustered configuration

Command Line: Application —discover —app exchange —host Exchange_Prod
Running under the user: BIT32.0RGhnadministrator
Process ID: 2084

Discovering volumes for the host: imits=@35

Start persisting the log configuration for server : Exchange_ Prod
abspath=-~imit=@3I5~K5~F5G
Unigue Volume MountPoint with dataslog file % Exchange_Prod-K$\FSG is ““Exchange_Prod“K&<
ahspath="*\imits@35\K5$*F8G\Mailhox.edh
Unique UolumesMountPoint with datarlog file S“\Exchange_Prods\K$“\F8G-Mailbox.edh is “\Exchange_Prod>\K$
abspath="\imitsB35\K$\FSG\Puhlic .edh
Unique Uolume MountPoint with dataslog file ““Exchange_ Prod~K$“FSG\Puhlic.edb is ““Exchange_ Prod“\Ké
File path: K:=\F8G
abspath=-*imits@35-K5~F5G
Unique UolumesMountPoint with datarslog file “\x\ Exchange_Prod“\K$“\FS8G is ““Exchange_Prod“\K5\
i : K:“\F§G~Mailbhox.edh

Unigque Uolume-MountPoint with datarlog file ““\Exchange_Prod K5 F8G-Mailbox.edh is ““\Exchange_Prod:\K$
File path: E\FSG\Puhlic.edh

Fi.gure 112
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Step 93.0nce the job completes its execution, the “Application” field under “Volume Protection-
> Source Site” displays the application name as Microsoft Exchange 2003 (for exchange 2003)

Volume Protection: Source Site

Logged in as “admin’ - Logout

Server Time: Feb-3-2008 01:09:51
source | Target

Protected Drives

Server

Pri Yolume Fs Application Capacity (Bytes) Frees Space (Bytes)
Primary Drives
[=] excuance_pron
Server Pri Volume Fs Application Capacity (Bytes) Free Space (Bytes) Replication Status
[o) EXCHANGE_PROD E (Erchangs_DB) NTFS | Microsof Exchangs zooz | | 526385152 498436096 Inactive
[s) EXCHANGE_PROD F (Mew Volume ) NTFS - - 526385152 521071104 Inactive
= excnance_or

Server

Pri Volume s Application Capacity (Bytes) Free Space (Bytes) Replication Status
o EXCHANGE_DR E ( New Yalurae ) NTFS Microzaft Exchangs 2003 5263685152 498436095 Inactive
(ol ERCHANGE_DR F(Mew Yolume ) NTFS T 526385152 521071104 Inactive
e} EXCHANGE_DR G [ Mew Volume ) NTFS Unknasn 1052803072 1044848640 Inactive

Start Replication Reset

Figure 113

‘!l) Notes:

For exchange 2007 the display name will differ

Discovery job is to be performed before setting the replication pairs, after setting up
replication pairs and after any Exchange configuration changes.

69



5.1.2 Replicate discovered volumes

Now that the exchange volume(s) are discovered proceed to replicate them to a remote exchange
host.

In this example, exchange log files and database files are located on a single volume (E volume).

Step 94.Click on “Volume Protection”, expand the source exchange server to select the exchange
volume, and then click on “Start Replication”

Yolume Protection: Source Site S 1 t. 1
Lo st - Loaoat electing source volume
Source | Target
Protected Drives
Server Pri ¥olume F5 Application
[
Primary Drives
= excuance_pron
Server Pri ¥olume F5 Application Capacity (Bytes)

o EXCHAMGE_PROD E (Exchange DB MTFS Microsoft Enchange 2003 526385152

™ | pam kL e TR HTFS Unknown SZE385152
EXCHANGE_DR

Start Replication Reset

Figure 114

Step 95.The target page opens up. Expand the target exchange server to select a target volume
then scroll down to set the “Replication options”

Host, EXCHANGE_PROD
Crive: E

Selecting Target Volume
Capacity: 526385152

Select a target WAN volume

WAN Server Yolume

EXCHANGE_PROD v

[=] excHANGE DR

= EXCHANGE_DE E [ Mew Volume ]

ey pperm— ey orrT—

Figure 115:

“" Caution:

Ensure that you replicate the source volume to the same drive letter (or mount point) on the target
host. For example E: to E:

Automated failover is not supported when source and target volumes have different drive
mapping.
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Step 96.While you can select any of the “Replication Options” be sure that the “Enable CDP
Retention Option” is enabled then click on “Submit”.

Replication Options
I_ Secure transport from Source to IntMage CX
[T | Secure transport from InMage CX to destination

¥ | Use fast resync instead of off-load resync algorithm

Use compression: | Cx Bazed Compression j
[Dverrides existing 1-N replication pairs)

Add to volume consistency group: I Mew Yaolume Group 'I

CDP Retention

Enable CDP Retention option

Automatic Resync Options

Start between hours I'IS : IUU and IE : IUU after waiting ISU

minutes. (All imes are local to CX)

Submit Cancel Reset

Figure 116

Step 97.Since “CDP retention” is selected, the corresponding retention policy has to be defined.
This is the screen where the type of retention policy (time, space or a combo policy) is
defined. Define the policy and click on “Submit” to start the replication pair.

VYolume Protection: Retention Options
Logged in as ‘admin’ - Logout

Pair Details
Server Pri Yolume Remote Server ¥olume

EXCHANGE_PROD E ERCHANGE_DR E

Retention Logging Policy

Retention Policy Rell-backvrard

Retention Log Size 0.00 (MB) Current Retention Log Size 0.00 (MB)
Unused Space 256.00 (MB)

Retain changes upto 256 MB =] (Cannotbe less then 256 MB)

Retain changes upto the (time) (Days) | (hrs.)

® Purge older retention logs

Dn insufficient disk space
© pause differentials

g:hretentionlags (Eg:- K:\log_data)

Log data directory
G drive is suggested for storing rollback log files.

Configure Threshold for Alerts

Alert when disk space utilization reaches 80 £

Subrnit Cancel

Figure 117

"!l") Notes:

By default 256 MB is left free on the retention volume. You may choose to reduce this free space
limit through “System -> Agent Settings -> Retention Reserve Space Settings” to reduce the
“Unused space” on retention volume
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Step 98.Click on the “Protection Status” to monitor the replication pair. The status of the

replication pair starts with “Resyncing step 1” then “Resyncing step 2” and then reaches
“Differential Sync”

Protection Status

Logged in as "admin’ - Logout Server Time: Feb-3-2008 01:32:56

Yolume Protection Status

Resyncs In Transit | Resync In Transit | Differentials Left

Server Yolume Group Step1 (MB) Stun2 (MB) ) Resync progress RPO Status

Resync | View
Required | Details
E (Enchange_DB)
-3 E ( New Volume )

TR 2008-02-02 2008-02-03 2008-02-02 2008-02-03 2008-02-03 2008-02-02 — [
0111114 01:12:06 01112106 01:112:58 01:12:58 0132101 &0

Figure 118

EXCHANGE_PROD->EXCHAMGE_DR Volume E 0,08 minutes Differentizl Syne

Configured
(Enabled)

Step 99.0nce the replication pairs reach “Differential Sync” run the Discovery job. For each EVS
(Exchange Virtual Server) or Exchange server, a total of three files are created on the
corresponding DR server. These files contain :

e List of Exchange VX Replication pairs

e Retention logs of each replication pair

e Exchange database and log file location.

This information is later used while recovering from a production site outage.

I\
g Caution:

If the discovery job is not run after setting the replication pairs, Unplanned failover cannot be
performed.
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5.1.3 Issue consistency tags

5.1.3.1 Through CX UI

Step 100. The vacp.exe consistency tag can be issued through an FXjob, click on the “File

Protection”, and then click on “New Job Group Wizard”.

File Protection

Logged in as "admin’ - Logout

Applications Filter: F

Application Per Page=|5

Ungrouped

Displaying 1 to 1 (of 1 Applications)

Mew Job Group Wizard

Manage Templates I

Figure 119

Step 101. The “File Protection Group” screen appears. Click on “Add Job”.

File Protection

Logged in as "admin’ - Logout

Replication Jobs

F ] .
[: £ Application | Source e Baertoey T;;Es:t

¥ ] Name Hast Target Directory

TPy pom
No jobs soged el

Zancel

Add Job

Figure 120
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Step 102. Select the production exchange server as source and destination then select the
FX template as “Exchange Consistency” and click on “Next”.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout

Replication Hosts

Application I
Name:

Job Description: I

Source Destination

Host Host
(&) | EXCHANGE _PROD [Windows] () | EXCHANGE_PROD [Windows]

) | EXCHANGE DR [Windows] {0 | EXCHANGE_DR [Windows]

Directory Directory
| |
I Exchange Consistency j
Next -= Cancel

Figure 121

“"]:I’J Notes:

For Exchange server 2007, select the FX template as “Exchange 2007 Consistency”

Step 103. The FX job options page opens up scroll down to click on “Finish” to complete
the FX job configuration.

Send E-mail alert if|5 minutes paszed withoutjob progrezs
Pre execution script pathlamelam Filzghlnt age Spstemsconsistencyhexchange_consistency.bat'’

Post edecution script pathnamel |

Pre execution script pathname [destination)l

Post execution script pathname (destination)l

Catch all job modiﬁerl--supel For pover users only

<- Back Finish -= 4 Cancel

Figure 122
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Step 104. You will be returned to the “File Protection Group”, this time the “Replication
jobs” contains the FX job configuration. Click on “Set Schedule”.

File Protection Group

Group Schedule
Schedule Type Schedule Time

Run Every & Hours

Set Schedule

Replication Jobs

[:g np:‘:::““ Source Host Source Directory Target Host Target Directory
Rur arder I
Ci\Program Ci\Pragram
[ Ungrouped EXCHAMGE_PROD  Filesh\InMage EXCHAMGE_PROD  Files\InMage
Systemsifailoveridata Systemsifailoveridata
Details Remove Cancel
Add Job
Finish
Figure 123
Step 105. The FX scheduler opens up, select “Scheduled -> Run every” then enter the

frequency and click on “Set Schedule”. For this example this FX job is set to execute every

five minutes.

File Protection Wizard: Scheduling

Replication Schedule

Scheduling Mode

o Run Dnce @ Scheduled l 1 l

&  Run Mow (¥ | Run Every: 2

@ Run At ID_ Da.,.s,l_n_ Hours, |5_ Minutes @
OnW\Iz_\Ia_ At|2_:|D_ O Daily An

& | Run On Demand W i W

O wWeekly On:

I Sunday 'I AtIDD : IDD

Set Schedule Cancel

R

Figure 124



Step 106. You will again return to the “File Protection Group” screen, click on “Finish” to

save the job configuration

File Protection Group

Group Schedule
Schedule Type Schedule Time

Run Every S Minutes

Set Schedule

Replication Jobs

@ | Application _ _
[:ﬂ_ Mame Source Host Source Directory Target Host Target Directory
Run arger T
Ci\Program Ci\Program
9 Ungrouped | EXCHANGE_PROD  Files\InMage EXCHAMGE_PROD | Files\InMage
Systemsifailover\data Swstemsifailover\data
Details Remove Cancel
Add Job
Finish

Figure 125

Step 107. The “Protection Status” also shows the FX job replication status under “File
Protection Status”. This is where you can monitor if the FX job executed normally or exited

with an error.

File Protection Status

Scheduled

Filter Job Description Application Status Source Host Source Directory Target Host Target Directory Tope 61D

Clear
Ci\Program Ci\Program
Exchange Consist.., Ungrouped Stopping... ERCHAMGE_PROD  Files\InMage EXCHAMGE_PROD | Files\InMage Run Every | 2
Systemsifailoveridata Systemsifailoveridsta
CiiProgram CiiProgram
Exchange Consist.., Ungrouped Completed EXCHANGE_FROD FilesiInMage EXCHANGE_FROD | FilesiInMage Run Every | 2
Systemsifailoverdata Systemstfailoverdata
Ci\Program Ci\Program
Exchange Consist.., Ungrouped Completed ERCHAMGE_PROD  Files\InMage EXCHAMGE_PROD | Files\InMage Run Every | 2
Systemsifailoveridata Systemsifailoveridsta
Ci\Program Ci\Program &
Exchange Discove... ungrouped Completed EXCHANGE_FROD Files\InMage EXCHANGE_PROD | FilesiInMage 1
Demand
Systems\failoveridata Bystems¥failoveridata

sults 1-4 of 4
< o

Clear logs for selected jobs | Delete all job histary

Set
= Select Bl select 2] Select [5]

pi]

Select 5]

Instance

Exit Code
Select [
A n
[ r
0 0
0 r

Figure 126

"!l"J Notes:

The volume replication is continuous while the FX job for exchange consistency is scheduled

to run at regular intervals.
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5.1.3.2 Through CLI

You may also issue consistency tags through command line interface using the vacp.exe under

the VX agent installation path.
To issue consistency tags on Exchange 2003

vacp -a exchange —t “<name of the tag>

C:sProgram FilessInMage Systemsz>vacp —a exchange —t “"Tag_

Parsing command line arguments ....

Jalidating command line arguments ...

Figure 127

To issue consistency tags on Exchange 2007

vacp —w ExchangelS —t *“<Name of the tag>"

Program Files (x86)><InMage Systems*vacp —w ExchangelS —t “tag_1"
Parzing command line arguments ....

alidating command line arguments ...

enerating Tag: ExchangelS548d7556h
enerating Tag: tag_1

enerating Tag: FileSystem48d7556h
enerating "Hevocation" tag ...

Figure 128

“%r) Notes:

“-a Exchange” is used for Exchange 2003
“-w ExchangelS” is used for Exchange 2007
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5.2 Protecting Exchange (DB and logs on different volumes)

Step 108. Considering that exchange data is usually spread over multiple volumes. The
production server (Exchange_PROD) is configured such that the edb files (exchange
database files) are stored on the F volume while the stm (streaming database files) are stored
on the E volume for public folder store and mailbox store.

Public Folder Store (EXCHANGE_DR} Prope 4 4] Mailbox Store (EXCHANGE_PROD) Properti 2] %]
Full-Text Indexing I Details | Policies | Security Details I Policies I Security
General Database Fieplication I Lirnits General Database I Lirrits I Full-T ext Indesing

Erxchange databage: Erchange databage:

IF:\priﬂ edb

Exchange streaming database:
IE:'\pub‘I _stm

Exchange streaming datfbasze:
IE:\priﬂ.stn‘i

Browse. ..

Browse. .. | Browse. .. |

Browse. ..

Maintenance interval:

Figure 129:

Maintenance interval:

Step 109. The same has to be done on the DR server (Exchange_DR) as well to maintain
the same configuration

Step 110. A discovery job is executed to discover all the exchange volumes. To learn more
about setting up discovery job, refer to section Discover Exchange volumes on page 65. A
“Volume Protection” screen is shown in the below figure containing the new exchange

volumes.
Primary Drives
=] ExcHANEE_PROD
Server Pri ¥olume FS Application Capal
e EXCHAMGE_PROD E (Euchange_DB) MTFS Microsoft Exchange =4
e EXCHAMGE_PROD F [ MHew Yolume MTFS Microsoft Exchange =4
(o] EXCHAMGE_PROD G [Mew Yolume ) MTFS Unknown 53
(o] EXCHAMNGE_PROD H [ Mew Yolume ) MTFS Unknown 53
=] ExcHANGE_DR
Server Pri ¥olume FS Application Capal
@ EXCHANGE_DR E(Exchange_DB) MTFS Pberesdis Exsemge 54
@ EXCHANGE_DR F ([ Mew Wolume ) MTFS Pberesdis Exsemge 54
(o] EXCHANGE_DR G [ Mew Yolume ) MTFS Unknown 53
(o) EXCHANGE_DR H [ Mew Yalume ) MTFS Unknown 5]
Figure 130:
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5.2.1 Replicate discovered volumes

Step 111. Setup a VX replication pair from E: of the production server (Exchange_prod) to

E: of the DR server (Exchange_DR). Then proceed to replicate the other volume(s) F: Click on

“Volume Protection”, expand the production server to select the next exchange volume then
click on “Start Replication”

Yolume Protection: Source Site
Logged in as "admin’ - Logout
source | Target
Protected Drives
Server Pri ¥olume FS§ Application
EXCHAMNGE_PROD E (Exchange_DB ) MNTFS Micrasoft Exchange 20
Primary Drives
= exchance_prop
Server Pri Yolume FS Application Capacity
fl ERCHANSE PECD ClEuchange LB NTES Microsoft Enchange —
® EXCHAMGE_PROD F (Mew Yalume ) MNTFS Microsoft Exchange S263
L= o ) ) o o i T MTFS Unknawn 5263
@ EXCHANGE_PROD H [ Mew Volume ) MTFS Unknawn 5263
EXCHANGE_DR
Start Replication Reset
Figure 131:
Step 112.

The target page opens up, expand the DR Exchange server, and select the target
volume and then scroll down to set the replication options

Host: EXCHAMNGE _PROD
Crive: F

Capacity: 526385152

Select a target WAN volume

WAN Server ¥olume

EXCHANGE_PROD

=l excHance DR

i EXCHANGE_DR F ([ Mew Valume )

il B ot GE D RSP L T |

Figure 132:

“" Caution:

Ensure that you replicate the source volume to the same drive letter (or mount point) on the target
host. For example E: to E:

Automated failover is not supported when source and target volumes have different drive mapping.
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Step 113. Be sure that the “Enable CDP retention option” option is enabled then click on
“Submit”.

Replication Options
I- Secure transport from Source to InMageCX
I- Secure transport from InMage CX to destination

Swnc options: I Fzst "I

Use compression: I Cx Based Compression d
{Overrides existing 1-N replication pairs)

Add to volume consistency group: I New Volume Group ﬂ
COP Retention

Enable CDP Retention option

Automatic Resync Options

m Start between huursl'& :I-:*:' andIS :I-:':' after waiting |30 | minutes,

{All times are local to CX)

Submit Cancel Reset
Figure 133
Step 114. Define the type of retention policy and start the replication. Click on the

“Protection Status” to check the status of the replication pairs.

Protection Status

Logged in as *admin’ - Logout Server Time: Feb-12-2008 04:05:07

Yolume Protection Status

Resyncs [n Resync In

Server Yolurwe Group Tran(s::!‘.)bepl Tran:'i:BS)hepZ D:_f::t'“(';:;;" Resync progress RPO Status R':l’“"i"r‘:d D"::_"i‘;s
EXRCHANSE_PROD-~EXCHANSE_DR E(E")"fj";e)a Volume E i o 0 NiA 0,28 minutes Differential Sync Ne
EXCHANGE_PROD-*EXCHANGE_DR F(N”f:;'“'"z) Volumne F 0 5} 1} {073 0.28 minutes Differential Sync MO

Figure 134:
Step 115. Proceed to issue consistency tags on the exchange volumes. To setup an

exchange consistency job refer to the section Issue consistency tags on page 73.

Exchange failover and failback through the CX Ul is similar as mentioned in the sections
Exchange failover through the CX Ul on page 82 and Exchange Failback through CX UI on page
88 respectively.

For console based failover and failback refer to the section Exchange failover and failback
through CLI on page 96.
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5.2.2 Before failover

Before failover, the production server (Exchange_prod) is fully functional. You may choose to
check this through your email client or web based outlook.

/3 Microsoft Outlook Web Access - Microsoft Internet Explorer

File Edit Wiew Favoribes Tools  Help
Qe ~ O~ [x 2 verogites @ | (2- & B
Addr I@http:Hexchangejrndll'exchange.l' 1 j
Dutloo D 1 i
mFolders O [ fadnen - 8 X Ch Gl e |15 - | 2 [ | ) Help
= = Tommy il [ | Fram w
] Calendar Suleyeet: ' |0 | test
[ Contacts ' ' 006 ... Jonry
@ Deleted Items LI To: Tom
[ — Jirmm
Lo
Figure 135

This concludes protecting standalone Exchange server. You may now proceed to perform a
failover. Post failover you should be able to access your mailbox without any configuration
changes from the client side.
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6 Exchange failover through CX Ul

6.1 Exchange Planned Failover

A planned failover can be performed through CXUI and also through the command line
interface. To perform Exchange planned failover through CLI refer to the section Planned

exchange failover on page 96.

Step 116.

Click on “File Protection” then on “New Job Group Wizard”

File Protection
Logged in as "admin® - Logout

Applications

Ungrouped

Displaying 1 to 1 (of 1 Applications)

Application Per Page :I L3

Mew Job Group Wizard

Manage Termplates

Figure 136

Step 117. Click on “Add Job”

File Protection
Logged in as 'admin’ - Logout

Replication Jobs

s Source

[:|: Application
E__ Name Host

Target

Source Directory Host

Cancel

I Add Job I

Target Directory

Figure 137
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Step 118. Select the source as the production Exchange server and the destination as the

DR Exchange server. Select the FX template as “Exchange Planned Failover” and click on
“Next”.

File Protection Wizard: Replication Pair

Replication Hosts

Application Name: I

Job Description: I

Source Destination
Host Host
(® EXCHANGE_PROD [Windows] {7 | EXCHANGE_PROD [Windows]
{0 | EXCHANGE_DR [Windows] {® | EXCHANGE_DR [Windows]
Directory Directory
I Exchange Planned Failower j
Mext -= Cancel
Figure 138
-
“\I’J Notes:

For Exchange server 2007, select the FX template as “Exchange 2007 Planned Failover”.
To perform AD replication, use the switch “~doadreplication” on the target post script.

To restrict DNS failover automatically use the switch “—nodnsfailover” on the target post
script

Step 119. The FX “Job Options” open up with required fields filled up. Scroll down to
“Miscellaneous options” to observe the source pre script and target post script are filled up
by the template. Click on “Finish” to save the job configuration.

Send RPO aIen:ifIU minutes passed

Send E-mail alertif|5 LA e s o g e

Pre execution script pathn elange -z EXCHAMGE_PROD -t EXCHAMGE_DR -builtin -tag MOME

Post execution script path

Pre execution script pathname (desti T

Post execution script pathname (dest] ation)la -tag PLANMNED -2 EXCHANGE_PROD -t EXCHANGE_DR -builtin

Catch All job modifief—super F———

<- Back Finish -= Cancel

Figure 139

The prescript prepares the production exchange server for a failover and the target post script
performs the failover to the consistency tag issues by the source prescript.
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Step 120. You will return to the “File Protection Group” screen, the job will be scheduled

to run “On Demand”, click on “Finish”.

File Protection Group

Group Schedule
Schedule Type Schedule Time
Cnce At Cn Demand

Set Schedule

Replication Jobs

[:g .ﬁp:l:':::on Source Host Source Directory Target Host Target Directory
Fur order ¥
Ci\Pragram Ci\Pragram
[ Ungrouped EXCHAMGE_PROD | Files\InMage EXCHAMGE_DR Files\InMage
Systemshfailoveridata Systemsifailoveridata
Details Rernove Cancel
&dd Job
Finish

Figure 140

Step 121. Click on the “File Protection” to find the “Exchange planned failover” job.

File Protection

Logged in as “admin’ - Logout

Application Per Page:[5

Server Time: Feb-3-2008 01:54:33

Applications Filter: [Appication Name [

Jobs Per Pages[5

Sortby:N G

Go |

= ungrouped
. . . Scheduled Job | scheduled .
Job Description Status Source Host Source Directory Target Host Target Directory RPO Toee GID  JIi Drder | Start Time Trending
Ci\Pragram Ci\Pragram g SETEFEAEE
o exchange consisteney... Seurce starting.. | EMCHANGE_PROD Files\InMage EXCHANGE_PROD Files\InMage SU’” run every 2 2 o D e View
Systamsifailoveridats Systams\failoueridats s P
Ci\Pragram Ci\Pragram a6 EE-E0-00
o exchange discovery... Mot started.. ERCHANGE_PROD Files\InMage ERCHANGE_PROD Files\InMage 5 ™ an demand 1 1 o G View
Systemsifailoveridata Systems\failoveridata = U0
Ci\Pragram Ci\Program CEEE-EE-a0
& exchange planned failover., Mot started.., EXCHANGE_PROD Files\Intage EXCHANGE_DR Files\InMage MfA | ondemand 3 3 o e (17
Systemsifailoveridata Systems\failoveridata :
Results 1-30f3 << <1 > »>
Stop Start | Details Remove
Displaying 1 to 1 (of 1 Applications) Result Pages:1
few Job Group Wizard
Manage Termplatss
Step 122 T f 1 d fail lect the “Exch 1 d failover” job and
ep . O periorm a planne allover, selec e Xchange planne aillover” jOb an

then click on “Start”. This will break the Exchange VX replication pairs and roll them back to

a consistent point.
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6.2 Exchange Unplanned Failover

Step 123. Click on “File Protection -> New Job Group Wizard -> Add Job” to open up the
“File Protection Wizard: Replication Pair”.

Step 124. Select the source and destination as the Exchange DR server. Then select the FX
template as “Exchange Unplanned Failover” and click on “Next”.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

Application I
Name:

Job Description: I

Source Destination
Host Host
{8 | EXCHANGE_DR [Windows] 1 {8} | EXCHANGE_DR [Windows] 2
{7 | EXCHANGE_PROD [Windows] {7 | EXCHANGE_PROD [Windows]
Directory Directory
I I Exchange Unplanned Failower j I @
Next -= Cancel
Figure 142
Step 125. The next screen opens up. Scroll down to the “Miscellaneous Options” to

change the target post script command. Edit the —S switch to reflect —-s<name of the
production Exchange server>

Step 126. The job will be set to run “On Demand”. Start the job to perform an unplanned
failover.
Step 127. To perform Exchange unplanned failover through CLIL refer to the section

Unplanned exchange failover on page 85

Step 128. To retain the replication pairs on the CX U, use the “—audit” switch. This will
unhide all the target volumes in read write mode and roll them back to the latest consistent
point. This is preferred when you want to avoid setting replication pairs again. All older
retention logs and data are lost.

‘!() Notes:

Ensure that Exchange discovery is performed (post VX replication) before going ahead
with Exchange unplanned failover.

For Exchange server 2007, select the FX template as “Exchange 2007 Unplanned Failover”.
Since the production server is considered to be down, selecting the source and target as
the DR Exchange server.
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-
A Caution:

Unplanned failover is performed when the production server is unreachable, so by selecting

the DR server as the source and destination ensures that the job completes even while the
production server is unreachable

6.3 Exchange failover (W/O CDP retention)

If the VX replication is set without the “CDP retention” option, then to failover the exchange
server select the FX template as “Exchange Failover without Retention”.

File Protection Wizard: Replication Pair

Replication Hosts

Application Mame: I

Job Description: I

Source Destination
Host Host
¥  EXCHAMGE_PROD [Windows] @ 0 EXCHAMGE_PROD [Windows]
T EXCHANGE_DR [Windows] % EXCHANGE_DR [Windows] [ 2
Directory

( 3 b | Exchange Failover ‘Without Fetention j

Mext ==« | Cancel

Figure 143:

You may also perform this through CLI; refer the section Exchange failover (Without retention)
on page 98

"!l") Notes:

For Exchange 2007 replication pairs without CDP retention, select the FX template as
“Exchange 2007 Failover without Retention” for failover.

While performing a failover on a replication pair without CDP retention, the target
volume is unlocked in read write mode and the exchange services are started on the target.

Ensure that the production server’s host name is not “Exchange”, else failover exits with
an error code of 32
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6.4 After Failover

After a failover is performed, users accessing the production server will be diverted to the backup

server.

3} Microsoft Outlook Web Access - Microsoft Internet Explorer

File  Edit Wwiew

Favorites  Tools  Help

B

orites £ | [__"21' L\._;t =

Addre @http:,l',l'exchange_dr,l'exchange,l’

[———

Figure 144

The backup server will serve to all user requests and email transactions continue normally. All
these operations occur while the production exchange server is down. Once the production

{a] Deleted Items LI

=l &

1 [

00
mFolders R TRETN [ERTTER Ay = = N & G 7
= £ Tommy ﬂ (4| From
[ Calendar Subject T | TN test
[85] Contacts : Jony
“M To: To

Jirn

server is online, a failback may be initiated.

.
\!1) Notes:

Post failover, discovery and consistency jobs are scheduled to "Run on Demand".
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7 Exchange Failback through CX Ul

Exchange failback is performed in three steps

“\
*To discover all volumes (and mount points)
Discovery *Can be performed either through CLI or CX Ul
*\/X replication of discovered volumes (or mountpoints)
VX *Media retention is enabled for roll back in time capabilities
replication
*A planned failback is performed from the DR server to the
\ Production server.
E::ilh?:cglf *Can be performed through CX Ul or through CLI )

Figure 145

Discovery
This is the first step to be performed in a failback. The discovery job ensures that all the Exchange

configuration changes on the DR server (post failover) are applied to the production Exchange
server.

Reverse replication

A reverse replication is set from the DR Exchange server to the production server to ensure that
the latest data is maintained across both servers.

Exchange Failback
Exchange planned failback is performed from the DR Exchange server to the production
Exchange server. This can be performed either through CX UI or through CLI.
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7.1 Discovery

Step 129. Open the CX UI and click on “File Replication —> New Job Group Wizard ->

Add Job” Then select the “source” and the Exchange production server and “destination” as
the Exchange DR server. Select the FX template as Exchange Discovery and click on “Next”.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

Application I
Name:

Job Description: I

Source Destination
Host Host
{8} | EXCHANGE_DR [Windows] {C | EXCHANGE_DR [Windows]
{O) | EXCHANGE_PROD [Windows] {8 | EXCHANGE_PROD [Windows]
Directory Directory
I Exchange Discovery j
Mext -= Cancel
Figure 146
Step 130. The “Job Options”, screen opens up with all the required fields filled up

automatically including the target post script. Click on “Finish” to continue to the next

screen. Then save the job.

=ng =-Tall 3T=TT IIIJ MIMOT=EE"F= =0 WILNGOT o0 Frogrs

Pra execution script pathnamsl

Post execution script pathnamel

0

re execution script pathname :::Estinaticn::l

Post execution script pathname [destinz cn::|_='-.IrMa-;aS‘Jrstar's'-App cation. exe” -discover -2pp Exchangs

Catch &ll jeb mcciﬁsrl—supal for power users only
<- Back Finish -= Cancel
Figure 147
Step 131. Start the Discovery job and proceed to the next step once discovery completes
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7.2 Setting a reverse replication

A reverse replication is set to update the production exchange server (original source) with all the
data changes during the outage. All exchange volumes are replicated to back to the production

exchange server.

Step 132.

select the exchange volume and click on “Start Replication”.

Yolume Protection: Source Site

Logged in as "admin’ - Logout
Source | Target

Protected Drives

Server

Primary Drives
EXCHANGE_PROD
=] EXcHANCE DR

Pri ¥olume

F5

Application

Server Pri Yolume FS Application Capacity (Bytes)
[l EXCHAMGE_DR E (Exchange DB MTFS Micrasoft Exchange 2003 526385152
T BN AT e O T Jorame T MTFS Unknown 526385152
o EXCHAMGE_DR G [ Mew Volume ) NTFS Unknown 1052803072
Start Replication Reset
Figure 148
Step 133. Expand the target host (previously source exchange server) and select the

exchange volume and scroll down to set the “Replication options”.

Host: EXCHAMNGE_DR
Crive: E

Capacity: 526385152

Select a target WAN volume

WAHN Server

B EXCHAMGE_PROD

o EXCHANGE_PROD

7T ERCHANGE_FROD
EXCHANGE_DR

[ InfMageProfilar

Yolume

E [ Exchange_DB )

F [ Mew Volume )

Figure 149

Click on “Volume Protection”, expand the host (previously the target host) and
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Step 134. Ensure that “Enable CDP Retention option” is enabled while other features are
optional. Click on “Submit”. The rest of the options are optional.

Replication Options

|- Secure transport from Source to InMageCX
|_ Secure transport from InMage CX to destination

Sync options: I Fast 'I

Use compression: I CX Basad Compression j
{Owverrides existing 1-M replication pairs)

Add to volume consistency group: I Mew Violume Group j

CDP Retention

Enable COP Retention option

Automatic Resync Options

' Start between huursl'& :I-:{' and IS :I-:-:' after waiting |30 | minutes.

(All times are local to CX)

Submit Cancel Reset
Figure 150
Step 135. The last screen opens up where the type of retention policy is to be defined. Enter

accordingly and click on “Submit” to start the replication.

Volume Protection: Retention Options
Logged in as 'admin’ - Logout

Pair Details
Server Pri Yolume Remote Server ¥olume

EXCHANGE_DR E EXCHAMNGE_PROD E

Retention Logging Policy

Retention Palicy Roll-backward
Retention Log Size 0.00 (ME) Cumrent Retention Log Size 0.00 (MB)
Unused Space 50.00 (MB)

Retain changes upto |258 I MB =] (Cannot be less then 256 MB)
Retain changes upto the (time) I (Days) I (Chrs.)

@ Durge older retention logs

On insufficient disk space
© Pause differentials

f:\retention logs (Eg:- K:\log_data)

Log data directory
F drive is suggested for storing rollback log files.

Configure Thresheld for Alerts

Alert when disk space utilization reaches a0 o

Submit Cancel

Figure 151

‘!l) Notes:

By default 256 MB is left free on the retention volume. You may choose to reduce this free
space limit through “System -> Agent Settings -> Retention Reserve Space Settings” to
reduce the “Unused space” on retention volume
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7.3 FX job for failback

After the reverse replication reaches “Differential Sync” the production exchange server is
updated with all the data changes occurred during its outage. Now performing a failback to the
production Exchange server ensures little or no data loss. To perform a failback through CLI,
refer to the section Exchange Failback on page 99.

Step 136. Open the CX U], click on “File Protection”, then click on “New Job Group
Wizard”

File Protection
Logged in as "admin’ - Logout

Applications Fitter: [ Application Hame 2]
Application Per Pages]5

=] Ungrouped
s - " Scheduled
Job Description Status Source Host Source Directory  Target Host Target Directory RPOD o
CiiProgram Cr\Program
e} exchange consistency.., Mot started.., EXCHAMNGE_PROD FileshInMage EXCHANGE_PROD FilesiInMage MN/A | on demand]
Systems\failoveridata Systems\failoveridata
Ci\Program Ci\Program
o exchange discovery... Mot started... EXCHANGE_PROD FileshInMage EXCHANGE_PROD FilesiInMage N/A | on demand|
Systemsifailoveridata Systemshfailoveridata
CiiProgram Cr\Program
O exchange planned failover... Mot started.., EXCHANGE_PROD Files\InMage EXCHANGE_DR FilesiInMage N/A | on demand|
Systemsifailoveridata Systemshfailoveridata

Results 1-3 of 3 << <1 > »»

Stop Start Details Remove

Displaying 1 to 1 (of 1 Applications)

MNew Job Group Wizard

Manage Templates

Figure 152

Step 137. Click on “Add Job”.

File Protection

Logged in as 'admin’ - Logout

Replication Jobs

P -
[: A Application  Source Target Target Direcbony

¥ ] Name Hast Source Directory Host

Cancel

I Add Job I

Figure 153



Step 138. Select the DR exchange server as source and the production exchange as the
destination, then select the FX template as “Exchange Planned Failover” and click on “Next”.

Replication Hosts
Application I
Mame:
Job Description: I
Source Destination
Host Host
{* | EXCHAMNGE_DR [Windows] " | EXCHANGE_DR [Windows]
" EXCHAMNGE_PROD [Windows] ¥ | EXCHANGE_PROD [Windows]
Directory Directory
| |
I Exchange Planned Failback ;I
Mext -= Cancel

Figure 154

‘!n) Notes:

For Exchange 2007 use the template “Exchange 2007 Planned Failback”

To perform AD replication, use the switch “~doadreplication” on the target post script.

To restrict DNS failover automatically use the switch “—nodnsfailover” on the target post
script

Step 139. The “Job options” page opens up, scroll down and click on “Finish” to complete
the FX configuration.

Send E-mail alert if|5 minutes passed without job progress

Pre execution script pathnamel"Cf\Fmgﬁm Filez (x&86°hInhiage Systems'application.exe" -failt

Post edecution script pathnamel

Pre execution script pathname (destinationjl

Post execution script pathname Edestination)l; PLANNED -5 EXCHANGE_DR 4 EXCHANGE_PROD -builtin

Catch All job modiﬂerl"s'-lper For power users anly

<- Back Finish - Cancel

Figure 155
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Step 140. You will be returned to the “File Protection Group”. Click on “Finish” to save

the job.

File Protection Group

Group Schedule
Schedule Type Schedule Time
Once At On Demand

Set Schedule

Replication Jobs

@ | Application N =
[:ﬂ_ Name Source Host Source Directory Target Host Target Directory
Run order I
CiWProgram Ci\Program
(o Ungrouped  EXCHAMGE_DR  Files\InMage EXCHAMNGE_PROD | Files\InMage
Systemsifailoveridata Systemsifailoveridata
Details Rermove Cancel
Add Job
Finish

Figure 156

Step 141. Click on “File Protection” to find the newly created FX job. To perform a failback

to the Production server, select the job and click on “Start”.

File Protection
Logged in as "admin’ - Logout

Results 1-40f4 << <1 » »»

Stop Start Details Rernove

Displaying 1 to 1 (of 1 Applications)

New Job Group Wizard

Manage Templates

Applications
Application Per Page;|5
E ungrouped
Job Description Status Source Host Source Directory  Target Host Taf
Ci'Program
[ exchange consistancy... Mot started.., EXCHANGE_PROD Files\InMage EXCHANGE_FROD
Sysrems\failoverdats
Ci\Program
(@l exchange discovery... Mot started.., EXCHANGE_PROD Files\InMage EXCHANGE_PROD
Systemsifailoveridata Sy
Ci\Program
Fud e ! b Mot started.. EXCHANGE_PROD Files\InMage EXCHAMGE_DR
Systemsfailoveridats Sy
Ci'Program
[ exchange planned failback... Mot started.. EXCHANGE_DR Files\InMage EXCHANGE_FROD
Sysrems\failoverdats Sy

Figure 157

Step 142. The status of the failback can be monitored under “Protection Status -> File

Protection Status”.

File Protecton Status
Filte Joh Descrpti Aplicati Stat Sourcetost | Source Diecto Trethost | Tagettinecy | SO0 g w W
lter ob Desciption ppication 5 ourceost Source Divectory argetHos agetbectoy G )
Set
Select j Select j Select j Select j
Clear
CiProgram Ciprogram \
Exchange Planneda, | Ungrouped Staring., EXCHANGE DR Fles\nMage EXCHANGE_PROD. Flles\nbage Bt 7 168

Exit Code

Select j

A
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Figure 158

7.4 After failback

After a failback, the production server is back online. This is a transparent process for the end
users and you should be able to access your mail box without any client side configuration

changes.

2 Microsoft Dutlook Web Access

File Edit Wiew Favaorites Tools  Help

i Bt~ ) - %] 2] Search . Fafarites 4 | [0+ s =

Addres @http:,l',l'exchange;rod,l’exchange,l’

1 [

mFolders v A Sl ew v 'f_% x a Q 6;\; LEEl - 'gﬁ p [ | @ Help

=) 5 Tomny ﬂ ! DI|Q | From |Subject Size| %7
] Calendar e test
@] Contacts Jarry
(5] Deleted Items ﬂ To: Tom
= . . Jirninny

Cc:

E 1

Figure 159




8 Exchange failover and failback through CLI
8.1 Exchange Failover

8.1.1 Planned exchange failover

A planned failover can be performed through the command line interface as well. Since planned
failover involves preparing the production exchange server before actually failing over.

Step 143. Switch to the production exchange server’s console (the active node incase of
cluster environment) and navigate to the VX agent installation path. In this example the
installation path is “C:\Program files\InMage Systems”. The command application.exe is
used to prepare the production server.

The syntax of the command is
Application.exe —failover —planned —app Exchange -s <Name of the production
exchange server> -t <name of the backup exchange server> -builtin —tag NONE

C:wProgram Files“InMage Systemsrapplication —failover —planned —app Exc
hange —s Exchange_prod —t exchange_dr —builtin —tag HOHE

Exchange_prod IP address = 18.8.81 .98
exchange_dr IP address = 18.8.81.91
Checking for Active Director

Figure 160:

The result of the command is displayed as “important information”.
The syntax of the command is

Application —failover —planned —app exchange —s <production exchange sever
name> -t <backup exchange server name> -builtin —tag <tagname as given by step1>

IMPORTANT INFORMATION

leaze vun the following command on the Target Host to complete failove

pplication.exe —failover —planned —app Exchange —s exchange_prod —t ex
hange_dy -builtln —-tag FileSystem4Yaclb%e

Successfully Completed Failover on Source Host

Figure 161:
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Step 144. Execute the command on the backup exchange server to complete a planned
failover through the command line interface.

wProgram FileswInMage Systems>application —failover —planned —app exchange —=s

exchange_prod —t exchange_dr —builtin —tag FileSystemd7aclbVe
exchange_prod [P address = 10.68.81.98
-xchaqge_ﬂr IP a@dress = 18.8.81.21

N ap [ . . .

2 i o da

o Ll
Figure 162:

“!'r) Notes:

To failover to an application tag or user defined consistency tag, append the command with —
tag <name of the tag> -tagtype <type of the tag>.

The tagtype for exchange 2003 is Exchange and for exchange 2007 it is Exchange2007.
The tag type for user defined tag is USERDEFINED.
The name of tag given should belong to the type of the tag specified.

If the tagtype is not mentioned, by default the FS tagtype is considered

8.1.2 Unplanned exchange failover

Exchange Discovery is to be performed at least once after VX replication before performing an
unplanned Exchange failover.

An unplanned failover is performed on the DR exchange server (target host) console. The syntax
of the command is

Application —failover —unplanned —app exchange —s <Production exchange server
name> -t <Backup exchange server name> -builtin —tag latest

C:wProgram Files“InMage ESystemszrapplication -failover -—unplanned —app
exchange —s exchange_prod —t exchange_dyr —huiltin —tag latest

exchange_prod IP addres=z = 18.8.81.9
exchange_dr IP address = 18.8.81 .91
Checking for Active Directory updatesmodify privileges...

Figure 163:
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8.1.3 Exchange failover (Without retention)

Since “CDP retention” option is not enabled, the target volume cannot be rolled back, hence the
target volume is unlocked in read write mode and the exchange server is failed over with the
same command issued on the DR exchange server. The syntax is

Application —failover —unplanned —app exchange —s <production exchange server
name> -t <DR exchange server name> -builtin —tag none

C:sProgram FilessInMage Svystemszapplication.exe —failover —unplanned -a
pp Exchange —s ERCHAMGE_PROD —t EXCHANGE_DR -builtIn —tag MOME

EXCHANGE_PROD IP address = 10.8.81.98
EZCHAMGE_DR IP address = 18.68.81.%1
hecking for Active Directory updatesmodify privileges...

Figure 164:
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8.2 Exchange Failback

8.2.1 Failback with CDP retention

Step 145. Access the DR exchange server console (which is acting in place of the
production exchange server) then issue the command shown in the picture below. The syntax
of the command is

Application —failover —planned —app exchange —s <DR exchange server> -t

<Production exchange server> -builtin —tag none

C:»Program Files“InMage Systems>»application —failbhack —planned —app Exchange —s
Exchange_dr —t Exchange_Prod —builtin —tag none

exchange_dyr IFP address = 18.8.81.91
exchange_prod IP address = 18.8_81.91
Checking for Active Directory update modif rivileges...

Figure 165:

The result of the command will be displayed under “important information”. This is the
command that has to be executed on the production server to complete the failback.

e e 3 S pepe e e e e e e e e H M M ] MPORTANT INFORMATIOW
Please run the following command on the target host to complete failover

application.exe —failback —planned —app Exchange —s exchange_dr —t exchange_prod
—builtin —tag FileSystemd7acB45e

Figure 166:

Step 146. Switch to the production exchange server’s console and issue the command to
complete the failback.

C:“Program Files“InMage Systemslapplication.exe —failback —planned —app Exchange
—z exchange_dr —t exchange_prod-builtin —tag FileSustemd4?acB45e

exchange_dr IP address = 10.8.81.91
exchange_prod IP address = 18.8.81.98
Checking for Active Directory update- modify privileges...

Figure 167:
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9 Failover and failback using crash consistency tag

In normal setup, DR scout uses VSS snapshot to issue application or consistency tag but in a
setup it is not possible to issue VSS consistency tag. In this case, crash consistency tag can be used
and the same can be used for failover and failback. When crash consistency tag is used it always
generates USERDEFINED tag. It will not generate any filesystem or application consistency tag.

9.1 Discovery

Use the application discovery template as used in planned failover. No changes are required.

9.2 Consistency

To set crash consistency FX job use the Exchangexxxx_consistency_fstag.bat file and pass the
required argument as given below.

Syntax:

Exchangexxxx_consistency fstag.bat "List of volumes separated by
semicolon™ -CrashConsistency

For example, Exchange 2003 has mailbox and storage groups in G, H, K:\Mnt1, J:\Mnt2 volumes.
Use the following command in prescript to set the crashconsistency job or run it through CLL

"C:\Program Files (x86)\InMage
Systems\consistency\Exchange consistency_fstag.bat”
"G:;H:;K:\Mntl;J:\Mnt2" —CrashConsistency

‘!fJ Notes:

List of volumes must be in double quotes else only first Drive or mount point is taken for
issuing tag.

-Crashconsitency can be written with or without double quotes
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9.3 Planned Failover

9.3.1 Planned failover through CX Ul

When you set a planned failover job, add the prescript with “—crashconsistency” and postscript
with-“-tagtype USERDEFINED”

For example,

Pre script: "C:\Program Files (x86)\InMage Systems\ application.exe" -failover -planned -app
Exchange -s W2K3-SRC -t W2K3-TGT -builtIn -tag NONE -CrashConsistency

Post script: "C:\Program Files (x86)\InMage Systems\ application.exe" -failover -planned -app
Exchange -s W2K3-SRC -t W2K3-TGT -builtIn -tag PLANNED -tagtype USERDEFINED

9.3.2 Planned Failover through CLI

When you run through CLI follow the same procedure as in Planned exchange failover on page
96. The only change is add “—crashconsistency” switch to the source command and target
command with”-tagtype USERDEFINED”.

Source Command:
"C:\Program Files (x86) \InMage Systems\ application.exe" -failover -planned -app Exchange -s
W2K3-SRC -t W2K3-TGT -builtln -tag NONE -CrashConsistency

Target command:

"C:\Program Files (x86) \InMage Systems\ application.exe" -failover -planned -app Exchange -s
W2K3-SRC -t W2K3-TGT -builtln -tag <User Defined Tag> -tagtype USERDEFINED
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9.4 Failback

9.4.1 Failback through CX

Use the same failback template as in section 8.2.4. The only change is add ”"-crashconsistency”
switch to the source command and target command with “-tagtype USERDEFINED”.

For example,
Pre script: "C:\Program Files (x86)\InMage Systems\ application.exe" -failback -planned -app
Exchange -s W2K3-TGT t W2K3-SRC -builtln -tag NONE -CrashConsistency

Post script: "C:\Program Files (x86)\InMage Systems\ application.exe" - failback -planned -app
Exchange -s W2K3-TGT -t W2K3-SRC -builtIn -tag PLANNED -tagtype USERDEFINED

9.4.2 Failback through CLI

When you run through CLI follow the same procedure as in section 8.2.4.
The only change is add “—crashconsistency” switch to the source command and target command
with “-tagtype USERDEFINED”.

Source command:
"C:\Program Files (x86)\InMage Systems\ application.exe" - failback -planned -app Exchange -s
W2K3-TGT -t W2K3-SRC -builtln -tag NONE -CrashConsistency

Target command:
"C:\Program Files (x86) \InMage Systems\ application.exe" - failback -planned -app Exchange -s
W2K3-TGT -t W2K3-SRC -builtln -tag <User Defined Tag> -tagtype USERDEFINED

9.5 Unplanned Failover

When you set the unplanned failover job, in the unplanned failover template, add the postscript
with-"-tagtype USERDEFINED”. The same can be used for the CLI

For example,
“C:\Program Files (x86)\InMage Systems>application.exe -failover -unplanned -app exchange -s
W2K3-SRC -t W2K3-TGT -builtln -tag LATEST -tagtype USERDEFINED"”
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Part 2 Active/Passive Clustered
Production Server and
Standalone DR Server

This part explains replicating a clustered production Exchange server to a standalone DR server.
This part contains four major sections

Prepare: This section explains steps to be taken before deploying Scout to backup a Clustered
Exchange server (with one active node and one passive node) to a standalone Exchange server.

Protect: This section consists of three sub sections Discovery, VX replication, and consistency.
Failover: Planned and unplanned failover are both explained through CX UI and CLL

Failback: Failback from a non-clustered Exchange server to a clustered Exchange server is
described in detail.
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10 Preparing for deployment

Similar to a non clustered environment, a discovery job is run to probe for exchange volumes.
However, before proceeding with the discovery job, there are a couple of registry values that
need to be altered manually on each of the cluster node.

The registry value “UseConfiguredIP” should be set to decimal 3255. Another registry value
“ConfiguredIP” should be set to the public IP address, since the private IP address will be
internally used for clustering. Both registry values are under
“HKEY_LOCAL_MACHINE\SOFTWARE\SV Systems\FileReplicationAgent”

Once the values are set, restart the FX agent service on the corresponding node to enable the FX
agent to pick up the new settings.

Start FX agent

Set Registry . :
values —> it d.‘*”f“a'”
user privilages
Figure 168:

In this part of the document EXCLUSTER1 and EXCLUSTER? are cluster nodes while
EXDRSERVER is used as a backup exchange server. The names of these servers will differ with
those in your production environment.

Step 147. Set the registry values: This can be done through the registry editor
(“regedit.exe”)

Step 148. Restart the FX agent service: Once the registry values are set restart the FX agent
service (“services.msc”

S Caution:

Ensure that the FX agent service is started with domain administrator privileges.
Failing to set the registry values results in exit code 10 for FX jobs.
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11 Protect Clustered Exchange server (Cluster environment)

This part of the document is valid for a two node cluster with one active and one passive node.
Protecting Exchange is divided into four sections as shown below

Exchange L VX s, Exchange Exchange
Discovery replication Discovery Consistency
Figure 169

Exchange Discovery

The first step for protecting Exchange server is to identify the volumes Exchange server is using.
This is accomplished through the Exchange Discovery FX job.

VX replication

The next step is a VX replication this is where all the discovered Exchange volumes are replicated
to a remote DR server.

Exchange discovery again

The Exchange discovery job is run once again to capture all configuration related changes such
are replication pairs set, retention path of each replication pair etc. The discovery job is run
whenever there are Exchange configuration changes.

Exchange consistency

Finally a consistency job is run on a periodic basis to issue exchange specific consistency tags.
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11.1 Discover

Log into the CX Ul and click on “File Protection” to setup the FX job for Exchange Discovery to
identify the Exchange volumes.

Step 149. Setup the FX job with “Source” as the active node and “Destination” as the DR
server. Select the FX template as “Exchange Discovery”

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
Application
Namae:
Job Description: |Discovery
Source Destination
Host Host
(& | EXCLUSTERI [Windows] {0 | EXCLUSTERL [Windows]
{0 | EXCLUSTERZ [Windows] ) | EXCLUSTERZ [Windews]
(& | EXDRSERWER [Windows] {8 EXDRSERVER [Windows]
Diractory Directory
[ I
[l
Mext -= Cancel
Figure 170
Step 150. The FX Job options screen opens up with all the required fields filled up

automatically scroll down and click on “Finish”

= ENT FFLArerr T ILI MINOTEE pazsad

Send E-mail alert ifIS minutes passed withautjob progress

Pre execution script pathnamel

Paost enecution script pathnamel

Pre axecution script pathnare (destination)l

Post execution script pathname (destinatinnjlapplicatinn.eae ~discower -app Edchange -host EXCLUSTER

Catch all job m-:-diﬁerl—rsuper for power users anly

<- Back Finish - = Cancel

Figure 171

Then start the job.
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Step 151.

Volume Protection: Source Site

Logged in as 'admin’ - Logout

Socurce | Target

Protected Drives

Server Pri Volume FS Application Capd
Primary Drivas
EXDRSERVER
EXCLUSTER1 Before Discovery
EXCLUSTER2
=] cluster Graup(s) Volumes
Server Pri Volume FS Application Capacity (Bytes) F
Cluster:EXCLUSTER,
[o] Group:EXVIRTSERN KL NTFS Unknown 1071627264
Servers:EXCLUSTER1,EXCLUSTERZ
Cluster:EXCLUSTER, Group:Group 3 y = =
© | carvers:EXCLUSTER1,EXCLUSTER2 o B Jngmew ke
Cluster:EXCLUSTER, Group:Cluster
[8] Group N NTFS Unknown 1065253632
Servers:EXCLUSTER1,EXCLUSTER2
Cluster:EXCLUSTER, Group:Group 0 | = =
© corversiEXCLUSTER®,EXCLUSTERZ Q I Unknown LITLETA
Start Replication || Reset ||
Figure 172:

Before executing the discovery job the “Application” field is shown as unknown.

Once the Exchange Discovery job is complete all the volumes used by exchange server show the

application as Microsoft Exchange 2003 (or 2007).

Volume Protection: Source Site

Logged in as 'admin’ - Logout
Source | Target

Protected Drives

Server Pri Volume FS Application Cap
Primary Drives
EXDRSERVER
EXCLUSTER1 )
EXCLUSTERZ After Discovery
[E Cluster Group(s) Volumes
Sarver Pri Volume FS Applicatioft Capacity (Bytes) H
Sl E U T Microsoft Exchangs
(8] Group:EXVWIRTSERW KL NTFS g 1071627264
Servers:EXCLUSTER L, EXCLUSTERZ
Cluster:EXCLUSTER, Group:Group 3 - = =
© | Servers:EXCLUSTER 1, EXCLUSTERZ M NTFS iy 1071627284
Cluster:EXCLUSTER, Group:Cluster
fa) Group N NTFS Unknawn 1069253632
Servers:EXCLUSTER L, EXCLUSTERZ
Cluster:EXCLUSTER, Greup:Group O - . .
© | Servers:EXCLUSTER1,EXCLUSTER2 Q D Sl LT LR
Start Replication || Reset ||
Figure 173:

‘!') Notes:

Discovery job is to be executed before and after setting up the VX replication pairs and
additionally a discovery job is executed whenever there is an Exchange configuration
change such as adding or removing exchange volumes, DB stores, or storage groups etc.
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11.2 Volume Replication

Now that the exchange volumes are identified, proceed to setup a replication pair to backup
exchange server on a cluster environment. The process however slightly varies with one

additional screen.

Step 152.
Replication”.

Click on “Volume Protection”, select the Exchange volume and click on “Start

Volume Protection: Source Site
Logged in as 'admin’ - Logout

Source | Target

Protected Dvives

Server Pri Volume FS Application
Primary Drives
EXDRSERVER
EXCLUSTER1
EXCLUSTER2
B Cluster Group(s) Volumas
Server Pri Volume FS Application Capacity (Bytes)
Clust=rEXCLUSTER, S —
o Group: EXVIRTSERW KL NTFS - 5003 = 1071627264
Senvers:EXCLUSTER1 EXCLUSTERZ
ustEr:sx 5 up:roup - - S
© | Servers:EXCLUSTER1,EXCLUSTER2 M NTFS e 1071827284
Cluster:EXCLUSTER, Group:Cluster
O Group N NTFS Unknown 1069253632
Servers:EXCLUSTER1,EXCLUSTERZ
Cluster:EXCLUSTER, Group:Group O L - 7 7264
© | Servers:EXCLUSTER1,EXCLUSTER2 2 NTFS Yl 107182728
Start Replication Rezet
Figure 174:
Step 153. This is the screen that is shown only for clustered environment. Select the

appropriate cluster drive and click on “Next”.

Volume Replication: Cluster Setup

Cluster: excLuster
Cluster Group: sxvirTsery

Configured Cluster Drives

Primary Server

Primary Volume

Finish Remove
Unconfigured Cluster Drives
Server Pri Volume FS
(= EXCLUSTER1,EXCLUSTERZ2 K NTFS
[ EXCLUSTER1,EXCLUSTERZ2 L NTFS
Next

Reset Cancel

Capacity (Bytes)
1071627264
1071627264

Reset

Figure 175:
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Step 154.

“Replication Options”.

In the next screen, select the target volume and scroll down to set the

Cluster: EXCLUSTER
Cluster Group: EXVIRTSERV

Drive: K
Capacity: 1071627264

Select a target WAN volume

WAN Servar Vaoluma Capacity (Bytes)
[=] exorserver

{7 | EXDRSERWER E [ New Wolume ) 1077477376
{7 | EXDRSERWER F [ New Veolume ] 1077477376
[ EXDRSERWVER G [ New Volume ) 1077477376
(& | EXDRSERVER H [ Maw Velumes ) 1044577280
*  EXDRSERVER K[ Mew Volume ) 1077477376
[ EXDRSERWVER L [ New VWolume ) 1077477376

Figure 176:

Step 155. Ensure that “Enable CDP Retention Option” is enabled then click on “submit”.

Other replication options are optional.

o
o

Replication Options

Secure transport from Source to InMageCX

Secure transport from InMage CX to destination

Sync options: I Fast "I

Use compression: I CX Based Compression
{Overrides existing 1-N replication pairs)

=

Add to volume consistency group: I New Volume Group

COP Retention

Enable COP Retention option

Automatic Resync Options

r Start between huursl'& :I-:-:l and IS :I-:r:l after waiting |30 | minutes.

(Al times are local to CX)

Submit Cancel Reszet

Figure 177:
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Step 156.

type of retention policy desired and click on “Submit”.

Volume Protection: Retention Options

Logged in as 'admin’ - Logout

Pair Details
Server

EXCLUSTER1,EXCLUSTERZ

Retention Logging Policy
Retention Policy
Retention Log Size

Unused Space

Retain changes upto

Retain changes upto the (time)

On insufficient disk space

Pri Valume

K EXDRSERVER K

Roll-backward
0.00 {MB) Current Retention Log Size

256.00 (MB)
{Cannot be less then 256 MB)
[ (oays) [ thes)

= Purge older retention logs
o Pause differentials

(Eg:- K \log_data)

Remaote Server Valume

0.00 (MB)

Log data directory

Configure Threshaold for Alerts

Alert when disk space utilization reaches

E.F.G.H,L are drives suggested for storing rollback log files.

Cancel ||

Figure 178:

‘!I) Notes:

Since CDP retention is enabled, a retention policy needs to be selected. Select the

By default 256 MB is left free on the retention volume. You may choose to reduce this free
space limit through “System -> Agent Settings -> Retention Reserve Space Settings” to

reduce the “Unused space” on retention volume

Step 157.
replication pair.

Select the configured cluster drive and then click on “Finish” to start the

Volume Replication: Cluster Setup

ICluster: excLusTer
ICluster Group: sxvirTsery

Configured Cluster Drives
Primary Server

" EXCLUSTER1 EXCLUSTERZ2

Unconfigured Cluster Drives
Server

(] EXCLUSTER1 EXCLUSTERZ2

Primary Volume

K

Finish H Remove || Reset || Cancel ||

Pri Volume F5

L

Capacity (Bytes)

NTFS 1071627264

Reset

Remot

Last VX 5

Figure 179:
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Step 158. Similarly, replicate other volumes to their respective target volumes on the DR
server (while maintaining similar drive mapping). The replication pair starts from
“Resyncing Step 1” then moves to “Resyncing Step 2” and then finally reaches “Differential
Sync”.

Protection Status

Logged in as 'admin’ - Logout Server Time: Sep-16-2008 02:22:1

Volume Protaction Status

Resyncs In Resync In
Sarver Valume Group Transit Stepl | Transit Stap2 D:fFFet’e(:‘téaj“ Resync progress RPO Status RR“"”‘d DV‘:"T
== == g evired | Datais
Cluster: EXCLUSTER, Group:EXVIRTSERY
Servers K-> K Welume K o o o N/A 0.4 minutes Differentizl Sync NO
EXCLUSTER1 EXCLUSTER2->EXDRSERVER
Cluster: EXCLUSTER, Group:EXWVIRTSERY
Servers: L->L Welume L o o 0 N 0,35 minutes Differential Sync NO
EXCLUSTER1 EXCLUSTER2->EXDRSERVER
Figure 180:
L . Ty . ” . .
Step 159. Once the replication pairs reach “Differential Sync” run the Discovery job. For

each EVS or Exchange server, a total of three files are created on the corresponding DR
server. These files contain :

e List of VX Replication pairs

e Retention logs of each replication pair

e Exchange database and log file location.

This information is later used while recovering from a production site outage.

s Caution:

If the discovery job is not run after setting the replication pairs, Unplanned failover cannot be
performed when the CX server is down.
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11.3 Consistency

Step 160. Once the replication pair reaches “Differential Sync”, configure FX job to issue

consistency tags at regular intervals. It is important to select the source and destination as the

active node. Then select the FX template as “Exchange Consistency”.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
::I:':“i“” |Excchang=2002
Job Description: IG:rE Etency
Source Destination
Host Host
(8) | EXCLUSTER1 [Windows] {® | EXCLUSTER1 [Windows]
{C | EXCLUSTER2 [Windows] {7} | EXCLUSTER2 [Windows]
| EXDRSERVER [Windows] ) | EXDRSERWER [Windows]
Directory Directory
I I
Exchange Consistency j
Next -= Cancel
Figure 181
Step 161.

The “job options” open up, with all the required fields filled up, scroll down to

find that the source pre script is filled up automatically. Click on “Finish” and schedule the

job to run at regular intervals.

Send E-mail alert iFI5 minutes passed witheut job progress

Pre execution script path

Post execution script pathname

mEI"C:'-.Fr-J; ram Files\InMage Systems\consistency\exchangs_c

Pre exscution script pathname ::cegtinaticn:il

Past execution script pathname ::cesl:inaticn:il

Catch &ll job mcciﬁerl—s..par for power users only

«<- Back Finish -= Cancel

Figure 182

112




Step 162.

Similarly set Exchange consistency job for all the nodes in the cluster.

Consistency tags will be issued only on the active node. This ensures that consistency tags are
issued even after cluster failover

Step 163.

It is also important to run the Discovery job after setting up the replication pairs
and it is recommended to schedule the discovery job to run once a day. This will catch any

configuration changes that were made by the exchange administrators and replicate them to

the target servers.

Protection Status
Logged in as "admin’ - Logout

Wolume Protection Status
Server

Cluster:EXCLUSTER, Group:EXVIRTSERV
Servars
EXCLUSTER1,EXCLUSTER2->EXDRSERVER
Cluster:EXCLUSTER, Group:EXVIRTSERV
Servars
EXCLUSTER1,EXCLUSTER2->EXDRSERVER
(Snapshot / Recovary / Rollback) Pair Status

Host | Snapshot / Recovery / | Drive

Host | bive Rollback Drive Type

File Protection Status

Filter Jab Description

Consistency...

Discovery...

sults 1-2 of 2 I
£ o3 o

Application

... Exchange Consistency
== ’TL = =
Clear

Exchang

Exchang

Exchange Discovery

Group

Velume K

Welume L

Start End
Time | Time

Status

Completed

Cempleted

Resyncs In Resync In

Transit Stepl Transit Step2 Resync progress
(B} (B} Left (MB)
1] 2] 2] N/A 0.57 minutes
1] 2] 2] N/A 0.52 minutes
— o = VXreplication
Status
Recovery Point = Recovery Paint Message

Source Host

Source Directory

ridata

C
EXCLUSTERL | Files\ e
Systems\failoveridata

Clear logs for selected jobs

Differentials

Target Host Target Directory

EXCLUSTER1 | File;
5 varidata

<
EXDRSERVER | File: age
Systems\failoveridata

Delete all job history

Server Time: Sep-16-2008 02:57:17

Resync | View
HETE Required | Details
Differential Sync NO
Differential Sync NO
GID 1D Job |
Instance =X
z 10 0
1 z o

Figure 183: Active VX replication, successful discovery and consistency jobs

S Caution:

It is important to select the source as the active node while setting up Exchange consistency job

else the job will fail

If Exchange consistency job fails continuously then either the exchange services are not running
on the active node or the active node is down.
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12 Exchange Failover through CX Ul (cluster environment)
12.1 Exchange planned failover
Step 164. Configure a new FX job to perform a planned failover. It is vital to select the

active node as the source then select the DR exchange server for destination and finally select
the FX template as “Exchange Planned failover” then click on “Next”.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
::ﬁl"::“i“” |Exchang= 2002
Job Description: |Fiznned Failover
Source Destination
Host Host
{* | EXCLUSTERL [Windews] {0 | EXCLUSTER1 [Windows]
{7 | EXCLUSTERZ [Windows] {0 | EXCLUSTERZ2 [Windows]
) | EXDRSERVER [Windows] {8 | EXDRSERVER [Windows]
Directory Directory
| |
| Exchange Piznned Faiover =l
Next -= Cancel
Figure 184:
Step 165. The “Job Options” page opens up with all the required fields filled up including

source pre script and target post script. Click on “Finish” to continue and save the job in the
following screen.

- —
Send RPO zlert iFII-_ minutes passed
Send E-mail alert iFIE-_ jputes pazzed withoutigh proors
Fre execution script pathn mEI'S:'F":-;'E“' Fies\InMzge Systems\appication sxe” falover
Post execution script pathnamal
Pre execution script pathname :::Estiraticn'il
Post execution script pathname [dest naticn:il "C:\Program Files\InMage Systems\application.sxs" failover
Catch All job I'I'Ic:iﬁil"—i.:é' for power users only
<- Back Finish -= Cancel

Figure 185:
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At this point of time:

e The exchange volume(s) are being replicated to the backup exchange server.
e Consistency tags are being issued on the active node regularly
o The planned exchange failover job is configured.

To perform an Exchange planned failover, click on “File Protection”, select the “Exchange
Planned Failover” job and click on “Start”.

Click on “Protection Status” to check the status of the “Exchange planned failover”. The job’s
status turns “Completed” indicating that the failover completed successfully.

File Protection Status
Filter Job Dascription Application Status Source Host Source Diractory Target Host Target Diractory =
Set Clear I Select Ell z==t =

C:\Program C:\Program

Consistency... Exchange 2003 Failed EXCLUSTER1 | Files\InMage EXCLUSTER1 | Files\InMage Ru
Systems\fziloveridata Systems\faileveridata
C:\Program C:\Program

Consistency... Exchange 2003 Failed EXCLUSTER1 | Files\InMage EXCLUSTERL | Files\InMage Ru
Systems\failowver\data Systems\failoveridata
C:\Program C:\Program ol

Planned Failover... Exchange 2003 Completed EXCLUSTER1 | Files\InMage EXDRSERVER | Files\InMage De
Systems\fziloveridata Systems\faileveridata

Figure 186:

‘!LI’) Notes:

After failover, exchange consistency job is set to “Run On Demand”
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12.2 Exchange unplanned failover

Although the functionality differs between planned and unplanned failover, the process of
setting FX jobs for both is similar with two small but significant changes.

Step 166. Assuming that the production exchange server is down, select the DR Exchange
server for both the “Source” and “Destination”. Select the FX template as “Exchange
Unplanned Failover”.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

::;:';a”"” |Exchangs 2002
Job Description: |unpiznned Faiover
Source Destination
Host Host
O | EXCLUSTER1 [Windows] {0 | EXCLUSTER1 [Windows]
{0 | EXCLUSTERZ [Windows] {0 | EXCLUSTERZ [Windows]
{* | EXDRSERVER [Windows] {3 | EXDRSERWER [Windews]
Directory Directory
| |
| Exchange Unpiznned Failover =l
MNext -= Cancel
Figure 187:
Step 167. The “Job Options” page opens up. Scroll down to “Miscellaneous options” to

edit the target post script. The “—s switch” contains the DR Exchange server’s name, change
this to “—s <Production exchange server>" then click on “Save”. Start the job to perform an
unplanned failover.

Send RPO zlert iFI-II minutes passed

Send E-mail alert iFI5 minutes passed witheut jeb progress

Pre exscution script pathnamel

Post exscutien script pathnamel

Pre exscuticn script pathname [destinatig il

Post execution script pathname [destinay cn:il'er-;a—s EXCLUSTER1 -t EXDRSERWVER -builtin -t=g LATEST|

Catch All jeb mc:iﬁerl—s..par for power USers oniy

«<- Back Finich -= Cancel

Figure 188:
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12.3 Exchange failover (W/O CDP retention)

VX replication pairs without CDP retention do not have roll back capabilities. However, a
failback may be performed through the FX job. Once the job completes, the target volume will be
unlocked in read write mode and exchange services are started.

Set the FX job with “source” as the active node and the “Destination” as the DR server. Select the
FX template as Exchange “Failover Without Retention”.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout

Replication Hosts

Application I
Name:
Job Description: I
Source Destination
Host Host

" | EXDRSERVER [Windows]

{7 | EXCLUSTERZ [Windows]

]

EXDRSERVER [Windows]

{7 | EXCLUSTERZ [Windows]

¥ | EXCLUSTER1 [Windows] ) | EXCLUSTER1 [Windows]
Directory Directory
Exchange Faiover Without Retention j
Next -= Cancel
Figure 189

The job options page opens up. Click on “Finish” without changing any settings. Then start the
job to complete a failover.

Pre exscuticn script pathnamel

Post executicn script pathnamel

Pre execution script pathname :::estinaticn:il

Post execution script pathname [destin ticnj:lcl‘ar-;a—s EXCLUSTER1 -t EXDRSERVER -builtln -tag MONE|

Catch &ll job mc:iﬁerl—s.par for power users only

<- Back Finish -= Cancel

Figure 190
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13 Exchange failover through CLI
13.1 Failover

13.1.1 Planned Exchange failover

Step 168. Planned and unplanned failovers on a cluster environment can also be achieved
through command line interface. Access the active node’s command prompt to issue the
following command under the VX agent installation folder

Application -failover —planned —app Exchange —s <name of the active node> -
t<name of the DR server> -builtin —tag none

C:»Program Files“InMage Systemszlapplication —failover —planned —app Exchange —=
EXCLUSTERL —t EXDRSEERUVER -builtIn —-tag NONE

Attempting to determine Exchange Uirtual Server name for host @ EXCLUSTERL in ca
ze¢ it's a clustered configuration

Jirtual Server Mame for Host @ EXCLUSTER1L is : EXUIRTSERU

ERUIRTSERU IP address = 18.68.133.283

ERDRSERVER IP address = 18.6.133.285

Checking for Active Directory updater modify privileges...

Command Line: application —failover —-planned —app Exchange —s EACLUSTER1L -t EXDR
SERUER —-builtIn —tag HOME

Running under the user: BIT3Z2.0RGhadministrator

Process ID: 1872

Stopping the services dependent on Exchange services...

[INFO1: Empty list of dependent [on EXCHANGE] services found in CG:SProgram Files
~InMage Systemz“Failover Data“FailoverServices.conf

Found the virtual server: ESUIRTSERU

Figure 191

Step 169. The above command ends with a command enclosed within “IMPORTANT
INFORMATION”. This command is to be executed on the DR server to complete a planned
failover.

#*xx¥® The actual tag to failover to is : FileSystem4B8d8a’?83
esenneaeoaaanaaataes ]| H{PORTANT INFORMAT IOM
Pleaze wun the following command on the Target Host to complete failover

Application.exe —failover —planned —app Exchange —s exclusterd -t exdrszerver —hu
iltIn —tag FileSystemdB8dBa783

JoE-30f- oo 3o o JeE-JoE-SPE- 3o oo 3ef-JoE- - oo oo JoE-SPE e oo 3ef- oo Jef- oS- oS- Jef o - oo ook oS- e 3ef- oo oo ook JoE - e e o

=xxx¥® Successfully Completed Failover on Source Host

Figure 192
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Step 170. Access the DR Exchange server’s command prompt and navigate to the VX agent
installation path and then issue the command enclosed within “important information” in
the previous step. This concludes planned exchange failover through CLI for an active-
passive clustered Exchange server.

G:swProgram FilessInMage Systems>*Application.exe —failover —planned —app Exchange
-z exclusterd —t exdrserver —huiltln —tag FileSystemdB8d8a783

Attempting to determine Exchange Uirtual Server name for host : exclusterl in c

zg it's a clustered configuration

Jirtual Server Name for Host : exclusterl iz : EXUIRTSERU

EAUIRTSERU IP address = 18.8.133.263

exdrserver IP address = 18.8.133_.2@5

Checking for Active Directory update-modify privileges...

Command Line: Application.exe —failover —planned —-app Exchange —s exclusterl -t
exdrserver —builtln —tag FileSystem48dB8a783

Running under the uwser: BIT32 . 0RGhadministrator

Process ID: 1332

Stopping the services dependent on Exchange services...

[IMFO1: Empty list of dependent [on EXCHANGE] sewrvices found in G:“Program Files
~InMage Systems“Failover-Data“Failoverfervices.conf

Stopping Exchange services

Waiting for the service MSExchangelS to stop

Figure 193

13.1.2 Unplanned Exchange failover

To perform an Exchange unplanned failover, access the DR server’s command prompt to issue
the following command under the VX agent installation folder.

Application —failover —unplanned —app exchange —s <name of the active node> -
t <name of the DR server> -builtin —tag latest

C:“Program Files:InMage Systemsapplication —failover —unplanned —app Exchange —s EXCLUSTE
R1 —t EXDRSERUER -builtIn —tag LATEST

Attempting to determine Exchange Uirtual Server name for host : EXCLUSTERL in case it's a
clustered configuration

Jirtual Server Mame for Host : EXCLUSTERL is : EXUIRTSERU

EXUIRTSERU IP address = 18.8.133.2683

EXADRSERVER IP address = 18.8.133.285

Checking for Active Directory updatesmodify privileges...

Command Line: application —failover —unplanned —app Exchange —s EXCLUSTER1 -t ERDRSERUER -
builtIn —tag LATEST

Running wunder the user: BIT3I2.0RGhadministrator

Process ID: 2668

Figure 194

“‘]fr) Notes:

Ensure that Exchange discovery is performed after setting the VX replication pair before
going ahead with Exchange unplanned failover
For exchange 2007 the —app switch will be exchange2007
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14 Exchange Failback through CX UI.

A failback is performed once the production server is ready to resume operations. Failback is
performed in seven sequential steps as shown below.

Step 1: Cluster to Standalone: As part of a failback a reverse replication is set from the DR server
to the production server. While the replication is in progress the VX agent locks the target
volume. Since the target volume is clustered, the VX agent’s drive lock results in a cluster
failover. To avoid this, the cluster machine is converted into a standalone machine in this step.
This is achieved through a command line tool bundled with the VX agent.

Step 2: Reverse replication: After the production machine is converted from a cluster machine to
a standalone machine, a reverse replication is set from the DR server to the production server
with the same drive mapping.

Step 3:
Step 1: Cluster Step 2: Reverse " .
to Standalone —> replication —> Con::gt:ncy —>| Stepd: Rollback
|
W

Step 5: Step 6: Step 7: Bring
Standalone to —> Exfailover& —2| theEVS cluster

cluster DNS failback resource online

Figure 195

Step 3: Consistency tags: VACP consistency tags are issued on the DR server. A rollback is later
performed to the same consistency tag for all the Exchange volumes. Before issuing a tag ensure
that you stop Exchange services. The list of services to be stopped is given in the Consistency tags
section on page 125.

Step 4: Rollback: All the Exchange volumes are rolled back to the same consistency tag as issued
in the previous step.

Step 5: Standalone to cluster: Once the target volume is rolled back, the production machine is
restored back to its former cluster state. This is achieved through the same CLI tool.

Step 6: Exfailover and DNS failback: Exfailover is performed to restore Exchange server while
DNS failback is performed to restore original IP address back to the production server.

Step 7: Bring the EVS cluster resource online: Access the production Exchange server and bring
the EVS cluster resource online. This will also bring the exchange services online.
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14.1 Step 1: Cluster to standalone

Step 171. To convert the clustered production server to a standalone server, access the
active node of the production server then navigate to the VX agent installation path through
the command prompt to issue the following command

Clusutil —prepare ClusterToStandalone:<name of the active node> -
shutdown <names of the passive nodes separated by commas>

C:“Program Files“InMage Systems>*>CluslUtil -prepare ClusterToStandalone:ERCLUSTERL —shutdown
EXCLUSTER2

Connected to [EXCLUSTER21 SCH

Waiting for the service [svagents] to stop
Successfully stopped the service: [svagents]

Connected to [EXCLUSTER11 SCH
Waiting for the service [svagents] to stop

Figure 196

This shuts down the passive nodes and restarts active node, temporarily converting the active
node into a standalone server.

“%r) Notes:

For 2008 cluster, once the active node restarts, the volumes would go offline. To bring the
volumes online use the following command

Clusutil —prepare onlinedisk

“" Caution:

¢ You will need to login with domain administrator privileges to execute the
“clusutil” command.

e Ensure that the CX server is up and running before running the clusutil command.

e Clusutils.exe is to be executed on the node which is supposed to be turned into a standalone
server.

e Ensure that all passive nodes are unlocked, you may use an additional switch “—force” at
the end of the above command to force the execution.
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Switch to the CX Ul to observe that the Cluster Group Volumes disappears and all the volumes
will be shown belonging to the active node.

Volume Protection: Source Site

Logged in as ‘admin’ - Logout

Source | Tarast

Protected Drives

Server Pri Volume
Primary Drives
B EXCLUSTER1
Server Pri Volume FS
o EXCLUSTER1 K NTFS
Lo} EXCLUSTER1 L NTFS
o EXCLUSTER1 M NTFS
M:\Mount1 [ New
XCLL
[o EXCLUSTER1 Volume ) NTFS
o EXCLUSTER1 N NTFS
[s EXCLUSTER1 B R NTFS
Volume)
[&] EXCLUSTER1 Q NTFS

EXDRSERVER
EXCLUSTER2

Application

Microsoft Exchange
Micresoft Exchange
Unkngwn
Unkngwn
Unknown
Unknawn

Unknown

Start Replication

Application

Capacity (Bytes)
1071627264
1071627264
1071627264
1069253632
1063253632
1063253632
1071627264

Capacity (Bytes)

Free Space (Bytes)

1046042624
481278304

1063510016
1061194752
1056799744
1061154752
1063526400

Server Time: Sep-16-2008 18:01:5

Frees Space (Bytes)

Replication Status

Inactive
Inactive
Inactive
Inzctive
Inzctive
Inzctive

Inzctive

Figure 197

14.2 Step 2: Reverse replication

Step 172. Access the CX UI, and then expand the DR server to select the Exchange volume
as source. Note that this was once a target volume. Click on “Start Replication”.

Volume Protection: Source Site

Logged in as 'admin’ - Logout

Source | Target

Protected Drives

EXCLUSTER2

Server Pri Volume

Primary Drives

EXCLUSTER1

=) exorserver

Server Pri Volume FS

(@] EXDRSERWER E [ New Veolume ) NTFS
&) EXDRSERWER F [ New Velume ) NTFS
(@] EXDRSERWER [ New Velume ) NTFS
[@] EXDRSERWER NTFS

I [ EXDRSERVER K 1 NTFS
[a] EXDRSERWER L NTFS

FS

Application
Unknow

E

Unknown
Unknawn
Unknow
Unknow
Unknow

E

E

E

Start Replication

Application

Capacity {Bytes)

Reset

1077477376
107
107
1044
1071627264
1071627264

Capacity (Bytes)

Free Space ( By
104255692
106944512
106544512
768515073
103581158
4811816594

Figure 198
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Step 173.

In the next screen; expand the production server to select the target volume,
which was once the source volume. Then scroll down to set the “Replication Options”.

Select a target WAN volume

Host: EXDRSERVER
Drive: K

Capacity: 1071627264

WAN Server Valume Capacity (Bytes)

= EexcLusTer1
& |EXCLUSTER1 K 1071627264
O | ExCLUSTER1 L 1071627264
O | ExcLUSTER1 M 1071627264
@ |ExcLusTER1 I ([ 1069253632

Volume )
@ |ExcLusTER1 N 1069253632
BloiBdannt
Figure 199
Step 174. Ensure that the “Enable CDP Retention option” is enabled then click on

“Submit” to continue.

-
-

Replication Options

Secure transport from Source to InMageCX

Secure transport from InMage CX to destination

Swnc options: I Fzst "I

Use compression: I Cx Based Compression d
{Overrides existing 1-N replication pairs)

Add to volume consistency group: I New Volume Group

COP Retention

Automatic Resync Options

m Start between huursl'& :I-:*:' andIS :I-:':' after waiting |30 | minutes,

Enable CDP Retention option

{All times are local to CX)

Submit Cancel

Reset

Figure 200
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Step 175. Enter the type of retention policy applicable for the replication pair and click on
“Submit” to start the replication pair.

Volume Protection: Retention Options
Logged in as 'admin’ - Logout

Pair Details

Server Pri Volume Remote Server Volume

EXDRSERVER K EXCLUSTER1 K

Retention Logging Palicy

Retention Policy Roll-backward
Retention Log Size 0,00 (MB) Current Retention Log Size 0,00 (MB)
Unused Space 256.00 (MB)

Retain changes upto |253 I ME 'I (Cannot be less then 256 MB)
Retain changes upto the
] I {Days) I (hrs.)

@ Purge older retention logs

On insufficient disk space
© pause differentials

(Eg:- K:\log_data)

Log data directory
Q.N,M.N:\Mount2,M: \Mount1 are drives suggested for storing rollback log files.

Configure Threshold for Alerts

Alert when disk space utilization reaches 80 %a
Submit Cancel
Figure 201
Step 176. Similarly replicate the other volumes. Once the replication pair(s) reach

“Differential Sync”, proceed to the next step

Protection Status

Reverse replication with same drive mapping
Logged in as 'admin’ - Logout

Server Time: Sep-16-2008 18:14:03|

Volume Protection Status

Resyncs In . . -
£ Resync In Transit | Differentials Left Resync | View
Server Volume Group Tran(;'lvltE;Jtepl S e ) Resync progress RPO Status S |
EXDRSERVER- »EXCLUSTER1 K-> K Wolume K 0 a [ N/A 0.2 minutes Differential Sync NG
EXDRSERVER->EXCLUSTER1 L->L Wolume L 0 ] [ N/A 0.25 minutes Differantizl Sync NO

Figure 202
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14.3 Step 3: Consistency tags

Step 177. Stop the following exchange services on the source machines (DR servers). Some
of these services do not exist in Exchange 2007 and will fail to stop, this may be ignored.

| Exchange20:3 Exchange 2007

Service names MSExchangeMGMT MSExchangelS
RESvc
MSExchangelS
MSExchangeMTA MSExchangeSA
MSExchangeSA

“!l) Notes:

If there are any dependency services, stop the dependencies and then stop the Exchange
services.

Step 178. Then access the command prompt of the DR server to issue a consistency tag.
Navigate to the VX agent install path to issue the following command

Vacp —-v <exchange volumes separated by semi colon> -t “<failback
consistency tag>”

C:“Program Files~InMage Systems>vacp —v k:;1: -t "Tag_1"
Parzing command line arguments ....

Jalidating command line arguments ...
Generating Tag: Tag_1

Generating Tag: FileSystem48d8h864
Generating "Revocation" tag ...

Preparing the applications for consistency ...
Preparing Files H:\*® {(recursivelyl

Preparing Files L:\#* {recursivelyl

Starting snapshot set

Using M5 Software Shadow Copy provider: h59246137-7h?f-4925-af88-51abd6Bb2R45
Freezing the applications for consistency ... k
Commiting shadow copy for the set...

Figure 203

“!l) Notes:

This consistency tag will be used perform rollback in the next step
To issue consistency tags to multiple volumes, separate the volumes with a semi colon
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14.4 Step 4: Rollback

Step 179. After issuing consistency tags on the DR server. Switch to the CX UI to perform a
target volume rollback for all Exchange replication pairs.

Step 180. Click on “Recovery” then select the replication pair you want to rollback and

click on “Rollback”. A message box appears for confirmation, click on “Ok” to proceed. It
might take a few minutes for the tags to reach the CX server.

Volume Recovery : Recovery Snapshots

Logged in as 'admin’ - Logout

Recovery Snapshots | Scheduled Snapshots

Replication Pair Details

Pri
Server

Remote Server Volume Replication
Volume Pool
% EXDRSERWER K EXCLUSTER1 ke <
[ EXDRSERVER L EXCLUSTER1 L 3

Fecover Rollback: Feset

Figure 204

Step 181. The next screen opens up as shown in the picture below. Select the “Using
Application consistency & Event based” option.

Volume Recovery: Recovery SnapShot Options

Logged in as 'admin’ - Logout
Pair Details

Server Primary Volume Remaote Server

EXDRSERVER K

Target Volume Replication Pool

EXCLUSTER1 K 4

Recovery Options

Logs Available From Z008/3/23 9:8:38:951 [GMT) Te 2008/9/23 9:36:0:557 (GMT)

Recovery Based On

o Using Time

Figure 205

© Using Application consistency & Event based
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Step 182. The interface changes to the “Search Result” as shown below, select the
consistency tag as issued in the step Consistency tags on page 125. Then click on “Save”.

Search Result

Accuracy | Timestamp Application Tag Name
T - 2008/9/23 0:34:5:376 File System FileSystem43d3bans
{ i 2008/9/23 0:34:5:876 User Defined Tag_1

<o o€ 1 > >

Recovery Points Accuracy: ¥ - Exact ¥ - Approximate ¥ - Mot guaranteed

Save Zancel

Figure 206

Step 183. This will break the replication pair and roll back the target volume to a consistent
point. Similarly rollback all other replication pairs to the same consistency tag.

Target Drive Rollback Status

Rollback Expected Recovery Actual Recovery Recovery based Info
Rt Dirive Skaime ERgpes Paoint Point an Message
o Tag Based
O | EXCLUSTER1 K Complet=| 100% SiEs E s - TagTag 1
9:34:5:876 . W

Accuracy

Tag Based
. . 2008/9/23 - -

' | EXCLUSTER1 L Complets 100% 5:34:5:876 = Tag Tag_1

Accuracy

Release Drive

Figure 207
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14.5 Step 5: Standalone to cluster

Now that the production server is updated, restore the production server back to its clustered
state. On the standalone target (original source) node, Navigate to the VX agent installation path
to issue the following command

Clusutil.exe —prepare StandaloneToCluster:<name of the active node>

The command reboots the machine. Once the node has rebooted, log back in. You will need to
then start all the passive nodes that were shutdown earlier.

14.6 Step 6: Migration & DNS Failback

Once the production machine comes up, access the command prompt and navigate to the VX
agent installation path to issue the following command

Exfailover —failback —s <name of the DR server> -t <Exchange Virtual Server Name>
—autorefine [-cs]

C:“Program FilesxInMage Systemszlexfailover —failback —sz EXDRSERUER —t EXRUIRTSERU
—autorefine

wxxxChanged PatchMDB settings for entry:CN=Public Folder Store <EXUIRTSERU)».CH=
First Storage Group.CN=InformationfStore.CM=EXUIRISERUV.CN=Servers.CH=First Admini
ztrative Group.CH=Administrative Groups,CH=First Organization,.CN=Microzoft Excha
nge . CN=Services,CN=Conf iguration,.DC=hit32 . DC=0rg

exChanged PatchMDB settings for entry:CH=Mailbox Store C(EXUIRTSERU),.CM=First
Storage Group,.CN=InformationStore.CM=ERUIRISERU.CHN=Servers, CHN=First Administrati
ve Group.CH=Administrative Groups.CN=First Organization.CM=Microsoft Exchange.CH
=Services, CN=Configuration,DC=bit32, DC=org

Modif ied homeMIA Value to CH=Microsoft MIA.CH=EXUIRTSERU.CH=Servers.CH=First Admn
inistrative Group,.CN=Adminisztrative Groups,CN=First Organization.CH=Microsoft Ex
change . CH=Services , CN=Conf iguration . DC=hit32, DC=om

Figure 208

This should migrate all user and configuration data back to the production cluster server.
However, all the clients will still be pointed to the DR server, until a DNS failback is performed.

You can add the “-dryrun” switch to see if the command will be successful before going ahead
with the Exfailover

ér) Notes:

Specify the option “-cs” only if any configuration change was at the DR Exchange server after
failover & before failback. For example, a new storage group is created at DR Exchange
server after failover & before failback.
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To restore the DNS entries, a DNS failback is performed. Access the command prompt of the
production server and navigate to the VX agent installation folder to issue the following
command.

Dns —failback —host <name of the EVS> —IP <original EVS IP address>

C:“Program Files“InMage Systems>dns —failbhack —host EXUIRTSERU —ip 18.8.133.283

Connecting to CH to determine if host - EXUIRTSERU i=s part of a cluster...
Using DNS name = EHUIRTSERU For DHS failback
EXUIRTSERU FQDN = EXUIRISERU.bhit32.oryg

e [IMS record for EXUIRTSERV now modified to point to 18.8.133.20803 zuccessful

1y
DHS cache flushed successfully.

C:wProgram Files“InMage Systems>_

Figure 209

14.7 Step 7: Bring all EVS Services Online

Step 184. Open cluster administrator on the production server and “Bring online” the
group owning MTA resource through cluster administrator. This concludes failback.

&5 Cluster Administrator - [EXCLUSTER (EXCLUSTER}]
2t File  Wiew ‘Window Help
&| @& X B ce|=E
-85 EXCLUSTER, [ state
=20 Groups D sk k: Cnline
Cluster Group l:m Diick L: online
J Irhmiie online
Remove Exchange Yirtual Server A
Online
L il Group 3 Bring IZZZInIinE Chrl+B :stanceEl>< gg:ine
{10 Resources Take Cffline ctance (EX... !ne
B0 Cluster Configur M¥e Group gent Insta. .. O'E:me
EXVIRTSE... Offline
O Resource Ty Chi+D :
27 Metwarks ance (ExvI... Offline
= ) Rename Chrl+M AL

Figure 210
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Part 3: Active/ Active Clustered
Production Server and
Standalone DR Server

This part explains protecting and recovering an Exchange sever with more than one EVS. Two
active node Exchange servers with each node running a separate Exchange Virtual Server (EVS)
will be considered as a production server while the DR server will be a standalone server.
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15 Introduction to active/ active exchange failover

A clustered Exchange server may contain multiple Exchange virtual servers, each operating from
a different node. Discovery, VX replication, issuing consistency tags etc are unique for each EVS.
Each EVS is replicated to a different DR server. Post failover each of the DR server will run its
corresponding EVS.

Protecting multiple EVS

DR server for

EV31

ks

CX Server

Clustered

Exchange Server ‘q;:

DR Server for
EVS2

Figure 211

While performing recovery operations such as failover or a failback, the process is different. For
failover the EVS owning the MTA resource is failed over last. While performing a failback the
production Exchange server is converted into a standalone Exchange server through the cluster
utility tool provided by Hitachi Data Systems to enable the production machine to act as a target
host. Later the production server is restored to its Clustered state through the same tool. This is
achieved in eight steps as explained in the section Failback section on page 150.
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16 Protect
16.1 Discovery

16.1.1 First EVS

Step 185.
Wizard”.

Open the CX Ul and click on “File Protection”. Then, click on “New Job Group

File Protection
Logged in as 'admin' - Logout

Applications

Mo Replication Applications To Display

Application Per Page:E

_ New Job Group Wizard

Manage Templates |

Figure 114:

Step 186. Click on “Add Job” to continue.

File Protection

Logged in as ‘'admin’ - Logout

Replication Jobs

"] Application  Source '
[:E Horic Host Source Directory

_Cancel |

_Add Job |

Target

Host Target Directory

Figure 115:
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Step 187. Select the “Source” as the active node on which the EVS is running and the

“destination” as its corresponding target host. Select the FX template as “Exchange
Discovery” and click “Next” to continue.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
Application o
N I:m. 3ngs Serve
Job Description: I‘ ohangs Discovery
Source Destination
Host Host
{% | ACTIVEL [Windows] & | ACTIVEL [Windows]
{7 | ACTIVEZ [Windows] {0 | ACTIVEZ [Windows]
| W2K3-22EXC2 [Windows] % | W2K3-32EXC2 [Windews]
{0 | SICEX1 [Windows] ) | SICEX1 [Windows]
Directory Directory
Next-= | Cancel |
Figure 116:
Step 188. The FX “Job Options” opens up with all the required fields filled up, scroll down

to “Miscellaneous Options” to edit the target post script with the switch “—host <name of

the EVS>" and then click the “Finish” button to continue.

gxecution script pathnamsl

B

Post execution script pathnsmel

™

re sxscution script pathnams :::Estinatil:-n:il

Post execution script pathname ::EestinatiIn::l-ws'-_.-l'-_;.l;. ication.cxe” dicoover -app Exchangs -hoot activetnw I

Catch All job maciﬁsrl—s.:er for power users only

<- Back | Finish ->= ||| Cancel

Figure 117:
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Step 189.

File Protection

Group Schedule
Schedule Type Schedule Time

Fun Every 1 Day

Set Schedule

Replication Jobs

[:g_- Application | Source

Name Host Source Directory Target Host Target Directory
FRun order T
Ci\Program Ci\Program
[ Ungrouped | ACTINEL  Files\InMage WZK3-32EXC2  Files\InMage
Systemsifailoveridata Systems\failoverdata
Details Remove Cancel
Add Job
Finish

Figure 118:

Step 190.
volumes specific to this EVS.

File Protection

Legged in as 'admin’ - Logout
Applications

Application Per Pa
E Exchange Server

Job Description Status a‘:‘;;“ Source Directory Target Host
o exchange discovery... Starting... ACTIVEL W2K3-32EXC2
Systems'\failoveridata
Results 1-10f 1 << <1 > »>
Stop Start || | Details | Remove

Displaying 1 to 1 {of 1 Applications)

Figure 119:

Step 191.

The job is scheduled to “Run On Demand”. Click on “Finish” to save the job.

Click on “File Protection” then select the job and click on “Start” to discover all

You may observe the progress of the job by clicking on “Protection Status”

File Protaction Status

Filter Job Description Application Status 5:::;& Source Directory Target Host Target Directory St'ﬁii
Set
— =l | Salect j Ssizct ;I
Clear .
Ci\Pregram C:\Program an
Exchange Discove... Esxchange Servar Completed ACTIVEL | Filzs\InMage W2K3-32EXC2 | Filzs\InMage Phistmits
Systems'fziloveridata Systems'\failoveridata

Figure 120:
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16.1.2 Second EVS

Similarly you may discover all other EVS

Step 192. The only difference is with the target post script, Ensure that you specify the EVS

name by adding the switch —host <name of the EVS>

S EMDT E-TNAIN STETT Irlu MIMOTES PEEEE0 WICNSOC JO0 FToOTEEE

Fre sxscution script pathnamal

Post exscution script psthnamel

Prz executien script pathname :E'EEtinEtil:I'I:iI

Post execution script pathname :::-55tin*ian:il“s'-.-'-‘c».:up-mr.-:vr.axa"—1_ over-zpp Exchangs -host activelnw|

Catch &ll job modifier-=super | for power users only

s -_Ea::k | Ei!'li:_:,!'l_ -> | I:;_alju:lell
Figure 121:
Step 193. Click on Protection Status to observe the status of all FX jobs.
File Protection Status
Filter Job Description Application Status 5;;:;9 Source Directory Target Host Target Direc!

Set | 2 =
— | | | [S=at E | zeea =

Clear |

C:\Pragram C:%Program

Exchange Discove... Ungrouped Complet=d ACTIVEZ | Files\In
Systems'fziloverigats

SICEX1

C:\Program
E] Exchange Discove... Ungrouped Completsd ACTIVEL  Files\InMzgs
Systems\fzileveridatz

Fzzults 1-2 of 2 ;
b Clear logs for selected jobs | Delete all job history |

‘WInMage
sstamsifzilow

Figure 122:

‘!l‘) Notes:

The CX UI will show the latest EVS that is discovered.
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16.2 Volume Replication

16.2.1 First EVS

Once all the EVSs are discovered, proceed to replicate their corresponding volumes.

Step 194.

select the source cluster group and click on “Start Replication”

Click on “Volume Protection” and expand the “Cluster Group (s) Volumes” to

Volume Protection: Source Site
Logged in as 'admin’ - Logout
Source | Target
Protected Drives
Server Pri Volume FS Application Capacity
Primary Drives
[ wakz-32exc
[ activer
E ACTIVEZ
[ sicext
B Cluster GI’DLIESS Volumes
Server Pri Valume FS Application Capacity (Bytes) Free 5
Cluster: ACTIVE-ACTIVE,
o KL NTFS Unknown 1071627264 101
fi M.Q NTFS ""'icrcsczr-toggd‘é"ﬁ 1071627264 se
(& Group:Cluster Group N NTFS Unknown 1065253632 105
Servers:ACTIVEL ACTIVEZ
Start Replication | Reset |
Figure 123:
Step 195. Select the desired clustered volume to be replicated and click “Next”.

Volume Replication: Cluster Setup

Cluster: acrive-active

Configured Cluster Drives

Primary Server

Primary Volume

Finish _ Remove |
Unconfigured Cluster Drives
Server Pri Volume FS
[ ACTIVEL ACTIVEZ K NTFS
o ACTIVELACTIVEZ L NTFS
Next

Reset Cancel

Capacity {Bytes)
1071627 264
1071627264

Reset

Figure 124:
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Step 196. Expand the target host specific to the EVS to select the drive with same mapping

and scroll down to set the “Replication Options”.

Cluster: ACTIVE-ACTIVE
Cluster Group: Activel-EVS

Drive: K
Capacity: 1071627264

Select a target WAN volume

WAMN Server Valume Capacity (Bytes)
= waka-32exc2

{3 | w2K3-32EXC2 E 1071627264
% | wzie-3zEXCE K [ New Velume ) 107 3740300
O | w2K3-32ExC2 L{ New Volume ) 1073740300
O |wzKz-32EHCE M [ New Velume ) 1073740300
O | waKz-zzEXCZ M New Volume ) 1072740300
~ - e P AP BT | Am

Figure 125:

Step 197. Ensure that the “Enable CDP Retention option” is enabled then click on
“Submit”

Replication Options

I- Secure transport from Source to InMageCX

I_ Secure transport from InMage CX to destination
Sync options: Iﬁ

Use compression: I C¥. Ba=sed Compression d
(Overrides existing 1-M replication pairs)

Add to volume consistency group: I New Volume Giroup j

COP Retention

Enable CDP Retention option

Automatic Resync Options

I— Start between hours |'5 g I-E{' and IS g I{-:' after waiting |30 | minutes.

{All times are local to CX)

Submit Cancel Reszet

Figure 126:
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Step 198.

Pair Details
Server

ACTIVELACTIVEZ

Retention Logging Policy
Retention Palicy
Retention Log Size

Unused Space

Retain changes upto

Retain changes upto the (time)

On insufficient disk space

Log data directory

Configure Threshold for Alerts

Volume Protection: Retention Options
Logged in as 'admin’ - Logout

Pri Volume Remote Server

K WZK3-3ZEXCZ

Roll-backward
0,00 {(MB) Current Retention Log Size

256.00 (MB)

|255 I I'ulE.""I {Cannot be less then 256 MB)
I {Days) I (hrs.)

& Purge older retention logs

@ Pause differentials

{Eg:- K:\log_data)

E,.M,N,P,Q,FLS,L are drives suggested for storing rollback log files.

Alert when disk space utilization reaches

Submit | Cancel

Volume

K

0.00 (MB)

Figure 127:

Step 199.

shown in the picture and click on “Finish” to start the replication pair.

Select the type of retention policy to be applicable for this replication pair, then
click on “Submit”

Select the entry representing the replication pair that is being configured as

Cluster: acrive-acrive

Configured Cluster Drives

Cluster Group: activer-svs

Volume Replication: Cluster Setup

[l ACTIVELACTIVEZ

Primary Server

Unconfigured Cluster Drives

O ACTIVELACTIVEZ

Server

Finish ||

Pri Volume

L

Primary Volume

<
_Remove | Reset Cancel |
FS Capacity (Bytes)
NTFS 1071627264
Heset

Remote Server

Last VX Sentinel H

oo

Figure 128:
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16.2.2 Second EVS

Similarly replicate all other volumes belonging to other EVS.

You may monitor the replication pairs through “Protection Status” as shown below

Protection Status

Logged in as ‘admin’ - Logout
Volume Protection Status
Server Volume Group

Cluster:ACTL

Srotalles g Volums K¢
Server:

ACTIVELACTIVEZ->W2K3-32EXC2

ClustenACTIVE-ACTIVE,

ST M->M Valums M

Sarvars
ACTIVELACTIVE2->E5ICEX]1

Resyncs In Resync In
Transit Stepl | Transit Stepl D‘fh’e("t“‘)ls Left
{MB) (m8)
0 0 ]
818 873 o

Resync progress

0,18 minutes

2.6 minutss

Server Time: Aug-3-2008 12;29:48

Status

Differzntial Sync

Diffzrzntizl Sync

Resync
Required

View
Details

]

Figure 134:
16.3 Consistency

16.3.1 First EVS

Once all the volumes belonging EVS reach “Differential Sync”, proceed to setup FXjob for each

of the EVS to issue consistency tags

Step 200. Setup the FX job with source and destination as the active node for the EVS.
Select the FX template as “Exchange Consistency” and click on “Next” to continue

File Protection Wizard: Replication Pair

Logged in as 'admin’ - Logout

Replication Hosts

::,—‘:‘I;Etiun IExcf!';
Job Description: IQ:rE =tency
Source Destination
Host Host
& | ACTIVE1L [Windows] & | ACTIVE! [Windows]
) | ACTIVEZ [Windows] 0 | ACTIVEZ [W
0 | W2K3-32EXC2 [Windows] {0 | W2K3-32EXCZ [Windows]
) | SICEX1 [Windows] ) | SICEX1 [Windows]
Directory Directory
I I
I I Exchange Consistarcy zj I
Next-> | | Cancel |
Figure 135:

139



Step 201.

click “Finish” to continue.

TP ERTOLHE [500rce]

Pre execution script pathn

Send RPO alert ifl:' minutss passsd

Send E-mail zlert if|5 | migutes pazced witheytjob prograzz

mejesiinMage Systemsiconsistencyexchange consstency:bat]

Post exscutien script pathname|

Pre execution script pathname ::c'estinstion:il

Past executien script pathnams ::cestinal:ion::l

Catch all jeb mociﬁerI—E..l:er for power users onfy

<- Back || | Fimish -=

Cancel |

Figure 136:

Step 202.

change the frequency by clicking on the “Set Schedule”. Click “Finish” to continue.

The job will be set to execute every six hours by default, you may choose to

File Protection

Replication Jobs

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type

Run Ewvery & Hours

Schedule Time

Set Schedule |

") Application Source < -
[:E_ R Host Source Directory Target Host Target Directory
Ruri groder 1
Eihaing Z:\Program Z:\Program
8] _q_ == | ACTIVEL | Files\InMage WZ2K3-32EXC2 | Files\InMage
Server s y \Fas A
Swstems'failovaridata Systems'\failevaridata
_Details ||| Remowve ||| Cancel
Add Jab |
Finish |
Figure 137:

The “Job Options” screen opens up with all the fields filled up, scroll down, and
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16.3.2 Second EVS
Similarly set up consistency jobs for each of the EVS. You may monitor the status of all the FX
jobs through “Protection Status”

File Protection Status

Filter Job Description

Set I—
Clear |

[E3] exchange consist...

Consisten

=
= Exchange Discove...
=

Exchange Dis

Application

Exchangs Server

Exchangs Server

Ungrouped

H

Status

S=zot

Completed

Completed

Completsd

Completed

Source
Host

ACTIVEZ

ACTIVEL

ACTIVEL

Source Directory

C:\Brogram
Files\InMage

Systems\fzilover\data

C:\Brogram
FilesiInM
Systems\fa

C:\Brogram
Files\InMags

Systemsz\fzilover'datz

veridata

Target Host

SICEX1

W2K3-32EXC2

SICEXL

W2K3-32EXC2

Target Directory

C:\Program

Filzs\InMz;

Systems'failoveridata

C:\Program
Fi

lestInMage

Systems'failoveridata

gram

(=
Filzs\InMage

Systems'failoveridata

C:\Program
Files\InMags
Syzrems'failovaridars

Scheduled

GID
Type

Run Every | 6

Run Every | 5

on
Demand

on
Demand

pru}

w

Job
Instance

Exit C

Figure 141:
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17 Failover

Each EVS is failed over individually to achieve a complete failover. The EVS owning the MTA

resource should be the last EVS to failover. To identify the EVS owning the MTA, open the
Cluster Administrator and select each of the EVS to find the MTA resource under one of them as
shown in the picture below.

File Wew Window Help

luster Administrator - [ACTIVE-ACTIVE {ACTIVE-ACTIVE)]

=loix|
=181

28] X|e| @

ACTIVE-ACTIVE
Eroups
il Activel-EvS
Active2-EWS
Cluster Group

=12 Cluster Configuration

{:I Ackive Groups
{:I Active Resources
{27 Metwark Interfaces
=g ACTIVEZ

{:I Ackive Groups

{:I Active Resources
1] Metwark Interfaces

Mame | Stats I Owiner Resource Type I Description
ullﬂctivel IP addresses Onling ACTIVEL 1P Address Activel IP Adc
ml Activel Network Onlineg ACTIVEL  MNetwaork Name Activel Nebwo
m Activel SA Online ACTIVEL  Microsoft Exchange System Attendant Activel SA
uﬂl Diisk. K. Online ACTIWEL  Physical Disk Diisk. K
ml Disk L: Onling ACTIVEL  Physical Disk
m Exchange HTTP Virtual Server Instance 100 (ACTIVE INW ) Online ACTIVEL  Microsoft Exchange HTTP Server Instance
u:l Exchange Information Store Instance (ACTIVE LMW Online ACTIVEL  Microsoft Exchange Information Store

“ Exchange

m Exchange M5 Search Instance (ACTIVE 1MW)
tﬂl Exchange Rauting Service Instance (ACTIVE 1MW)
n:l SMTP Yirkual Server Instance 1 (ACTIVE 1MW)

Qnling
online
Online
Online

ACTIVEL 1M ge

e ansfer Agent
Microsaft Search Service Instance

ACTIVEL
ACTIVEL  Microsoft Exchange Raouting Service
ACTIVEL  Microsoft Exchange SMTP Server Instance

Figure 142:

Always failover the EVS without MTA resource and finally failover EVS with the MTA resource,

this applies for both planned and unplanned failover.

| First Failover EVS -
without MTA

resource

Fianlly Failover -
EVS with MTA
resource
s

’

Figure 212
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17.1 Exchange Planned Failover

17.1.1 Failover EVS without MTA resource

Step 203.

Failover” and click on “Next” to continue.

Logged in as 'admin' - Logout

Replication Hosts

File Protection Wizard: Replication Pair

Application I
Name:

Job Description: I

<name of the virtual

Setup the FX job with the source as the active node on which the EVS is running
and target as its corresponding target host and the FX template as “Exchange Planned

Source Destination
Host Host
O | ACTIVE! [Windows] ) | ACTIVE! [Windows]
{8 | ACTIVEZ [Windows] O | ACTIVEZ [Windows]
€ | W2K3-32EXC2 [Windows] O | w2K2-32EXC2 [Windows]
€ | sICEX1 [Windows] {% | SICEX1 [Windows]
Directory Directory
| |
I [Exchance Penred Faiove = I
Next -> Cancel |
Figure 213
Step 204. The next screen appears with all the required fields filled up, scroll down to
“Miscellaneous Options” to edit the source pre script and target post script with the switch
—virtualserver <name of the virtual server to be failed over> -mta
server owning the MTA resource> and click “Finish”
CEU throttle (source) I:_
Send RPO alertif |0 minutes passed
Send E-mail slert if f | migures poceed withourigh pragresc
Fre executicn script pathn3 'nat' ~buiitin -t=g MONE -virtu=iserver sctivelnw -mis 2ctiveinw
Post execution script pathnamsl
Bre execution script pathname ::csstinaticn:.l
Fost execution script pethnzme [desti aticn}l&Z-tS,.‘CEI‘- ~buiitln -wirtes (22nw -mis sctivelinw
Catch &ll job rncaiﬁirl—s..na-'
<- Back Finish -= Cancel |
Figure 146:
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Step 205. The job is set to execute “On Demand”. Click “Finish” to save the job.

File Protection

Logged in as 'admin’ - Logout

Group Schedula
Schedule Type Schedule Time
Once At On Demand

Set Schedule |

Replication Jobs

@ Applicati So Target
= pplication urce . arge!
[: MName Host S =t Host

Ci\Program

Target Directory

C:\Program

' E’;Cha:ge ACTIVEZ | Files\InMags SICEX1 | Files\InMage
CREEE, Swstems'fziloveridats Systems\failover\dats
_Details | _Remove |
Finish |
Figure 147:
Step 206. You may start the job from the “File Protection” to failover this EVS.
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17.1.2 Failover EVS with MTA resource

Once all the other EVSs are failed over proceed to failover the last EVS containing the MTA

resource.

Step 207.

Open the CX user interface, click on “File Protection-> “New Job Group

Wizard”. Select the source as the active node on which the EVS is running and the target as it
corresponding target host. Select the FX template as “Exchange Planned Failover” and click
on “Next” to continue.

Replication Hosts

File Protection Wizard: Replication Pair

Logged in as 'admin’ - Logout

Application I
Hame:

Job Description: |

Source Destination
Host Host
{0 | ACTIVEL [Windoivs] O | ACTIVEL [Windews]
O | ACTIVEZ [Windows] ) | ACTIVEZ [Windows]
& | w2k3-32EXC2 [Windows] ® - W2K3-32EXC2 [Windows]
{0 | SICEX1 [Windows] € | s1CEX1 [Windows]
Directory Directory
I |
I Exchange Pianned Failoyer ﬂ_
_Next -> | cancel
Figure 143:
Step 208. The “FX job Options” page opens up, scroll down to “Miscellaneous Options”

and edit the source prescript and target post script with —virtualserver <name of the
virtual server to be failed over> -mta <name of the EVS owning MTA resource> then click on

“Finish”.

Send RPO alert ir'I-:'

Send E-mail alert if |3

L&)

w

1

Paost executicn script pathname !:festinatlon:fl:_z -1 SICEXT -bu

Catch All job medifier-supsr

r= execution script pathnams :::Estinaticn'.l

minutes passed

minutes passed without job progress

re exscuticn script pathng nEIZ‘ ~built|n -t=g NON

E -wittus =ar ¥

T activeZnw -mis activeinw

oSt executien script pathnamel

ctiveZnw -mits activelnw

«<- Back

for power users only

Finish -= Cancel |
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Figure 144:

Step 209.

File Protection

Logged in as 'admin' - Logout

Group Schadule
Schedule Type Schedule Time
Once At On Demand

_Set Schedule |

Replication Jobs

Source

" Application u
[:D_ Hast Source Directory

Hame
Rur order]

C:\Program

Target Host

Target Directory

C:\Program

The job is set to execute “On Demand” and click on “Finish” to save the job.

ez E;Z':ZEE ACTIVEL | Filzs\InMage W2K3-32EXC2 | Files\InMage
Systemsifailoveridats Systemsifailovericats
_Details | Remove |  Cancel |
Add Tob |
Finish ||
Figure 145:
Step 210. You may observe the progress of the job through “Protection Status”. Once the
EVS owning the MTA resource is failed over then all the EVS are successfully failed over.
File Protection Status =
o — s G 1. Planned Failover for 1st EVS
Hter 0 esorl on ication artu e o
° e 2. Planned failove for 2nd EVS
set | 3. Exchange Consistency for 2nd EVS
e || || E=em Bl | (st 4. Exchange Consistency for 1stEVS
— 5. Exchange Discovery for 2nd EVS
Planned failaver... Exchange Server Completed 6. Exchange I_jl.sco‘fery for 1St EVS s _
[Planned failover for tst EvE] . v Y -
C:"\Program C:'Frogram|
planned failover... Exchangs Server Complstsa ACTIVEZ | Files\InMags SICEX! Filz=\Inkz
Systems'\failoveridata Systems\f3]
C:\Program C:\Program|
exchange consist... Exchange Server Completed SCTIVEZ  Files\InMags SICEX1 FilesiInMay
Systems\fziloveridata Systems'fal
C:'\Program C:'\Prograrm
Consistency... Exchange Server Completed ACTIVEL | FilesiInMage WZ2K3-32EXC2 | FilesiInMay
Systems\failoveridata Systzms\fa]
C:'\Program C:'\Program|
Exchange Discove... Ungrouped Completed ACTIVEZ | Files\InMage S1ICEX1 FilesiInMay
Systems\fziloveridata Systems|fz]
C:'Program C:\Program
Exchange Discove... Ungroupad Completed ACTIVEL  Files\InMags WZ2K3-32EXC2 | Files\InMay
Systems\failoveridata Systems\f3l
Figure 148:
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17.2 Exchange Unplanned Failover

17.2.1 Failover EVS without MTA resource

Step 211.
template as “Exchange Unplanned Failover” and click on “Next” to continue.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

caum
Job Description: |
Source Destination
Host Host
{3 | ACTIVEL [Windows] O | ACTIVEL [Windows]
© | ACTIVEZ [Windows] 0 | ACTIVEZ [Windows]
| W2K3-32EXC2 [Windows] o .-.\-2.‘43-325:‘:2 [Windows]
% | SICEX1 [Windows] (® | S1ICEX1 [Windows]
Directory Directory
I I
I | Extchange Pianred F: =l I
_Mext -> | Cancel
Figure 214
Step 212. The next screen appears with all the required fields filled up, scroll down to

“Miscellaneous Options” to edit the target post script with the switch —virtualserver

Setup the FX job with the source and destination as the target host. Select the FX

<name of the virtual server to be failed over> -mta  <name of the virtual server owning the MTA

resource> and click “Finish”.

CPU throttle [seurce) I-E'
Send RPO alert iFI-:' minutes passed

Send E-mail zlert iFIE\ minutes passed withoutjob pregress

Pre execution script pathnamel

Post execution script pathnamel

Pre executien script pathname ::cestinaricn'il

Pest execution script pathname [destin| ticn:il—b.. tn -tag LATEST -virtuzlserver activeZnw -mtz activelnw

Catch &l jeb modifier|-=uper for power users only
1 = =

«- Back

Cancel

Figure 146:
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Step 213. The job is set to execute “On Demand”. Click “Finish” to save the job.

File Protection

Logged in as 'admin’ - Logout

Group Schedule
Schedule Type Schedule Time

COnce At Cn Diemand

Set Schedule

Replication Jobs

I; = -
[:D_ Apﬁl:l:_::mn 5:;:;& Source Directory T: ;gs:t Target Directory
Run orger 1
~ 5 s | Z:\Program Files\InMage . C:\Program Files\InMage
o URIFRIEER. || EIEEE Systems'\fziloveridata lEES Systems\fziloveridata
Details Femove Cancel
Add Job
Finizh
Figure 147:
Step 214. You may start the job from the “File Protection” to failover this EVS.
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17.2.2 Failover EVS with MTA resource

Once all the other EVSs are failed over proceed to failover the last EVS containing the MTA

resource.

Step 215. Open the CX user interface, click on “File Protection->New Job Group Wizard”.

Select the source and destination as the target host running owning MTA. Select the FX
template as “Exchange Unplanned Failover” and click on “Next” to continue.

File Protection Wizard: Replication Pair
Logged in as 'admin’ - Logout
Replication Hosts
::I!:‘l:atiun I
Job Description: |
Source Destination
Host Host
O | ACTIVEL [Windaws] ) | ACTIVE!L [Windaws]
O | ACTIVEZ [Windaws] € | ACTIVEZ [Windows]
& | W2K3-32EXC2 [Windows] {5 | W2K3-32EXC2 [Windows]
) | SICEX1 [Windows] {3 | SICEX1 [Windows]
Directory Directory
|
oz i
Next -= Cancel |
Figure 143:
Step 216. The “FX job Options” page opens up, scroll down to “Miscellaneous Options”,

and edit the source prescript and target post script with —virtualserver <name of the
virtual server to be failed over> -mta <name of the EVS owning MTA resource> then click on

“Finish”.

Send RPO zlert iFI-:I minutss passed

Send E-mail alert iFI5 minutes passad without job prograss

Pre execution script pathnamel

Post execution script pathnamel

Pre executicn script pathname ::cestinaticn:il

Post execution script pathname :::Eslinaticn:il-b. tln -t=g LATEST -virtuslssrver sctiveZnw -mitz sctivelnw

Catch All jeb mcciﬂerl—z..par for power users only
<- Back Finish -= Cancel

Figure 144:
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18 Failback

A failback is performed once the production server is ready to resume operations. Failback is
performed in eight steps as shown below.

Step 3:
Step 1: Cluster Step 2: Reverse ; .
to Standalone > replication —> Con:las,;:ncv —>»| Step4:Rollback
|
L 4

Step 5: Step 6: Step 8: Bring
Standaloneto 2 Exfailover& —» Exchange

cluster DNS failover Services Online

Figure 215
18.1 Step 1: Cluster to standalone

To update the production server with all the data changes occurred during its outage a reverse
replication is performed. Both DR servers (each containing an EVS) will be replicated to the
production server. Since volume replication requires the target volume to be locked while
replication, the clustered production server will be converted into a standalone server. This is
accomplished through the clusutil.exe tool under the VX agent installation path.

Step 217. To convert the clustered production server to a standalone server, access the
active node of the production server then navigate to the VX agent installation path through
the command prompt to issue the following command.

Clusutil —prepare ClusterToStandalone:<name of the active node> -
shutdown <name of the passive nodes>

C:\Program Files:\InMage Systems>CluslUtil -prepare ClusterToStandalone:activel —shutdown active2

Connected to [active2] SCH
Waiting for the service [svagents] to stop
Buccessfully stopped the service: [svagents]

Connected to [activell SCH
Waiting for the service [svagents] to stop

Figure 216

“ Caution:

You will need to login with administrator privileges to execute the “clusutil”command.

This shuts down the rest of the nodes and turns the active node into a standalone server.
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‘!'1) Notes:

For Windows Server 2008 cluster, you will need to perform onlinedisk operation after the node
restarted as the result of the above step.

In Windows Server 2008 cluster, after server restarts, cluster disk will be offline and cannot be
used until it becomes online. You may use the “ClusUtil.exe —prepare onlinedisk” command

to bring all the disks online.

When you need only selected clustered disks online, you may access the cluster management
interface and take the other disks offline

Switch to the CX Ul to observe that the Cluster Group Volumes disappears and all the volumes
will be shown belonging to the active node.

Primary Drives
ACTIVEZ

W2K3-32EXC2

= actver
Server Pri Volume FS Application Capacity (Bytes)
o ACTIVEL K NTFS Microseft Exchange 1071627264
ACTIVEL L NTFS Unknawn 1071627264
ki
ACTIVEL M NTFS Unknown 1071627264
ki
o ACTIVEL M:\Mount { New Volume NTES Unknawn 1069253632
)
(9] ACTIVEL B "“{?DL;E::E:-,NE“' NTFS Unkngwn 542835712
)
ACTIVEL N NTFS Unknawn 1069253632
ki
O ACTIVEL Q NTFS Unknown 1071627264
SICEX1
Start Replication || Reset ||
Figure 217
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18.2 Step 2: Reverse replication

After failover each EVS is functional on its respective DR server. Therefore, a reverse replication
is to be set from each of the DR server to the production server.

Failback to Clustered Exchange server

DR server for

EVS1

Passive nodes E.‘
b are shutdown |3 |
CX Server j

Clustered converted to Standalone 4
Exchange sarvar e
o

Jix

DR server for
EVS2

Figure 218

Now that the production machine appears like a standalone server, proceed to set reverse
replications. The production machine will now act as a target for all DR servers.

Step 218. Access the CX UL then expand the DR server for the EVS that is to be reverse
replicated and select the volume. Observe that this was once a target volume. Click on “Start
Replication”.

Volume Protection: Source Site
Logged in as 'admin’ - Logout
Source | Target
Protected Drives
Server Pri Volume F5 Application
PrTmar?r Drives
ACTIVE2
B W2K3-32EXC2
Server Pri Volume FS Application Capacity (g
[ @) '-‘.'2K3-32§=§C2 E NTFS Unknown | 1071627
| & WEK3-32EXCE K | NTES Unknewn 1071627
[ | '.\'2PQ3-32TE?<C2 NTFS | Unknown 1073740
(8 | W2K3-32EXC2 NTFS | Unknown 1073740
r | W2K3-32EXC2 NTFS Unknown 1073740
C W2K3-32EXC2 !\.TFS | Unknown | 214?481
o WZK3-32EXC2 Qf Valume } NTES Unknown 2147481
= W2K3-32EXC2 R [ New Wolume | NTFS Unknown | 2147481
o W2K3-32EXC2 S [ Mew Volume | NTES Unknown 2147481
ACTIVE1L
SICEX1
_ Start Replication | | Reset |
Figure 219
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Step 219. The next screen opens up; expand the production server to select the target
volume, which was once a source volume. Then scroll down to set the “Replication

Options”.

Host: W2K3-32EXC2
Drive: K

Capacity: 1071627264

Selact a target WAN volume

WAN Server Volume Capacity (Bytes)
H acrivez
H wakz-z2exc2

= acrves

I & |ACTIVEL 5 I 1071627264

O | ACTIVEL L 1071627264
ACTIVEL L 1071627
& | ACTIVE M 071627264
{

ACTIVEL Hinmund ik ia/ooe 1063252632

Figure 220

Step 220. Ensure that you check the “Enable CDP Retention option” then click on
“Submit” to continue.

Raplication Options

I_ Secure transport from Source to InMageCX
I_ Secure transport from InMage CX to destination

Sync options: I Fast 'I

Use compression:
{Overrides existing 1-N re

cation pairs)

Add to volume consistency group: I New Volume Group ﬂ

CDP Retention

Enable CDP Retention option

Automatic Resync Options

I Start between huur5|'5 :I-Zr:' and IS :I-:{' after waiting [30 | minutes.

{All times are local to CX)

Submit Cancel Reset
Figure 221
Step 221. Enter the type of retention policy applicable for the replication pair and click on

“Submit” to start the replication pair.

153



Volume Protection: Retention Options
Logged in as 'admin’ - Logout

Pair Details

Server

W2K3-Z2EXCZ

Retention Logging Policy

Pri Volume
Retention Policy

Remote Server
K ACTIVEL
Roll-backward
Retention Log Size 0.00 (MB)
Unusad Space 256.00 (MB)
Retain changes upto
Retain changes upto the (time)

Current Retention Log Size

255 Maﬂ (Cannot be less then 256 MB)

| (0ayn) [ =)
&
On insufficient disk spaca Becgs clde iatirion fige
© Pause differentials
Log data directory 4
L

Configurs Threshold for Alerts

(Eg:- K:\log_data)
Alert when dick space utilization reaches

M.Q.N.M:\Mount are drives suggested for storing rollback log files.

Figure 222

=

Volume

K

0.00 (M8)
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Step 222.

Similarly, replicate all other EVS running on DR servers. Once all the replication
pairs reach “Differential Sync”, proceed to the next step.

Protection Status

Logged in as 'admin’' - Logout
Volume Protection Status
Server

SICEX1->ACTIVEL

W2K3-32EXC2->ACTIVEL

Volume

M-=M

K- K

Group

Volume M

Velume K

Resyncs In L g ¥
: Resync In Transit | Differentials Left
Transit Stepl Step2 (MB) (MB) Resync progress RPO
(mg)
0 0 a N/A 0.3 minutes
[ ] 0.03 /& 0,37 minutes

Server Time: Aug-30-2008 13:55:56

Status

Differential Sync

Differential Sync

Resync | View
Required | Details

no 3
no 3

Figure 223
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18.3 Step 3: Consistency tags

Step 223. Stop the following exchange services on the source machines (DR servers). Some
of these services do not exist in Exchange 2007 and will fail to stop, this may be ignored.

_ Exchange 2003 Exchange 2007

Service names MSExchangeMGMT
RESvc
MSExchangelS
MSExchangeMTA
MSExchangeSA
1
"\r’) Notes:
If there are any dependency services, stop the dependencies and then stop the Exchange
services.
Step 224. Then access the command prompt of each of the DR server to issue the following

command under the VX agent installation path.

Vacp —v <volume> -t ““<name of the consistency tag>”

C:“Program Files“InMage Systems>vacp —v k: —t “"Tag_ 1"
Parsing command line arguments ....

Jalidating command line arguments ...
Generating Tag: Tag_1

Generating Tag: FileSystem48bbh%?ic

Generating "Revocation" tag ...

Preparing the applications for consistency ...
Preparing Files K:s® {(recursivelyd

Starting snapshot set

Uzing M8 Software Shadow Copy provider: b5946137-7b?f-4225-af808-51abd6@b2Bd5
Freezing the applications for consistency ...

Commiting shadow copy for the set...
K:% iz mapped to Unigue volume ““?N\Uolume{eB874f8%a-313d4-4297-8271-fdc587d436de>

Checking driver mode for given volumes

For volume K:\ driver iz in Data mode.
Sending tags to the driver ...

Successfully sent tags to the driver ...

Marked all applications as successfully backed up

Resuming the applications after point—-in—time consistency check-point
Deleting snapshot set{Shadow copies)

Succeefully deleted snapshot set{(Shadow copies)

Exiting gracefully ...

C:“Program Files“InMage Systems>
Figure 224
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18.4 Step 4: Rollback

Step 225.

After issuing consistency tags on all source hosts (DR servers). Switch to the CX

UI to perform a target volume rollback. Click on “Recovery” then select the replication pair
you want to rollback and click on “Rollback”. A message box appears for confirmation, click

on “OK” to proceed.

Volume Recovery : Recovery Snapshots

Logged in as 'admin’ - Logout

Recovery Snapshots | Scheduled Snapshots

Replication Pair Details

Server Lo, Remote Server Volume Replication
Volume Pool
0 | s1cEX1 M ACTIVEL M 7
= wzkz-zzENCE K ACTIVEL K 5
Recover | RD”hEF:?I} Reset
Figure 225
Step 226. The next screen opens up as shown in the picture below. Select the “Using

Application consistency & Event based” option.

Logged in as 'admin’ - Logout

8 Using Time

Volume Recovery: Recovery SnapShot Options

Recovery Based On

= Using Application consistency & Event based

Pair Details

Server Primary Volume Remote Server Target Volume Replication Pool
WZK3-32EXC2 ACTIVEL K g
Recovery Options
Logs Available From  2008/5/1 9:5:46:251 [GMT) To 2008/9/19:52:11:21 [GMT)

Figure 226
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Step 227. The interface changes to the “Search Result” as shown below, select the
consistency tag as issued in the step Consistency tags on page 156. Then click on “Save”.

Search Result

Accuracy | Timestamp Application Tag Name
O i 2008/9/1 9:42:57:851 File System FileSystem48bbbo1c
f’m il 2008/9/19:42:57:851 User Defined Tag_1
Ll .3 2008/9/1 0:40:11:497 File System FileSystem28bbba76
i . ¥ . 2008/9/1 9:40:11:407 User Defined . ExchangeConsistencyPoint

< o= 1 = o

Recovery Points Accuracy: ¥ -Exact ¥ - Approximate ¥ - Not guaranteed

Save Cancel

Figure 227

Step 228. This will break the replication pair and roll back the target volume to a consistent
point. Similarly rollbacks all other reverse replication pairs.

Target Drive Rollback Status

Host Rull?:rack Siatas | Drispes Expected _Re:lwer',r Actual Recuvew Recovery based Info
Dirive Point Point on Message
T Tag Based
- . . " 2008/9/1 s
{3 | ACTIVEL K Complete | 100% ey T2z -a,_;y
Accuracy
e Tag Based
. : :; 2008/9/1
Fey f % o ete oh s Tag tag_2
{O | ACTIVEL 1 Complete | 100 G 46:16:438 T
Accuracy
Release Drive |
Figure 228
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18.5 Step 5: Standalone to cluster

Now that the production server is updated, restore the production server back to its clustered
state. Navigate to the VX agent installation path to issue the following command

Clusutil _exe —prepare StandaloneToCluster:<name of the active node>

The command reboots the machine and then starts all the passive nodes that were earlier
shutdown.

18.6 Step 6: Migration & DNS Failback

Step 229. Once the production machine comes up, access the command prompt and
navigate to the VX agent installation path to issue the following command

Exfailover —failback —s <name of the DR server> -t <name of the production server>
—autorefine —mta <host where MTA is running>

INDOWS" system32 cmd.exe - exfailover.exe -Failback

C:“\Program Files“\InMage Systems>exfailover.exe —failback —s uw2k3-3Zexc? —t activelnuw —-autorefine
-mta activelnw

saeseeChanged PatchMDB settings for entry:CN=Mailbox.CN=F8G.CH=InformationStore.CH=ACTIVEiNU.CH=Se
ruers,CH=Firset Administrative Group,.CH=Administrative Groups.CH=First Organization,CH=Microsoft E
xchange .CHN=Services .CN=Conf iguration.DC=bit32.DC=0rg

woeexChanged PatchMDB settings for entry:CM=Public.CH=FSG.CM=InformationStore.CH=ACTIVEi1NY.CH=8cr

vers,.CH=First Administrative Group.CH=Administrative Groups.CN=First Organization.CH=Microsoft Ex
change .CHM=Services .CN=Conf iguration,.DC=hit32 . DC=0ryg

xexxChanged PatchMDB settings for entry:CN=Smailbox.CN=S58G.CHM=InformationStore.CN=ACTIVEiINW.CN=8
ervers.CH=First Administrative Group.CH=Administrative Groups.CHN=First Organization.CH=Microsoft
Exchange .CHN=Services .CN=Conf iguration,DC=hit32 . DC=oryg

xexxChanged PatchMDB settings for entry:CN=Imailbox.CN=T8G.CH=InformationStore.CMN=ACTIVEiINW.CN=8
ePuePS,CN FlPSt ﬂdmlnlotratlue GPnup.CH Hdmlnlotratlue Groups .CH=First Organization.CH=Microsoft

Flgure 229

This will failover all exchange services to the production server. However, all the clients will still
be pointed to the DR servers. A DNS failback is performed to restore the original IP address to
the EVS.

You can add the “-dryrun” switch to see if the command will be successful before going ahead
with the Exfailover
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Step 230. To restore the DNS entries, a DNS failback is performed. Access the command
prompt of the production server and navigate to the VX agent installation folder to issue the
following command

Dns —failback —host <name of the EVS> -1P <original EVS IP address>

WINDOWSh system3 2 cmd.exe

C:“Program Files™InMage Systemsz>dns —failback —host activelnw —ip 180.8.186._173

Connecting to CH to determine if host : activelnw is part of a cluster...
Using DHS name : activelnw For DHS failback

activelnw FQDHN = activelnw.hit32 _ oryg

e NS record for activelnw now modified to point to 18.0.188.173 successfully
DMS cache flushed successfully.

Figure 230

18.7 Step 7: Bring all EVS Services Online

Step 231. Open cluster administrator on the production server and “Bring online” the
group owning MTA resource through cluster administrator. This concludes failback.
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Part 4: Clustered Production

Server and Clustered DR
Server

This part explains protecting exchange server in a clustered environment where both production
server and DR server are in clustered environment. This is applicable for Exchange Server 2003
only.
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19 Introduction

A clustered Exchange server can contain more than one Exchange Virtual Server (EVS). Each EVS
may again span over many volumes. To protect a clustered machine with multiple EVS to
another identical clustered machine, ensure that you follow the below aspects while preparing
the DR cluster machine

e Prepare the list of EVS on the production cluster and create the corresponding EVS on the DR

cluster.
e Create the list of volumes used by each production EVS and assign the same drive letters for
the DR EVS. These volumes will later be used as target volumes for the respective EVS
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20 Prepare target cluster

A clustered machine cannot be used as a target host for a replication. The DR cluster should be
converted to a standalone server. Follow the below steps to prepare the DR cluster server before
setting a VX replication.

Step 232. Create the same number of EVS on the DR cluster as on the production cluster

Step 233. Ensure that each EVS created on the DR cluster is similar to its corresponding
EVS on the production cluster in terms of volumes occupied, size of volumes, drive mapping
etc.

Step 234. Take the system attendant resource offline for both the EVS on the DR cluster

Step 235. List the volumes belonging to each of the EVS on the DR cluster server

Step 236. Get the MS Search Instance folder path by running the following command:

Cluster.exe resource ”<MSSearch Instance resource Name>" /priv
Take back up of MS Search Folder to Hitachi Dynamic Replicator VX installation path.

Step 237. Login to the active node of the DR cluster and navigate to the Hitachi Dynamic
Replicator VX agent directory through the console and execute the clusuti.exe command to
convert the active node into a standalone server

clusutil.exe -prepare clustertostandalone:<active node name> -shutdown
<passive hodes>

‘!LI’J Notes:

For Windows Server 2008 cluster, you will need to perform onlinedisk operation after the node
restarted as the result of the above step.

In Windows Server 2008 cluster, after server restarts, cluster disk will be offline and cannot be
used until it becomes online. You may use the “ClusUtil.exe —prepare onlinedisk” command to
bring all the disks online.

When you need only selected clustered disks online, you may access the cluster management
interface and take the other disks offline

b
b Caution:

Back up of MS Search Folder should be taken before converting the target cluster to standalone
target, because this folder contains configuration files which are very important for Exchange
Virtual Sever. Without backup of this folder EVS will not come online after failover.
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21 Protect

Set VX replication pairs from production cluster to standalone DR server. Ensure that you
replicate all production EVS to their corresponding volumes on the DR production server with
CDP retention enabled. Configure consistency job from all clustered nodes on the production

cluster to the standalone DR server.

Production Cluster

DR Cluster

EvE 4

Converted to Standalone
while VX replication

Figure 231
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22 Planned Failover

You can perform a planned failover in six steps explained below. During these steps the
standalone DR server will be restored back to its clustered state and users are diverted directly to
the EVS on the DR cluster transparently.

Production Cluster DR Cluster

Y

g

CX-PS CX-PS

Figure 232

Follow the below steps to perform a planned failover

Step 238. Take the system attendant resource offline on the production cluster for all the
EVS to stop the further data writes.

Step 239. Issue consistency tag for each of the EVS running on the production cluster.
Access the respective node for each EVS to issue a vacp tag.

vacp -v <EVS Volumes> -t "<name of the tag>"

For Example:
vacp -v K:;M:;L:\Mountl -t "tagl"

Step 240. Switch back to the CX Ul to roll back the target volumes to the consistency tag
issued in the previous step

Step 241. Access the standalone DR server to convert it back to its clustered state. You can
do this using the clusutil.exe command found under the VX install directory.

clusutil._exe -prepare standalonetocluster:<standalone DR server>
Step 242. After the active DR server comes up start the passive nodes manually.

Step 243. Restore back the MS Search Instance Folder to original target location with same
drive letters.
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Step 244. Then perform exchange failover through the “exfailover” command for each of
the EVS on the DR cluster nodes. Access the production cluster through console for each of
the EVS and navigate to the VX installation path to issue the following command

exfailover._exe -failover -s <Source EVS name> -t <corresponding target EVS on DR
cluster> -autorefine -cs

This step is performed for each of the EVS on the production cluster

Step 245. Perform a DNS failover for each EVS.
Dns.exe -failover s <Source EVS name> -t <corresponding Target EVS name>

Step 246. Bring the cluster resources online for all the EVS on the DR cluster

23 Failback

Note down the volumes of corresponding Source EVS

Step 247. Convert the production cluster to a standalone server. This enables the
production server to act as a target host for the reverse replication (For more details refer
section Prepare target cluster). Access the active node of the production cluster and navigate
to the VX installation directory to issue execute the clusutil.exe command

clusutil._exe -prepare clustertostandalone: <active node on production cluster> -
shutdown <passive nodes on production cluster>

Step 248. Set VX replications from DR Cluster to Standalone production server for each of
the EVS. Ensure that you maintain drive mapping while selecting the target volumes for
replication. For example, when EVS 3 is using e: volume on the DR cluster server, ensure that
it’s target volume on the production standalone server is also e:

Similarly set reverse VX replication pairs for the rest of the EVS.

Step 249. Once the replication pairs reach “Differential Sync”, configure exchange
consistency job from Active node on DR cluster to the standalone production server.

Take the system attendant resource offline on DR cluster for all EVS

Step 250. Issue consistency tags for all the Exchange volumes using vacp.exe.

Vacp —v <EVS Volumes> -t <Tag Name>

For Example:
vacp -v K:;M:;L:\Mountl -t "tagl"
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Step 251. Switch back to the CX Ul to roll back the target volumes to the consistency tag
issued in the previous step

Step 252. Convert the standalone production server back to a clustered machine using
clusutil.exe.

clusutil.exe -prepare standalonetocluster:<Production Server Name>

Step 253. After the active production server comes up start the passive nodes manually.

Step 254. Restore back the MS Search Instance Folder to original target location with same
drive letters.

Step 255. Perform Exchange failback for each of the EVS using the following command

exfailover.exe -failover -s <TargetEVS> -t <SourceEVS> -autorefine -cs
Step 256. Perform DNS failback for each of the EVS
dns.exe -failback -host <SourceEVS> -ip <SourceEVS IP Addresses>

Step 257. Bring all cluster resources online for EVS on the production cluster.
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Part 5: Exchange Log Rotation

This part of the document explains Exchange log rotation. Exchange log rotation is a performance
tuning job that executes at regular intervals. In each pass exchange logs files are removed from
the production exchange server.
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24 Introduction to Exchange Log rotation

Exchange server 2003 produces log files during its operations, eventually these log files consume
disk space. To maintain free space these log file can be deleted. However, deleting them directly
is not recommended. This solution explains how to rotate exchange log files with simple FX jobs.

This flushes all exchange data in the memory to disk and the VX replication transfers these files

to the backup exchange server. Then log files on production and backup server are compared and
then removed from the production server.

VX replication Log rotation =
AT ES transfers the files compares both files LLEED e i =
data from memroy . deleted from the
. to the backup on the production .
to disk production server
Exchange sever and backup server

Figure 149: Exchange log rotation workflow

b %

25 Configuring FX jobs
Three FX jobs are used for Exchange log rotation.

o The first FX job is for generating Exchange consistency tags.

e The second FX job will be in a different job group and will take a virtual snapshot based on
the tag issued earlier to validate exchange log files.

e  The third and final FX job will be within the same job group as the previous FX job (Exchange
consistency Validation) and is responsible for rotating Exchange logs on the production
exchange server.

Exchange Consistency Exchange Consistency Exchange Log
Validation Rotation

e|ssues Consistency *Takes a Virtual *Rotates Exchange
tagson production snapshot based on logs on production
Exchange server the tag to validate Exchansge server.

exchange logs

Figure153:
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25.1 Exchange Consistency

Step 258. On the CX Ul click on “File Protection -> New Job Group Wizard -> Add Job”.
Select the source and destination as the production exchange server, then select the FX
template as “Exchange Consistency” and click on “Next”.

File Protection Wizard: Replication Pair

Logged in as 'admin' - Logout

Replication Hosts

Application I
Name:

Job Description: I

Source Destination
Host Host
{8 | EXCHANGE_PROD [Windows] {8 | EXCHANGE_PROD [Windows]
{0 | EXCHANGE_DR [Windows] {0 | EXCHANGE_DR [Windows]
Directory Directory
I Exchange Consistency d
Next -> Cancel
Figure 233:
Step 259. The FX job Options page appears, scroll down and click on “Finish”.

CPU thrattle (source] [T

Send RPO alert ifID minutes passed
Send E-mail aIertiFIE- . ibbeateteiatals

Pre executien script pat namEIiITI Files“InMage Systems‘consistency'exchange_consistency bat”

. . L
Pest execution script pal T

Pre executicn script pathname :::estinaticn::l

Post execution script pathname :::estinaticn:il

Catch &ll jeb mc:iﬂsrl—super for power users only

<- Back Finish -= Cancel

Figure 234:

170



25.2 Exchange Consistency Validation

Step 260. Click on “File Protection -> New Job Group Wizard -> Add Job”, select the

source and target exchange servers then select “Exchange Consistency Validation” for the

FX template and click on “Next”.

File Protection Wizard: Replication Pair

Replication Hosts

Application Name: I

Job Description: I

Source Destination
Host Host
{5 | EXCHANGE_PROD [windows] {0 | EXCHANGE_PROD [Windows]
O | EXCHANGE_DR [Windows] {8} | EXCHANGE_DR [Windows]
Directory Directory
| Exchange Consistency Yalidation j
Next -> Cancel
Figure 235:
Step 261. The FX job options page opens up with both the target pre script and target post

script filled up. Click on “Finish” without changing any settings.

Send E-mail zlert if[3 minutes passed

without job progress

Pre execution script pathnamEI

Post ewecution script pathnamel

Pre execution script pathname [destinatfen

| exchang=2007 -s EXCHANGE_PROD -t EXCHANGE_DR

Post execution script pathname [destin icn::lar's'-.{}:irs =tency\exchange2007_consistency_wvalidstion. bat’)

Catch 2ll job mcciﬁerl—s..par for power users only
<- Back Finish -= Cancel
Figure 157:
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Step 262. The job will be set to “Run On Demand”, Click on “Add Job”.

File Protection
Logged in as "admin' - Logout

Group Schedule
Schedule Type

Once At

Replication Jobs

ﬂ_, Application
(&

Mame

Run erder 1

Schedule Time

Cin Demang

Set Schedule

C:\Program

Source Host Source Directory Target Host Target Directory

C:\Pregram

i Ungrouped  EXCHAMGE_PROD | Files\InMage EXCHANGE_DR | Files\InMage
Systems\faileveridata Systemsifailoveridata
Details Remove Cancel
Add Job
Finish
Figure 236
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25.3 Exchange Log Rotation

Step 263. Now add another FX job under the same job group. This is a reverse replication.

Setup a replication pair from target exchange server to source exchange server. Select the FX
template as “Exchange Log Rotation” and click on “Next”.

Replication Hosts

File Protection Wizard: Replication Pair

Application Name: I

Job Description: I
Source
Host
{0 | EXCHANGE_PROD [Windows]

(¥ | EXCHANGE_ DR [Windows]

Destination

Host

=

EXCHANGE_PROD [Windows]

& | EXCHANGE_DR [Windows]

Directory Directory
| Exchange Log Rotation j
Next -= Cancel

Figure 237
Step 264. The “FX job Options” page opens up, scroll down and click on “Finish”.

CEL throttle (source) ID

Send RPO alert iFIl]l minutes passed

Send E-mazil alert iFIE- minutes passed withoutjob progress

Pre execution script pathnamel

Post execution script pathnamEI

Pre execution script pathname [destin

Post executien script pathname [dasti ticnj:l"C:"-.F‘roglarn Files"InMage Systems“consistency*exchanage_log_flu

«<- Back

Catch All jeb mcciﬁerl—super for power Users only

Finish -= Cancel

Figure 238
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Step 265.

File Protection
Logged in as 'admin’ - Logout

Group Schedule
Schedule Type

Once At

Replication Jobs

[:g AP:IEHI:'::I on Source Host
Run order 1
P Ungrouped | EXCHANGE_PROD

Ungrouped EXCHANGE_DR

Details

Remove

Schedule Time

MNow

Set Schedule

Source Directory

C:\Program
Files\InMage
Systems\failoveridata

C:\Pregram
Files'InMags
Systems'coensistency

Add Job

Finish

Target Host

EXCHANGE_DR

EXCHANGE_PROD

Cancel

Target Directory

C:\Program
Files\InMage
Systems\failoveridata

C:\Pregram
Files\InMags
Systems'coensistency

Set the Run order for Exchange log rotation as “Run Order 2”.

Figure 239

Step 266.
production exchange server.

Once both the FX jobs are complete, the logs are successfully rotated on the

File Protection Status
Filter Job Description Application Status
Set

Sekeot El seka
Clear
Exchange Consist... Ungrouped Completed
Exchange Consist... Ungrouped Completed
Exchange Censist... Ungrouped Completed

Source Host

EXCHANGE_PROD

EXCHANGE_PROD

EXCHANGE_PROD

Source Directory

C:\Program
Files\InMage
Systams\failover\datz

C:\Program
Files\InMage
Systams\failover\datz

C:\Program
Files\InMage
Systams\failover\datz

Target Host Target Directory

C:\Program
Filzs\InMags
Systzmsz'fziloveridata

EXCHANGE_DR

C:\Pragram
Files\InMage
Systzmsz'fziloveridata

EXCHANGE_DR

C:\Pragram
Files\InMage
Systzmsz'fziloveridata

EXCHANGE_DR

Scheduled

T GID

Seeat

Once Now

10

Run Every | &

Run Every | &

Jab
Instanc

35

32

3z

Figure 161:
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Part 6: Troubleshooting

This part describes the process to recover from an inconsistent Exchange server database.
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26 Recovering from Inconsistent Exchange Databases

There are instances when the exchange database and log files are not consistent on the target
exchange server upon a disaster. Microsoft exchange databases can be recovered to a consistent
point by using two utilities called “eseutil” and “isinteg”, they are available with Exchange
installation. Following is a set of steps that can be followed to bring the exchange database(s) to a
usable state. This must be executed on the target exchange server where you wish to recover the
database files. The following assumes G and H drives are being used for exchange database and
log volumes respectively, and “privl.edb/privl.stm” and “publ.edb/publ.stm” are the names of
the private and public database/stm files respectively.

net stop svagents
net stop MSExchangelS

cd “C:\Program Files\InMage Systems”

Cdpcli
Cdpcli

unhide_rw G:
unhide_rw H:

chkdsk /f G:
chkdsk /f H:

cd “C:\Program Files\Exchsrvr\bin”
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Eseutil /mh “G:\dbl\privil.edb”
Eseutil /mh “G:\dbl\publ.edb”

pivl . adh

ft Corporation. A1l Rights Reseruved.

File Typ
ulMagi

Rand:31 28 Computer:

| {B-A>
PRARRA1T08 0000 :BR
o5
2BA6
‘142086
1988 &8

42006 B9:08:24 Rand:3 8234 Computer:

Previous Full Backup:
B-8 (BxPB-BxB>
a8
788 B8:86:88

B8
THE PE:BE R

Current snap

Operation conpleted sfully in 1.8 secondsz.

Figure 162:
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Eseutil /r Exx /I1”H:\logsl” /s”H:\logsl” /d”G:\dbl /i~

Eseutil /p “G:\dbl\privl.edb” /s”G:\dbl\privl_.stm” /i

il

s Databaoe

raamin
Datak

Chacking datahass

ation.

-l ks

tm
16 .EDR

bhiz data % o up—to-ilats

nning

k1% ]

18 28

Checking the data

Status

48 58
b '

Btatus

A L1

dbi~privi .edh

tiesn

Nll Hights He

plea

conplote}

G ]
| 1

comnple

L

completed

1L "
| i

conplo

5] A

Figure 163:
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Eseutil /p “G:\dbl\publ.edb” /s”G:\dbl\publ.stm” /i

eutil #p gihudblspubl cedbh sogiwdblspubl oste i
~ Patabase Utilities
Reseruved.
Initiating F
Dat
!El veaning File

Temp. Data

Checking dat

the database

ann in

2B i ] 48
=% kit : - " : -

:0bjects fFrom R vjecteShadow.
atus ¥ completel

aa 48 %8 (1] 78 58 78 188

Scanning S onplate?

)

Repaiving damaged tables.

Scanning & 5 onplete )

8 48 LA (1] 78 BA %8 iRk

F:l:j_lll i |'l|1-|'|]!]l‘ ted. Databaze corru pt ion haz hesn re L5 ired?

Figure 164:

cd “C:\Program Files\InMage Systems”
exfailover —failover -autorefine -cs -s<source_server> -t<target_ server>

net start MSExchangel$S

¢ Unmount all the private and public mailstores from Exchange System Manager

¢ Runisinteg to fix all the databases one at a time where <ServerName> is the dns name of the
exchange server whose databases you wish to fix. The screenshot below shows a sample
using DEMO-EXCHS3 as the server name.
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Isinteg —fix —s DEMO-EXCH3 -test alltests

< CAWINDOWS \system3Ziomd exs =100 x|

¢ Madlbao e {DEHD
Tables result: B error 8 warnir

Tabhles r

older Lin
4

le: @ error tima: BhzBn:B
To rezilt: B srrortsd: B warni
hedinle result: B errorts¥; B warndr 3 £ P fEY: timo:

Events rezult: B srropds B warning : B Fixfezd; B vrowiz); time: B

Eruction xult: B o

result: o i H 1 ¥ i 1- 2 i time: Bh
ltz B error i i time: Hh:8m:
rgories result: B erro time: Hh:

Uger Read resultz @ : 2 r }; Gimo:

cial Folders g =27 © £27 time

ion result: B srroar

g in ¥ o J unt? of total 2 E % complete. =1

Figure 165:

e Mount all the private and public mailboxes and verify the emails by logging into the
exchange user’s mailboxes.
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27 Known issues

1. Failover is not supported for the following scenarios
Exchange servers in different administrative groups

e Exchange servers across domains.

¢ 1-N failover is not supported.

e  When replication is set without considering drive mapping for example when an exchange
replication is set from d:\ of production server to e:\ of DR server.

e Failover is not supported while using Junctions

e Individual storage group failover is not supported.

2. Application.exe, dns.exe does not support IPV6.

3. When there is more than one network card on the DR server during failover, the expected IP
address may not be assigned to the production server at the DNS server.

4. If the production server is set to register the its IP address in the DNS on a reboot, all clients
will be pointed to it rather than the DR server even after a failover, provided the production
server reboots after a failover.

To resolve this, either uncheck the "Register this connection's addresses in DNS" check box for
all NICS

OR

Add the "DisableDynamicUpdate" of type DWORD to the Registry key
"HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ Tcpip\Parameters" with
value set to 1. This key disables DNS update registration for all adaptors on that computer.

5. During Exchange 2000 failover/failback while stopping/starting the Exchange services, you
may observe the message “Error: [1060] the specified service does not exist as an installed
service “which may be safely ignored.

6. For Exchange 2003/2007 Cluster, Exchange consistency validation is supported when active
node name is supplied as source name in the command. When passive node is mentioned as
source then the resulting script “exchangeXXXX_consistency_validation.bat” will be empty.

7. When the DR server has a storage group name different from the storage groups at
production server then that will not be deleted during failover. After failover that storage
group should be deleted manually.

8. Individual storage group failover is supported only for storage groups that host both the
private and public folder stores and all private mailbox stores in this storage group must
reference the public folder store in the same storage group. The current limitation w.r.t to
both Exchange 2003 and Exchange 2007 is as follows:
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e Tailover is not supported for individual storage groups if a mailbox store references a public
folder store that is external to the same storage group:

For example, consider the following Exchange Configuration:

Storage Group 1
Mailbox Store 1 [references Public Folder Store 1]
Public Folder Store 1
Storage Group 2
Mailbox Store 2 [references Public Folder Store 1]
Storage Group 3
Mailbox Store 3 [DOES not reference any public folder store]

e Failover of Storage Group 1 and Storage Group 3 is supported, however, failover of Storage
Group 2 is not supported as it references the public folder database from Storage Group 1.

9. When Exchange system volume (where Exchange is installed) is replicated, the Exchange
validation template is not supported because the eseutil.exe utility resides in the Exchange
system path on the Exchange system volume which is locked as part of the VX replication.

10. During failover from cluster to stand alone machine, if failover halts at the production server
after off lining the cluster resources, you will need to bring the resources online manually.
This is applicable for all the cluster resources of Exchange.

11. When same computer name is available in parent/child domain environment, add/delete of

SPN entries will happen from both the computer name if failover is for parent computer.
Executing the WinOp.exe or Application.exe from any of the two domains will change the SPN
entries of both the computers.
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